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duction

ual describes detailed instructions on the operation and notes about the use of this machine.
aximum versatility from this machine all operators are requested to read this manual carefully
w the instructions. Please keep this manual in a handy place near the machine.

t

 of this manual are subject to change without prior notice. In no event will the company be
 direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
machine.

 Version Conventions Used in This Manual

are 3.x means NetWare 3.12 and 3.2.
are 4.x means NetWare 4.1, 4.11 and IntranetWare.

rks

h, Mac OS, Apple, AppleTalk, EtherTalk, LaserWriter, Rendezvous are registered trademarks
 Computer, Inc.
t, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
d/or other countries.
, Netscape Navigator are registered trademarks of Netscape Communications Corporation.
etWare, NDS are registered trademarks of Novell, Inc.
t is a registered trademark of Adobe Systems, Incorporated.
registered trademark of Hewlett-Packard Company.
 a trademark or registered trademark of Sun Microsystems, Inc. in the United States and other
.
 is a Trademark of the Bluetooth SIG, Inc. (Special Interest Group) and licensed to RICOH

 limited.
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oduct names used herein are for identification purposes only and might be trademarks of their
ve companies. We disclaim any and all rights in those marks.
per names of the Windows operating systems are as follows:
product name of Windows® 95 is Microsoft® Windows 95.
product name of Windows® 98 is Microsoft® Windows 98.
product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).
product names of Windows® 2000 are as follows:
osoft® Windows® 2000 Advanced Server
osoft® Windows® 2000 Server
osoft® Windows® 2000 Professional
product names of Windows® XP are as follows:
osoft® Windows® XP Professional
osoft® Windows® XP Home Edition
product names of Windows ServerTM 2003 are as follows:
osoft® Windows ServerTM 2003 Standard Edition
osoft® Windows ServerTM 2003 Enterprise Edition
osoft® Windows ServerTM 2003 Web Edition
product names of Windows NT® 4.0 are as follows:
osoft® Windows NT® Server 4.0
osoft® Windows NT® Workstation 4.0
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to Read This Manual

nual, the following symbols are used:

ING:
ol indicates a potentially hazardous situation which, if instructions are not followed, could
eath or serious injury.

ION:
ol indicates a potentially hazardous situation which, if instructions are not followed, may re-

nor or moderate injury or damage to property.

ements above are notes for your safety.

tant
ruction is not followed, paper might be misfed, or data might be lost. Be sure to read this.

ration
ol indicates the prior knowledge or preparations required before operating.

ol indicates precautions for operation, or actions to take after misoperation.

tion
ol indicates numerical limits, functions that cannot be used together, or conditions in which
r function cannot be used.

ence
ol indicates a reference.
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at appear on the machine's panel display.

d buttons that appear on the computer's display.

ilt into the machine's control panel.

 the computer's keyboard.
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irming a Network Environment

ecting Printer and Computer
etwork connection (Ethernet cable)

etwork connection (IEEE 802.11b (Wireless LAN) )

arallel connection (parallel cable)

luetooth™

NetWare (Server)

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
(Server)

Macintosh

         NetWare
          (Client)

UNIX

ws 95/98/Me/
XP

Windows Server 2003

Windows NT 4.0
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erver Configuration

 Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 Print Server

 use Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 as a print server.

 “Preparation before Use” to set up the network environment, and then prepare the print server
 to the following topics in accordance with the operating system used.

.23 “Windows 2000 Print Server Configuration”.

.47 “Windows XP, Windows Server 2003 Print Server Configuration”.

.67 “Windows NT 4.0 Print Server Configuration”.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print ServerPrint Server

Windows 95/98/Me/
2000/XP

Windows Server 2003 Windows NT 4.0
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 NetWare Server

 print out from a client using Windows 95/98/Me/2000/XP, Windows Server 2003 or Windows
by using NetWare 3.x, NetWare 4.x, NetWare 5/5.1, or NetWare 6/6.5 as the print server.

ork interface board allows you to use the machine as either a print server or a remote printer.

g as a Print Server

NetWare
File ServerPrint Server

Windows 95/98/Me/
2000/XP

Windows NT 4.0Windows Server 2003
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g as a Remote Printer

 “Preparation before Use” to set up the network environment, , and then see p.89 “NetWare
ration” to prepare the NetWare server.

NetWare
Print Server

NetWare
File ServerRemote Printer

Windows 95/98/Me/
2000/XP

Windows Server 2003 Windows NT 4.0
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paration before Use

uring the Printer for the Network
connecting this printer to a network using an Ethernet cable or an optional 802.11b interface
levant settings are required.

guring the Printer for the Network 

 network settings below depending on
rk interface you use.

also use SmartDeviceMonitor for Ad-
eb Image Monitor to make IP address-
ttings in a TCP/IP-capable environ-

 details about using SmartDeviceMoni-
dmin, see SmartDeviceMonitor for
lp. For details about using Web Image

see Web Image Monitor Help.

ence
tails about optional 802.11b interface
ttings, see Option Setup Guide

 the printer for the network using the
ontrol panel.

ing table shows the control panel set-
their default values. These items are in-
the “Host Interface” menu.

*1 If DHCP is in use, the IP address, subnet mask,
and gateway address are all set automatically.

*2 Make this setting only when it is necessary. See
p.198 “Host Interface Parameters”

ing Name Value

On

s *1 011.022.033.044

Subnet Mask *1 000.000.000.000

Gateway Address *1 000.000.000.000

Frame Type (NW) Auto

Active Protocol TCP/IP Active

NetWare Active

SMB Active

AppleTalk Active

Ethernet Speed *2 Auto

LAN Type Ethernet

Setting Name Value
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s {{{{Menu}}}} key.

nu” appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Host In-
ce” menu, and then press {{{{# Enter}}}} key.

ote
ress the {{{{UUUU}}}} or {{{{TTTT}}}} key once, and not
nger than necessary.

following message appears on the panel
ay.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Network
Setup”, and then press {{{{# Enter}}}} key.

The following message appears on the panel
display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Active
Protocol”, and then press {{{{# Enter}}}} key.

The following message appears on the panel
display.

EEEE Press {{{{UUUU}}}} or {{{{TTTT}}}} key to select [Active Pro-
tocol] , and then press {{{{# Enter}}}} key.

The following example explains activating
TCP/IP.

The “Active/Not Active” selection screen ap-
pears.

Menu:

 Host Interface

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

  Host Interface:

   Network Setup

  Host Interface:

   Active Protocol

  Active Protocol:

   TCP/IP
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ress {{{{UUUU}}}} or {{{{TTTT}}}} key to select “Active”
r “Not Active”, and then press {{{{# En-
r}}}} key.

fter the settings are made, about two sec-
nds later, the screen returns to that of
epE.

et other protocols you need to set in the
me way.

ress {{{{Escape}}}} key.

he screen of step E appears.

Note
The default is “Active”.

Leave unused protocols “Not Active”.

Enable TCP/IP to use the Pure IP envi-
ronment of NetWare 5/5.1, NetWare
6/6.5.

FFFF When you use this machine in DHCP envi-
ronment, proceed to stepJ. When you use
this machine with a fixed IP address, you
must make the setting for the required item
after setting DHCP to Off. Proceed to
stepG.

Important
❒ When DHCP is On, you cannot make set-

tings for the following items:

• IP Address

• Subnet Mask

• Gateway Address

Note
❒ Consult your network administrator for in-

formation about making network settings.

GGGG Set DHCP to Off.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “DH-
CP”, and then press {{{{# Enter}}}} key.

TCP/IP:

*Active

  Network Setup:

   DHCP
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ress {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Off”,
nd then press {{{{# Enter}}}} key.

Note
* shows the current setting.

After about two seconds, the display re-
turns to the “Network Setup” setting
screen.

u use TCP/IP, assign the IP address to
rinter.

ote
o get the IP address for the printer, con-
ct your network administrator.

11.022.033.044 cannot be used.

ress {{{{UUUU}}}} or {{{{TTTT}}}} key until the following
essage appears, and then press {{{{# En-
r}}}} key.

he current IP address appears on the pan-
 display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} key to enter the left
most entry field of the IP address, and
then press {{{{# Enter}}}} key.

The screen changes, and the next field can
then be entered.

Note
❒ It takes a while for the display to change

after pressing {{{{UUUU}}}} or {{{{TTTT}}}} key. To set a
new IP address, press {{{{UUUU}}}} or {{{{TTTT}}}} key -
releasing immediately - and then make
sure that the display changes. The value
moves by 10 if {{{{UUUU}}}} or {{{{TTTT}}}} key is kept
pressed.

❒ When {{{{# Enter}}}} key is pressed, the cur-
sor moves to the next field.

❒ To display the previous field, press the
{{{{Escape}}}} key.

❒ Press the {{{{Escape}}}} key when no value
is entered and the screen will return to
that of step H-A, without the IP ad-
dress changing.

DHCP:

*Off

Network Setup:

 IP Address

  IP Address:

   192.000.000.000
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ake the other settings in the same way,
nd then press {{{{# Enter}}}} key.

fter the settings are made, about two sec-
nds later, the screen returns to that of step
-A.

u use TCP/IP, assign “Subnet Mask”
“Gateway Address” following the same
edure for entering the IP address.

JJJJ If you use NetWare, select the frame type
for NetWare.

Select one of the items below if necessary.

• Auto (Default)

• Ethernet ll

• Ethernet 802.2

• Ethernet 802.3

• Ethernet SNAP

Note
❒ Usually, use the default setting (“Auto”).

When you first select “Auto”, the frame
type detected by the printer is adopted. If
your network can use more than two frame
types, the printer may fail to select the cor-
rect frame type if “Auto” is selected. In this
case, select the appropriate frame type.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Frame
Type (NW)”, and then press {{{{# Enter}}}}
key.

The current setting appears on the panel
display.

IP Address:

 192.168.000.010

  Network Setup:

   Frame Type (NW)
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ress {{{{UUUU}}}} or {{{{TTTT}}}} key to display the
ame type you want to use, and then

ress {{{{# Enter}}}} key.

fter the settings are made, about two sec-
nds later, the screen returns to that of step
-A.

t the interface.

E 802.11b” appear only when the
11b interface unit are installed.

t one of the items below.

thernet

EE 802.11b

ress {{{{UUUU}}}} or {{{{TTTT}}}} key to display “LAN
ype”, and then press {{{{# Enter}}}} key.

he current setting appears on the panel
isplay.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Ether-
net”, and then press {{{{# Enter}}}} key.

After the settings are made, about two sec-
onds later, the screen returns to that of step

K-A after about 2 seconds.

LLLL Press {{{{On Line}}}} key.

“Ready” appears on the panel display.

Frame Type (NW):

*Auto

Network Setup:

 LAN Type

  LAN Type:

  *Ethernet

  Ready

  

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL003S
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t a configuration page to confirm the
ngs made.

eference
ee p.166 “Printing a Configuration Page”.

are the print server or client computer.

eference
When you prepare the print server, see
the following in correspondence with
the OS used. 

When you prepare the client computer,
see the Client Reference. 
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ndows 2000 Print Server Configuration

rinter connected to the Ethernet interface, select “SmartDeviceMonitor”, “Standard TCP/IP
LPR Port” when installing the printer driver.

eviceMonitor
4 “Configuring the Protocols” and p.27 “Installing SmartDeviceMonitor for Client” and p.28
ling the PCL 5c or RPCS Printer Driver” or p.36 “Installing the PostScript Printer Driver”.

rd TCP/IP Port, LPR Port
4 “Configuring the Protocols” and p.28 “Installing the PCL 5c or RPCS Printer Driver” or
nstalling the PostScript Printer Driver”.

want to use “LPR Port“, “Print Services for UNIX” must be installed. For more information
installing the “Print Services for UNIX”, see Windows 2000 Help.
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iguring the Protocols

uring TCP/IP and IPP for Printing

these instructions to configure Windows 2000 to use the TCP/IP protocol and IPP.

ring the printer

re the printer to use the TCP/IP protocol.

irm that the TCP/IP protocol is set to be active. (The factory default is active.)

gn an IP address and make other settings required for using the TCP/IP protocol.

rence
ore information about how to make the above settings, see p.16 “Configuring the Printer for
etwork”that comes with this printer.

CP is used to assign IP addresses, see p.307 “Using DHCP”.

 setting the IP address, use the ping command to confirm that it has been set correctly.

 [Start], point to [Programs], point to [Accessories] and then click [Command Prompt].

 the following: (Example IP address is 192.168.15.16)

 ping 192.168.15.16

 address has been configured correctly, the following message appears.

ly from 192.168.15.16

 address has been configured incorrectly, the following message appears.

uest timed out.



25

Configu

Follow 

AAAA Click

BBBB Click

CCCC Con
this c

N
❒ If

❒ If
in

DDDD Conf

Conf

EEEE To u
is no
work

R
F

Operating Instructions Administrator Reference

ring a Windows 2000 computer

these steps to configure a Windows 2000 computer to use the TCP/IP protocol.

 [Start] on the taskbar, point to [Settings], and then click [Network and Dial-up Connections].

 [Local Area Connection]. On the [File] menu, click [Properties].

firm that “Internet Protocol (TCP/IP)” is selected in the [Components checked are used by
onnection:] box under the [General] tab.

ote
 the check box for TCP/IP protocol is not selected, select the box.

 the TCP/IP protocol is not installed, click [Install] under the [General] tab and install it. For more
formation about installing the TCP/IP protocol, see Windows 2000 Help.

igure the TCP/IP protocols with an appropriate IP address, subnet mask and other settings.

irm with the network administrator that the settings are correct.

se LPR Port, Print Services for UNIX must be installed. When “Print Services for UNIX”
t installed, install it from [Optional Network Components] on the [Details] menu under [Net-
 Dial-up Connection].

eference
or more information about installing the “Print Services for UNIX”, see Windows 2000 Help.
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uring NetBEUI for Printing

these instructions to configure the network interface board and Windows 2000 to use the Net-
rotocol.

aration
se NetBEUI, use the SmartDeviceMonitor for Client port.

ring the printer

MB to print using NetBEUI (The default is active).

rence
ore information about how to make the above settings, see p.16 “Configuring the Printer for
etwork” that comes with this printer.

ring a Windows 2000 computer

these steps to configure a Windows 2000 computer to use the NetBEUI protocol.

 [Start] on the taskbar, point to [Settings], and then click [Network and Dial-up Connections].

 [Local Area Connection]. On the [File] menu, click [Properties].

firm that “NetBEUI Protocol” is selected in the [Components checked are used by this con-
on:] box under the [General] tab.

ote
 the check box for the NetBEUI protocol is not selected, select the box.

 the NetBEUI protocol is not installed, click [Install] under the [General] tab and install it. For more
formation about installing the NetBEUI protocol, see Windows 2000 Help.
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lling Software

ling SmartDeviceMonitor for Client

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

 [SmartDeviceMonitor for Client / Admin].

 to select [SmartDeviceMonitor for Client], and then click [Next >].

w the instructions on the screen.

ote
 you are required to restart the computer after the installation of SmartDeviceMonitor for Client,
start the computer and continue with necessary configurations.
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ling the PCL 5c or RPCS Printer Driver

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

portant
ever have two versions of the same printer driver installed on your system at the same time.
hen upgrading to a new version of the printer driver, delete the old version, and then install the

ew one.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

t [PCL/RPCS Printer Drivers].

software license agreement appears in the [License Agreement] dialog box.

r reading through all of the contents, click [I accept the agreement] to agree with the license
ment, and then click [Next >].
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t the printer drivers you want to use when the “Select Program” dialog box appears, and
 click [Next >].
can select more than one printer driver.

t the printer model(s) you want to use.

hange the printer name, change it in the [Change settings for 'Printer Name'] box.

ble-click the printer name to display the printer settings.

ote
he details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system
eing used, the model of printer selected, and the port being used.

 [Port:], and then select the port you want to use.

martDeviceMonitor

tandard TCP/IP Port

PR Port
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rtDeviceMonitor

lick [Add].
elect [SmartDeviceMonitor], and then click [OK].
elect a printer you want to use.

TCP/IP
A Click [TCP/IP].
B Click [Search].

Available printers will be listed.

C Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be displayed. To print

to a printer not listed here, click [Specify Address], and then type the IP address or host
name.

D Click [OK].
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NetBEUI
A Click [NetBEUI].
B Click [Search].

A list of printers that can be used by the NetBEUI protocol appears.

C Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Con-
firm the NetBEUI address on the network is on the configuration page. For more infor-
mation about printing the configuration page, see p.166 “Printing a Configuration
Page”. NetBEUI address appears as “\RNPxxxxxxx” on the configuration page. Type
the printer's network path name in the form of “%%Computer name\Share name”. Do
not type “\” as head characters but “%%”.

❒ You cannot print to printers beyond routers.

D Click [OK].



32

❖❖❖❖
Operating Instructions Administrator Reference

IPP
A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the
[Printer URL] field.

Note
❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01
or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different
name from those of any existing port name.
If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note
❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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dard TCP/IP Port

elect [Standard TCP/IP], and then click [OK].

Note
If [Standard TCP/IP Port] is not displayed, set Windows 2000 help to enable the standard
TCP/IP.

lick [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

ype the printer name or IP address in the “Printer Name or IP Address” box.

Note
A port name is automatically entered in the [Port] box. Change this if necessary.

lick [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.

he printer driver installation screen returns.
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 Port

elect [LPR Port], and then click [OK].

Note
If [LPR Port] is not displayed, Print Services for UNIX is not properly installed. Install it from
[Optional Network Components] on the [Details] menu under [Network Dialup Connection]. For more
information about installing Print Services for UNIX, see Windows 2000 Help.

ype the printer's IP address in the “Name or address of server providing lpd” box.

ype “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

 [OK].
port is added.

e sure the location for the selected printer is shown after [Port:].

ble-click [Shared] to display the shared settings.

hare the printer, check the left side of the [Shared] box.

 the box under [Shared name] to install the alternative driver for the necessary system.

ote
heck [Shared] to start installation of an alternative driver ([Windows NT 4.0/2000], [Windows 95/98])
as already been selected. 

ou can add an alternative driver after installation. See p.46 “Setting the Printer Shared”.
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figure the default printer as necessary.

ser Code
he procedure to specify the “User Code” may differ depending on the printer language.

RPCS
You can specify the “User Code” when installing the printer driver. You cannot register or edit
the “User Code” from the Printer Driver dialog box. To change the “User Code”, you must un-
install the printer driver, and then register the new “User Code” during the re-install process.

PCL 5c
You can specify the “User Code” with the Printer Driver Properties after installing the printer
driver. See printer driver's Help.

efault Printer
heck [Default Printer] to set the printer as the default printer.

 [Continue] to start printer driver installation.

ote
uring installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]
 continue the installation.

n the [Select Program] dialog box appears, click [Finish].

n the [Installation completion.] dialog box appears, click [Finish].

p the options.

ote
ou must set up the options when bidirectional transmission is disabled. For more information
bout the status of bidirectional transmission, see p.44 “Bidirectional transmission”.

eference
or more information about option settings, see p.43 “Setting Up Options”.
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ling the PostScript Printer Driver

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

portant
ever have two versions of the same printer driver installed on your system at the same time.
hen upgrading to a new version of the printer driver, delete the old version, and then install the

ew one.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

ote
he printer driver with the selected language will be installed. The printer driver will be installed
 English if you select the following languages: Portugues, Suomi

 [PostScript 3 Printer Driver].
 Printer Wizard” starts.

 [Next >].
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t the port you want to use.

martDeviceMonitor

tandard TCP/IP Port

PR Port

rtDeviceMonitor

lick [Create a new port:].
elect [SmartDeviceMonitor], and then click [Next >].
elect a printer you want to use.

TCP/IP
A Click [TCP/IP], and then click [Search].

Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when
“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when
“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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NetBEUI
A Click [NetBEUI], and then click [Search].

A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm
the NetBEUI address on the network is on the configuration page. For more information
about printing the configuration page, see p.166 “Printing a Configuration Page”. NetBEUI
address appears as “\RNPxxxxxxx” on the configuration page. Type the printer's network
path name in the form of “%%Computer name\Share name”. Do not type “\” as head char-
acters but “%%”.

❒ You cannot print to printers beyond routers.
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IPP
A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the
[Printer URL] field.

Note
❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01
or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different
name from those of any existing port name.
If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note
❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].



40

Stan

A C

B S

C C

D T
cl

E C

LPR

A C

B S

C T

D T

GGGG Conf

HHHH Cha

Conf

IIII Chec

To c

N
❒ C

h

❒ Y
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dard TCP/IP Port

lick [Create a new port:].
elect [Standard TCP/IP] in [Create a new Port], and then click [Next].
lick [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

ype the printer name or IP address in the “Printer Name or IP Address” box, and then
ick [Next>].
lick [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.

 Port

lick [Create a new port:].
elect [LPR Port] in [Create a new Port], and then click [Next].
ype the printer's IP address in the “Name or address of server providing lpd” box.

ype “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

irm to select the name of the printer whose driver you want to install, and then click [Next >].

nge the name of the printer if you want, and then click [Next >].
igure the default printer as necessary. Check [Yes] to set the printer as the default printer.

k [Share as:], and then click [Next >].
hange the printer name, change it in the [Share as:] box.

ote
heck [Shared] to start installation of an alternative driver ([Windows NT 4.0/2000], [Windows 95/98])
as already been selected.

ou can add an alternative driver after installation. See p.46 “Setting the Printer Shared”.
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t whether or not you want to print a test page, and then click [Next>].

 [Finish].
 printer driver installation.

ote
uring installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]
 continue the installation.

p the options.

eference
or more information about option settings, see p.43 “Setting Up Options”.
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ing Port Settings

the steps to change SmartDeviceMonitor for Client settings, such as the proxy server settings
RL.

re are no settings for the NetBEUI protocol.

 the [Printers] window, click the icon of the printer you want to use. On the [File] menu,
 [Properties].

 the [Ports] tab, and then click [Configure Port].
[Port Settings] dialog box appears.

or TCP/IP protocol, you can configure Timeout Settings.

Note
If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-
ent icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each
port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

or IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

ote
or more information about these settings, see SmartDeviceMonitor for Client Help.
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ng Up Options

st set up installed options, paper size and feed direction with the printer driver when bidirec-
ansmission is disabled.

itation
ange the printer settings requires Manage Printers permission. Members of the Administrators

Power Users groups have Manage Printers permission by default. When you set up options,
n using an account that has Manage Printers permission. 

 [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

 the icon of the printer you want to use. On the [File] menu, click [Properties].

ote
hen you open the Printer Properties dialog box for the first time after installing the RPCS printer

river, the confirmation window appears. After that, the initial display of the Printer Properties di-
log box appears.

 the [Accessories] tab.

ote
 you use the RPCS printer driver, Click [Change Accessories] tab.

 you use the PostScript 3 printer driver, Click [Device Settings] tab.

t options you have installed from the [Options] group, and then make any settings you require

 [OK] .
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irectional transmission

idirectional transmission is enabled, the information about the paper size and feed direction set-
utomatically sent to the printer by a computer. You can also confirm the printer status from your
r.

ectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003 and
ows NT 4.0.

u use the RPCS printer driver and bidirectional transmission is enabled, the [Change Accesso-
 tab is shaded.

RPCS printer driver supports bidirectional transmission and updates the printer status automat-
.

PCL 5c printer driver supports bidirectional transmission, you can update the printer status
ually.

PostScript 3 printer driver does not support bidirectional transmission.

ort bidirectional transmission, the following conditions are required:
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n connecting with a parallel cable
he computer must support bidirectional transmission.

he printer must be set to bidirectional transmission.

he Interface cable must support bidirectional transmission.

he machine must be connected to the computer using the standard parallel cable and parallel
nnector.

nder Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
g] must not be selected on the [port] tab with RPCS printer driver.

n connecting with the network
he printer must be set to bidirectional transmission.

martDeviceMonitor for Client included on the CD-ROM must be installed, and the TCP/IP pro-
col must be used.

nder Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
g] must not be selected on the [port] tab with RPCS printer driver.
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ng the Printer Shared

itation
ange the printer settings requires Manage Printers permission. Members of the Administrators

Power Users groups have Manage Printers permission by default. When you set up options,
n using an account that has Manage Printers permission.

 [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

 the icon of the printer you want to use. On the [File] menu, click [Properties].

t [Shared as:] under the [Sharing] tab.

are a printer with the users running a different version of Windows, click [Additional Drivers...]

ote
 you have installed an alternative driver by checking [Shared], you do not have to follow this step.

 [OK].
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dows XP, Windows Server 2003 Print Server Configuration

rinter connected to the Ethernet interface, select “SmartDeviceMonitor”, “Standard TCP/IP
LPR Port” when installing the printer driver.

eviceMonitor
8 “Configuring the Protocols” and p.50 “Installing Software” and p.51 “Installing the PCL
PCS Printer Driver” or p.57 “Installing the PostScript Printer Driver”.

rd TCP/IP Port, LPR Port
8 “Configuring the Protocols” and p.51 “Installing the PCL 5c or RPCS Printer Driver” or
nstalling the PostScript Printer Driver”.

te
ou want to use “LPR Port”, “Print Services for UNIX” must be installed. For more information
ut installing the “Print Services for UNIX”, see Windows XP or Windows Server 2003 Help.
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iguring the Protocols

uring TCP/IP and IPP for Printing

these instructions to configure the network interface board and Windows XP or Windows Serv-
to use the TCP/IP protocol and IPP.

ring the printer

re the printer to use the TCP/IP protocol.

irm that the TCP/IP protocol is set to be active. (The factory default is active.)

gn an IP address and make other settings required for using the TCP/IP protocol.

rence
ore information about how to make the above settings, see “Windows XP, Windows Server

 Configuration”, Client Reference that comes with this printer.

CP is used to assign IP addresses, see p.307 “Using DHCP”.

 setting the IP address, use the ping command to confirm that it has been set correctly.

lick [Start], point to [All Programs], point to [Accessories], and then click [Command Prompt].

ype the following: (Example IP address is 192.168.15.16)
:> ping 192.168.15.16
 the address has been configured correctly, the following message appears.
eply from 192.168.15.16
 the address has been configured incorrectly, the following message appears.
equest timed out.
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ring a Windows XP or Windows Server 2003 computer

these steps to configure a Windows XP or Windows Server 2003 computer to use the TCP/IP
l.

 [Start] on the taskbar, point to [Control Panel], and then click [Network and Internet Con-
ons].

 [Local Area Connection]. On the [File] menu, click [Properties].

firm that “Internet Protocol (TCP/IP)” is selected in the [This connection uses the following
:] box under the [General] tab.

ote
 the check box for TCP/IP protocol is not selected, select the box.

 the TCP/IP protocol is not installed, click [Install] under the [General] tab and install it. For more
formation about installing the TCP/IP protocol, see Windows XP or Windows Server 2003 Help
e.

igure the TCP/IP protocols with an appropriate IP address, subnet mask and other settings

irm with the network administrator that the settings are correct.
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lling Software

ling SmartDeviceMonitor for Client

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

 [SmartDeviceMonitor for Client / Admin].

 to select [SmartDeviceMonitor for Client], and then click [Next >].

w the instructions on the screen.

ote
 you are required to restart the computer after the installation of SmartDeviceMonitor for Client,
start the computer and continue with necessary configurations.
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ling the PCL 5c or RPCS Printer Driver

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

portant
ever have two versions of the same printer driver installed on your system at the same time.
hen upgrading to a new version of the printer driver, delete the old version, and then install the

ew one.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

t [PCL/RPCS Printer Drivers].

software license agreement appears in the [License Agreement] dialog box.

r reading through all of the contents, click [I accept the agreement] to agree with the license
ment, and then click [Next >].
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t the printer drivers you want to use when the “Select Program” dialog box appears, and
 click [Next >].
can select more than one printer driver.

t the printer model(s) you want to use.

hange the printer name, change it in the [Change settings for 'Printer Name'] box.

ble-click the printer name to display the printer settings.

ote
he details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system
eing used, the model of printer selected, and the port being used.

 [Port:], and then select the port you want to use.

martDeviceMonitor

tandard TCP/IP Port

PR Port



53

Sma

A C

B C

C S

❖❖❖❖

❖❖❖❖
Operating Instructions Administrator Reference

rtDeviceMonitor

lick [Add].
lick [OK].
elect a printer you want to use.

TCP/IP
A Click [TCP/IP], and then click [Search].

Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

IPP
A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the
[Printer URL] field.

Note
❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01
or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer
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C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different
name from those of any existing port name.
If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note
❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

dard TCP/IP Port

lick [Add].
elect [Standard TCP/IP], and then click [OK].
lick [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

ype the printer name or IP address in the “Printer Name or IP Address” box.

lick [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.
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 Port

lick [Add].
elect [LPR Port], and then click [OK].
ype the printer's IP address in the “Name or address of server providing lpd” box.

ype “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

e sure the location for the selected printer is shown after [Port:].

ble-click [Shared] to display the shared settings.

hare the printer, check the left side of the [Shared] box.

 the box under [Shared name] to install the alternative driver for the necessary system.

ote
heck [Shared] to start installation of an alternative driver ([Windows NT 4.0/2000], [Windows 95/98])
as already been selected. 

ou can add an alternative driver after installation. See p.66 “Setting the Printer Shared”.

figure the default printer as necessary.

efault Printer
heck [Default Printer] to set the printer as the default printer.

 [Continue] to start printer driver installation.

ote
uring installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue
nyway] to continue the installation.
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n the [Select Program] dialog box appears, click [Finish].

n the [Installation completion.] dialog box appears, click [Finish].

p the options.

ote
ou must set up the options when bidirectional transmission is disabled. For more information
bout the status of bidirectional transmission, see p.64 “Bidirectional transmission”.

eference
or more information about option settings, see p.63 “Setting Up Options”.
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ling the PostScript Printer Driver

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

portant
ever have two versions of the same printer driver installed on your system at the same time.
hen upgrading to a new version of the printer driver, delete the old version, and then install the

ew one.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

ote
he printer driver with the selected language will be installed. The printer driver will be installed
 English if you select the following languages: Portugues, Suomi

 [PostScript 3 Printer Driver].
 Printer Wizard” starts.

 [Next >].
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t the port you want to use.

martDeviceMonitor

tandard TCP/IP Port

PR Port

rtDeviceMonitor

lick [Create a new port:].
elect [SmartDeviceMonitor], and then [Next >].
elect a printer you want to use.

TCP/IP
A Click [TCP/IP], and then click [Search].

Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when
“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when
“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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IPP
A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the
[Printer URL] field.

Note
❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01
or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different
name from those of any existing port name.
If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note
❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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dard TCP/IP Port

lick [Create a new port:].
elect [Standard TCP/IP] in [Create a new Port], and then click [Next].
lick [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

ype the printer name or IP address in the “Printer Name or IP Address” box, and then
ick [Next>].
lick [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.

 Port

lick [Create a new port:].
elect [LPR Port] in [Create a new Port], and then click [Next].
ype the printer's IP address in the “Name or address of server providing lpd” box.

ype “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

irm to select the name of the printer whose driver you want to install, and then click [Next >].

nge the name of the printer if you want, and then click [Next >].
igure the default printer as necessary. Check [Yes] to set the printer as the default printer.

k [Share as:], and then click [Next >].
hange the printer name, change it in the [Share as:] box.

ote
heck [Shared] to start installation of an alternative driver ([Windows NT 4.0/2000], [Windows 95/98])
as already been selected.

ou can add an alternative driver after installation. See p.66 “Setting the Printer Shared”.
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t whether or not you want to print a test page, and then click [Next>].

 [Finish].
 printer driver installation.

ote
uring installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue
nyway] to continue the installation.

p the options.

eference
or more information about option settings, see p.63 “Setting Up Options”.
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ing Port Settings

the steps to change SmartDeviceMonitor for Client settings, such as the proxy server settings
RL.

 the [Printers and Faxes] window, click the icon of the printer you want to use. On the [File]
u, click [Properties].

 the [Ports] tab, and then click [Configure Port].
[Port Settings] dialog box appears.

or TCP/IP protocol, you can configure Timeout Settings.

Note
If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-
ent icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each
port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

or IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

ote
or more information about these settings, see SmartDeviceMonitor for Client Help.
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ng Up Options

st set up installed options, paper size and feed direction with the printer driver when bidirec-
ansmission is disabled.

itation
ange the printer settings requires Manage Printers permission. Members of the Administrators

Power Users groups have Manage Printers permission by default. When you set up options,
n using an account that has Manage Printers permission. 

ss the [Printers and Faxes] window from [Start] on the taskbar.

[Printers and Faxes] window appears.

 the icon of the printer you want to use. On the [File] menu, click [Properties].

ote
hen you open the Printer Properties dialog box for the first time after installing the RPCS printer

river, the confirmation window appears. After that, the initial display of the Printer Properties di-
log box appears.

 the [Accessories] tab.

ote
 you use the RPCS printer driver, click [Change Accessories] tab.

 you use the PostScript 3 printer driver, click [Device Settings] tab.

t options you have installed from the [Options] group, and then make any settings you require

 [OK] .
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irectional transmission

idirectional transmission is enabled, the information about the paper size and feed direction set-
utomatically sent to the printer by a computer. You can also confirm the printer status from your
r.

ectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003 and
ows NT 4.0.

u use the RPCS printer driver and bidirectional transmission is enabled, the [Change Accesso-
 tab is shaded.

RPCS printer driver supports bidirectional transmission and updates the printer status automat-
.

PCL 5c printer driver supports bidirectional transmission, you can update the printer status
ually.

PostScript 3 printer driver does not support bidirectional transmission.

ort bidirectional transmission, the following conditions are required:
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n connecting with a parallel cable
he computer must support bidirectional transmission.

he printer must be set to bidirectional transmission.

he Interface cable must support bidirectional transmission.

he machine must be connected to the computer using the standard parallel cable and parallel
nnector.

nder Windows XP or Windows Server 2003 [Enable bidirectional support] must be selected and
nable printer pooling] must not be selected on the [port] tab with RPCS printer driver.

n connecting with the network
he printer must be set to bidirectional transmission.

martDeviceMonitor for Client included on the CD-ROM must be installed, and the TCP/IP pro-
col must be used.

nder Windows XP or Windows Server 2003 [Enable bidirectional support] must be selected and
nable printer pooling] must not be selected on the [port] tab with RPCS printer driver.
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ng the Printer Shared

itation
ange the printer settings requires Manage Printers permission. Members of the Administrators

Power Users groups have Manage Printers permission by default. When you set up options,
n using an account that has Manage Printers permission.

ss the [Printers and Faxes] window from [Start] on the taskbar.

[Printers and Faxes] window appears.

 the icon of the printer you want to use. On the [File] menu, click [Properties].

t [share this printer] on the [Sharing] tab.

r a shared name in [Share Name]. 

are a printer with the users running a different version of Windows, click [Additional Drivers...]

ote
 you have installed an alternative driver by checking [Shared], you do not have to follow this step.

 [OK].
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ndows NT 4.0 Print Server Configuration

rinter connected to the Ethernet interface, select “SmartDeviceMonitor” or “LPR Port” when
the printer driver.

eviceMonitor
8 “Configuring the Protocols” and p.72 “Installing Software” and p.73 “Installing the PCL
PCS Printer Driver” or p.79 “Installing the PostScript Printer Driver”.

ort
8 “Configuring the Protocols” and p.73 “Installing the PCL 5c or RPCS Printer Driver” or
nstalling the PostScript Printer Driver”.

te
u want to use “LPR Port”, “Microsoft TCP/IP Printing” must be installed. For more information
ut installing the “Microsoft TCP/IP Printing”, see Windows NT 4.0 Help.
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iguring the Protocols

uring TCP/IP and IPP for Printing

these instructions to configure the network interface board and Windows NT 4.0 to use the
protocol and IPP.

ring the printer

re the printer to use the TCP/IP protocol.

irm that the TCP/IP protocol is set to be active. (The factory default is active.)

gn an IP address and make other settings required for using the TCP/IP protocol.

rence
ore information about how to make the above settings, see “Windows NT 4.0 Configuration”,

t Reference that comes with this printer.

CP is used to assign IP addresses, see p.307 “Using DHCP”.

 setting the IP address, use the ping command to confirm that it has been set correctly.

lick [Start], point to [Programs], and then click [Command Prompt].

ype the following: (Example IP address is 192.168.15.16)
:> ping 192.168.15.16
 the address has been configured correctly, the following message appears.
eply from 192.168.15.16
 the address has been configured incorrectly, the following message appears.
equest timed out.
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ring a Windows NT 4.0 computer

these steps to configure a Windows NT 4.0 computer to use the TCP/IP protocol.

n [Control Panel] and double-click the [Network] icon. Confirm that “TCP/IP Protocol” is
 in the [Network protocols] box under the [Protocols] tab.

ote
 the TCP/IP protocol is not installed, click [Add] under the [Protocols] tab and install it. For more
formation about installing the TCP/IP protocol, see Windows NT 4.0 Help.

igure the TCP/IP protocols with an appropriate IP address, subnet mask and other settings.

irm that the settings are correct with the network administrator.

 the [Services] tab, and confirm that “Microsoft TCP/IP Printing” is installed.

icrosoft TCP/IP Printing” is not installed, click [Add] under the [Services] tab, and install it.
ore information about installing and configuring network services, see Windows NT 4.0 Help.
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uring NetBEUI for Printing

these instructions to configure the network interface board and Windows NT 4.0 to use the Net-
rotocol.

aration
se NetBEUI, use the SmartDeviceMonitor for Client port.

ring the printer

re the printer to use the NetBEUI protocol.

le SMB to print using NetBEUI (The default is active).

rence
ore information about how to make the above settings, see “Windows NT 4.0 Configuration”,

t Reference that comes with this printer.
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ring a Windows NT 4.0 computer

e NetBEUI protocol on the Windows NT 4.0 computer, and change the LAN adapter number
umber).

n [Control Panel] and double-click the [Network] icon. Confirm that “NetBEUI Protocol” is
 in the [Network Protocols] box under the [Protocols] tab.

ote
 the NetBEUI protocol is not installed, click [Add...] under the [Protocols] tab, and install it. For
ore information about installing the NetBEUI protocol, see Windows NT 4.0 Help.

nge the Lana Number. Click the [Services] tab, click “NetBIOS Interface” in the [Network
ices:] box , and then click [Properties:].

 the Lana Number corresponding the Nbf protocol of the [Network Route] headline, and
 click [Edit].

 “0” as the Lana Number.

ote
 another protocol’s Lana Number is configured at “0”, change it to another number other than “0”.

 [OK].

 [Close], and then close the [Network] dialog box.

r confirming the message to restart, click [Yes].

ote
fter you change the Lana Number, you must restart the computer.
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lling Software

ling SmartDeviceMonitor for Client

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

 [SmartDeviceMonitor for Client / Admin].

 to select [SmartDeviceMonitor for Client], and then click [Next >].

w the instructions on the screen.

ote
 you are required to restart the computer after the installation of SmartDeviceMonitor for Admin,
start the computer and continue with necessary configurations.
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ling the PCL 5c or RPCS Printer Driver

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

portant
ever have two versions of the same printer driver installed on your system at the same time.
hen upgrading to a new version of the printer driver, delete the old version, and then install the

ew one.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

t [PCL/RPCS Printer Drivers].

software license agreement appears in the [License Agreement] dialog box.

r reading through all of the contents, click [I accept the agreement] to agree with the license
ment, and then click [Next >].

t the printer drivers you want to use when the “Select Program” dialog box appears.
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t the printer model(s) you want to use.

hange the printer name, change it in the [Change settings for 'Printer Name'] box.

ble-click the printer name to display the printer settings.

ote
he details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system
eing used, the model of printer selected, and the port being used.

 [Port:], and then select the port you want to use.

martDeviceMonitor

PR Port

rtDeviceMonitor

lick [Add].
elect [SmartDeviceMonitor], and then click [OK].
elect a printer you want to use.

TCP/IP
A Click [TCP/IP], and then click [Search].

Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.
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NetBEUI
A Click [NetBEUI], and then click [Search].

A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm
the NetBEUI address on the network is on the configuration page. For more information
about the printing of configuration page, see p.166 “Printing a Configuration Page”. Net-
BEUI address appears “\RNPxxxxxxx” on a configuration page. Type the printer's network
path name in form of “%%Computer name \Share name”. Do not type “\” as head charac-
ters but “%%”.

❒ You cannot print to printers beyond routers.
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IPP
A Click [IPP].

The IPP settings dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the
[Printer URL] field.

Note
❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01
or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different
name from those of any existing port name.
If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note
❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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 Port

lick [Add].
elect [LPR Port], and then click [OK].

Note
If [LPR Port] is not displayed, “Microsoft TCP/IP Printing” is not installed. Click [Add] on the
[Service] tab to install “Microsoft TCP/IP Printing”. For more information about installing the
“Microsoft TCP/IP Printing”, see Windows NT 4.0 Help.

ype the printer's IP address in the “Name or address of server providing lpd” box.

ype “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

e sure the location for the selected printer is shown after [Port:].

ble-click [Shared] to display the shared settings.

hare the printer, check the left side of the [Shared] box.

 the box under [Shared name] to install the alternative driver for the necessary system.

ote
heck [Shared] to start installation of an alternative driver ([Windows NT 4.0/2000], [Windows 95/98])
as already been selected. 

ou can add an alternative driver after installation. See p.88 “Setting the Printer Shared”.

figure the default printer as necessary.

efault Printer
heck [Default Printer] to set the printer as the default printer.
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 [Continue] to start printer driver installation.

n the [Select Program] dialog box appears, click [Finish].

n the [Installation completion.] dialog box appears, click [Finish].

p the options.

ote
ou must set up the options when bidirectional transmission is disabled. For more information
bout the status of bidirectional transmission, see p.86 “Bidirectional transmission”.

eference
or more information about option settings, see p.85 “Setting Up Options”.
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ling the PostScript Printer Driver

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

portant
ever have two versions of the same printer driver installed on your system at the same time.
hen upgrading to a new version of the printer driver, delete the old version, and then install the

ew one.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

ote
he printer driver with the selected language will be installed. The printer driver will be installed
 English if you select the following languages: Portugues, Suomi

 [PostScript 3 Printer Driver].
 Printer Wizard” starts.
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 [Next >].

t the port you want to use.

martDeviceMonitor

PR Port

rtDeviceMonitor

lick [Create a new port:].
elect [SmartDeviceMonitor], and then [New Port...].
elect a printer you want to use.

TCP/IP
A Click [TCP/IP], and then click [Search].

Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when
“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when
“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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NetBEUI
A Click [NetBEUI], and then click [Search].

A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm
the NetBEUI address on the network is on the configuration page. For more information
about printing the configuration page, see p.166 “Printing a Configuration Page”. NetBEUI
address appears as “\RNPxxxxxxx” on the configuration page. Type the printer's network
path name in the form of “%%Computer name\Share name”. Do not type “\” as head char-
acters but “%%”.

❒ You cannot print to printers beyond routers.
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IPP
A Click [IPP].

The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the
[Printer URL] field.

Note
❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01
or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different
name from those of any existing port name.
If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note
❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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 Port

elect [Add Port:].
elect [LPR Port] in [Create a new Port], and then click [Next].
ype the printer's IP address in the “Name or address of server providing lpd” box.

ype “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

irm to select the name of the printer whose driver you want to install, and then click [Next >].

nge the name of the printer if you want, and then click [Next >].
igure the default printer as necessary. Check [Yes] to set the printer as the default printer.

k [Shared], and then click [Next >].
hange the printer name, change it in the [Share Name:] box.

ote
heck [Shared] to start installation of an alternative driver ([Windows NT 4.0/2000], [Windows 95/98])
as already been selected. 

ou can add an alternative driver after installation. See p.88 “Setting the Printer Shared”.

t whether or not you want to print a test page, and then click [Next>].

 [Finish].
 printer driver installation.

p the options.

eference
or more information about option settings, see p.85 “Setting Up Options”.
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ing Port Settings

the steps to change SmartDeviceMonitor for Client settings, such as the proxy server settings
RL.

re are no settings for the NetBEUI protocol.

 the [Printers] window, click the icon of the printer you want to use. On the [File] menu,
 [Properties].

 the [Ports] tab, and then click [Configure Port].
[Port Settings] dialog box appears.

or TCP/IP protocol, you can configure Timeout Settings.

Note
If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-
ent icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each
port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

or IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

ote
or more information about these settings, see SmartDeviceMonitor for Client Help.
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ng Up Options

st set up installed options, paper size and feed direction with the printer driver when bidirec-
ansmission is disabled.

itation
ange the printer settings requires Full Control Access permission. Members of the Administra-
nd Power Users groups have Full Control Access permission by default. When you set up op-

, log on using an account that has Full Control Access permission. 

 [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

 the icon of the printer you want to use. On the [File] menu, click [Properties].

ote
hen you open the Printer Properties dialog box for the first time after installing the RPCS printer

river, the confirmation window appears. After that, the initial display of the Printer Properties di-
log box appears.

 the [Accessories] tab.

ote
 you use the RPCS printer driver, click the [Change Accessories] tab.

 you use the PostScript 3 printer driver, click the [Device Settings] tab.

t options you have installed from the [Options] group, and then make any settings you re-
e.

 [OK] .
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irectional transmission

idirectional transmission is enabled, the information about the paper size and feed direction set-
utomatically sent to the printer by a computer. You can also confirm the printer status from your
r.

ectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003 and
ows NT 4.0.

u use the RPCS printer driver and bidirectional transmission is enabled, on Windows 95/98/Me,
navailable functions are shaded.

RPCS printer driver supports bidirectional transmission and updates the printer status automat-
.

PCL 5c printer driver supports bidirectional transmission, you can update the printer status
ually.

PostScript 3 printer driver does not support bidirectional transmission.

ort bidirectional transmission, the following conditions are required:
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n connecting with a parallel cable
he computer must support bidirectional transmission.

he printer must be set to bidirectional transmission.

he Interface cable must support bidirectional transmission.

he machine must be connected to the computer using the standard parallel cable and parallel
nnector.

nder Windows NT 4.0 [Enable bidirectional support] must be selected and [Enable printer pool-
g] must not be selected on the [port] tab with RPCS printer driver.

n connecting with the network
he printer must be set to bidirectional transmission.

martDeviceMonitor for Client included on the CD-ROM must be installed, and the TCP/IP pro-
col must be used.

nder Windows NT 4.0 [Enable bidirectional support] must be selected and [Enable printer pool-
g] must not be selected on the [port] tab with RPCS printer driver.
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ng the Printer Shared

itation
ange the printer settings requires Full Control Access permission. Members of the Administra-
nd Power Users groups have Full Control Access permission by default. When you set up op-

, log on using an account that has Full Control Access permission.

[Printers] window to set up the printer.

 [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

 the icon of the printer you want to use. On the [File] menu, click [Properties].

t [Shared] in the [Sharing] tab.

ote
 you use alternate drivers for Windows 95/98/Me client, service pack 4 or more is required. And
stall the appropriate printer driver for each client.

are a printer with the users running a different version of Windows, click [Additional Drivers...]

ote
 you have installed an alternative driver by checking [Shared], you do not have to follow this step.

 [OK].
printers attached to the network are displayed.
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tWare Configuration

ter describes how to configure the printer to use as a print server or a remote printer in a Net-
ironment.

guring the NetWare Protocol using the Control Panel

X/SPX protocol must be installed on your computer. If it is not, see Windows Help for instruc-

the {{{{Menu}}}} key.

” appears on the panel display.

the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Host Interface”.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

enu:

Host Interface
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s the {{{{# Enter}}}} key.

following message appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Network Setup”.

s the {{{{# Enter}}}} key.

following message appears on the panel display.

Host Interface:

 I/O Buffer

Host Interface:

 Network Setup

Network Setup:

 IP Address
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t the NetWare protocol.

ote
ll protocols are active by the default.

o not select protocols that are not used on your network.

 you use Pure IP on NetWare 5.1, configure the printer to active the TCP/IP protocol.

ress the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Active Protocol”, and then press the {{{{# Enter}}}} key.

ress the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “NetWare”.

ress the {{{{# Enter}}}} key.

he current setting appears on the panel display.

Active Protocol:

 TCP/IP

NetWare:

*Active
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t the frame type for NetWare.

t one of the following items if necessary.

uto (Default)

thernet ll

thernet 802.2

thernet 802.3

thernet SNAP

ote
 most situations, use the default setting (“Auto”). When you first select “Auto”, the frame type

rst detected by the printer is adopted. If the network can use more than two frame types, the
rinter may fail to select the correct frame type if “Auto” is selected. In this case, select the ap-
ropriate frame type.

ress the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Frame Type (NW)”.

ress the {{{{# Enter}}}} key.

he current setting appears on the panel display.

ress the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the frame type you want to use.

ress the {{{{# Enter}}}} key.

 about two seconds, the display returns to “Network Setup”.

Network Setup:

 Frame Type (NW)

Frame Type (NW):

*Auto
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ress the {{{{On Line}}}} key.

eady” appears on the panel display.

t the configuration page to check settings you have made.

ore information about how to print a configuration page, see p.166 “Printing a Configuration
”.

martDeviceMonitor for Admin
sing a printer in a NetWare environment, configure the NetWare printing environment by using
martDeviceMonitor for Admin.

Note
If you configure the NetWare printing environment by using SmartDeviceMonitor for Admin
under the following environments, NetWare Client provided by Novell is required.

• NDS mode in Windows 95/98/Me

• NDS or Bindary mode in Windows 2000/XP, Windows Server 2003, Windows NT 4.0

Use the version of Novell Client provided with your operating system or the latest version.

rinters listed by SmartDeviceMonitor for Admin
martDeviceMonitor for Admin displays a list of printers, which are connected to the network.
 you cannot find out the printer from the displayed list, see the configuration page printed from
e printer. For more information about printing a configuration page, see p.166 “Printing a Con-
guration Page”.

Ready
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are 3.x - Advanced Settings

al procedures for configuring the printer differ depending on whether the network interface
 configured as a print server or as a remote printer. This section describes how to configure it
etWare 3.x environment.

section assumes NetWare is functional and that the necessary environment for NetWare Print
ice is available.
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ling SmartDeviceMonitor for Admin

martDeviceMonitor for Admin on your computer. For the installation procedure, see p.114 “In-
SmartDeviceMonitor for Admin”.

stalling SmartDeviceMonitor for Admin, go to p.95 “Setting Up as a Print Server” to use this
r as a print server, or to p.97 “Setting Up as a Remote Printer” to use it as a remote printer.

g Up as a Print Server

on to the file server as Supervisor or a Supervisor equivalent.

 SmartDeviceMonitor for Admin.

 the [Group] menu, and click [Search Device], and then select [IPX/SPX].
t of printers appears

ote
 you cannot identify which printer to configure from the list of printers, print Configuration Page
om the printer and find the desired printer. For more information about printing the Configura-
on Page, see p.166 “Printing a Configuration Page”. 

 no printer name appears on the list, match the frame types of the IPX/SPX protocol between
e computer and printer. Use the [Network] dialog box of Windows to change the frame type of
e computer. For more information about changing the frame type of equipment, see p.89 “Con-
uring the NetWare Protocol using the Control Panel”.

t a printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

 to select [Wizard], and then click [OK].
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 the device name into the [Device Name] box and comment into the [Comment] box as nec-
y, and then click [Next].

t the [NetWare] check box, and then click [Next].

 to select [Bindery mode], type the file server name into the [File Server Name] box, and then
 [Next].
e [File Server Name] box, type the name of the file server in which a print server is to be created.
can also select a file server from the list that appears by clicking [Browse].

 the print server name into the [Print Server Name] box, and the printer name into the
ter Name] box, and the print queue name into the [Print Queue Name] box, and then click
t].
 the [Print Server Name] box, type the name of the NetWare print server within 47 characters.

 the [Printer Name] box, type the name of the NetWare printer.

 the [Print Queue Name] box, type the name of the print queue to be added to NetWare.

r confirming the settings, click [Next].
settings take effect, and the NIB Setup Tool exits.

 SmartDeviceMonitor for Admin.

 the printer power off and on.

ote
o confirm that the printer is configured correctly, type the following from the command prompt.

:> USERLIST

 the printer works as configured, the name of the print server appears as an attached user.
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g Up as a Remote Printer

on to the file server as Supervisor or a Supervisor equivalent.

 the SmartDeviceMonitor for Admin.

 the [Group] menu, and click [Search Device], and then select [IPX/SPX].
t of printers appears.

ote
 you cannot identify which printer to configure from the list of printers, print the Configuration
age from the printer and find the desired printer. For more information about printing the Con-
guration Page, see p.166 “Printing a Configuration Page”.

 no printer name appears on the list, match the frame types of the IPX/SPX protocol between
e computer and printer. Use the [Network] dialog box of Windows to change the frame type of
e computer. For more information about changing the frame type of equipment, see p.89 “Con-
uring the NetWare Protocol using the Control Panel”.

t a printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

 to select [Property Sheet] and click [OK].

 the [NetWare] tab, and then make the following settings.

 the [Print Server Name] box, type the name of the print server.

 the [File Server Name] box, type the name of the file server in which a print server is to be
eated.

y clicking [Browse], you can select a file server among those listed in the [Browse] dialog box.

 the [Print Server Operation Mode] group, click [As Remote Printer].
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 the [Remote Printer No.] box, type the printer number.

Important
Use the same printer number as that to be created in the printer server.

lick [OK] to close the property sheet.

fter a confirmation dialog box appears, click [OK].

he [NIB] menu, click [Exit] to exit the NIB Setup Tool.

 “PCONSOLE” from the command prompt.

 PCONSOLE

te a print queue as follows:

ote
 you use a currently defined print queue, go to step J.

rom the [Available Options] menu, select [Print Queue Information], and then press Enter key.

ress Insert key, and then type a print queue name.

ress ESC key to return to the [Available Options] menu.

te a printer as follows:

rom the [Available Options] menu, select [Print Server Information], and then press Enter key.

o create a new print server, press Insert, and then type a print server name.

 you use a currently defined print server, select one of the print servers shown in the [Print Server]
st.

Important
Use the same name as that specified in the NIB Setup Tool. (Step F - A).



99

C F

D F

E S

❒

F If

A .

G A

T

H P

I P

KKKK Assi

A F

B S

C P

❒

D F

W

LLLL Pres
Operating Instructions Administrator Reference

rom the [Print Server Information] menu, select [Print Server Configuration].
rom the [Print Server Configuration] menu, select [Printer Configuration].
elect the printer which is indicated as “Not Installed”.

Important
Use the same number as that specified as Remote Printer No. using the NIB Setup Tool.
(Step F - D).

 you change the name of the printer, type a new name.

 name “Printer x” is assigned to the printer. The “x” stands for the number of the selected printer

s type, select [Remote Parallel, LPT1].
he IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.

ress the ESC key, and then click [Yes] in the confirmation dialog box.

ress the ESC key to return to [Print Server Configuration Menu].

gn print queues to the created printer as follows:

rom [Print Server Configuration Menu], select [Queues Serviced By Printer].
elect the printer created in step J.

ress the Insert key to select a queue serviced by the printer. 

Note
You can select more than one queue at a time.

ollow the instructions on the screen to make other necessary settings.

hen you have finished the above steps, confirm that the queues are assigned.

s the ESC key until “Exit?” appears, and then select [Yes] to exit PCONSOLE.
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t the print server by typing the following from the console of the NetWare Server.

is running, restart it after exiting it.

o exit
AREE: unload pserver

o start
AREE: load pserver print_server_name

ote
 the printer works as configured, “Waiting for job” appears.
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are 4.x, 5/5.1, 6/6.5- Advanced Settings

al procedures for configuring the printer differ depending on whether the network interface
 configured as a print server or as a remote printer. This section describes how to configure it
etWare 4.x, 5/5.1, 6/6.5 environment.

se NetWare 5/5.1, 6/6.5
 you use Pure IP, use the printer as a print server. You cannot use the printer as a remote printer
hen you use Pure IP.

 you use Pure IP, configure the printer to use the TCP/IP protocol. For more information about
ow to make the settings, see p.89 “Configuring the NetWare Protocol using the Control Panel”.
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ling SmartDeviceMonitor for Admin

martDeviceMonitor for Admin on your computer. For the installation procedure, see p.114 “In-
SmartDeviceMonitor for Admin”.

stalling SmartDeviceMonitor for Admin, go to p.102 “Setting Up as a Print Server” to use this
r as a print server, or to p.107 “Setting Up as a Remote Printer” to use it as a remote printer.

g Up as a Print Server

on to the file server as Supervisor or a Supervisor equivalent.

 SmartDeviceMonitor for Admin.

 the [Group] menu, and click [Search Device], and then select [IPX/SPX] or [TCP/IP].
t of printers appears.

ote
 you use Pure IP, select [TCP/IP].

 you cannot identify which printer to configure from the list of printers, print the Configuration
age from the printer and find the desired printer. For more information about printing the Con-
uration Page, see p.166 “Printing a Configuration Page”.

 no printer name appears in the list, match the frame types of the IPX/SPX protocol between
e computer and printer. Use the [Network] dialog box of Windows to change the frame type of
e computer. For more information about changing the frame type of equipment, see p.89 “Con-
uring the NetWare Protocol using the Control Panel”.
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t a printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

eference
 you use Pure IP, see p.105 “Using Pure IP in the NetWare 5/5.1, 6/6.5 Environment”

 to select [Wizard], and then click [OK].

 the device name into the [Device Name] box and comment into the [Comment] box as nec-
y, and then click [Next].

t the [NetWare] check box, and then click [Next].

 to select [NDS Mode], type the file server name into the [File Server Name] box, the NDS
name into the [NDS Tree:] box and the context into the [NDS Context:] box, and then click
t].
e [File Server Name] box, type the name of the file server in which a print server is to be created.
can also select a file server from the list that appears by clicking [Browse].
licking [Browse], you can select a NDS context among those listed in the [Browse] dialog box.

 context, object names are typed from a lower object and divided by a period. For example, if
ant to create a print server into NET under DS, type “NET.DS”.
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 the print server name into the [Print Server Name] box, and the printer name into the
ter Name] box, and the print queue name into the [Print Queue Name] box, and the print
e volume into the [Print Queue Volume], and then click [Next].
 the [Print Server Name] box, type the name of the NetWare print server within 47 characters.

 the [Printer Name] box, type the name of the NetWare printer.

 the [Print Queue Name] box, type the name of the print queue to be added to NetWare.

 [Print Queue Volume], type the print queue volume. As a volume, object names are typed from
lower object and divided by a period. You can select a volume by clicking [Browse].

r confirming the settings, click [Next].
settings take effect, and the NIB Setup Tool exits.

 SmartDeviceMonitor for Admin.

 the printer power off and on.

ote
o confirm that the printer is configured correctly, type the following from the command prompt.

:> NLIST USER /A/B

 the printer works as configured, the name of the print server appears as an attached user.
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ure IP in the NetWare 5/5.1, 6/6.5 Environment

on to the file server as Admin or an Admin equivalent.

 SmartDeviceMonitor for Admin.

 [Property Sheet], and then click [OK].
[NIB Setup Tool] dialog box appears.

 the [NetWare] tab, and make the following settings.

 the [Print Server Name] box, type the name of the print server.

 the [File Server Name] box, type the name of the file server in which a print server is to be
eated.

y clicking [Browse], you can select a file server among those listed in the [Browse File Server]
ialog box.

 the [NDS Context:] box, type the context of the print server.

y clicking [Browse], you can select NDS tree and a NDS context among those listed in the
rowse Context] dialog box.

s context, object names are typed from a lower object and divided by a period. For example, if
ou want to create a print server into Net under DS, type “NET.DS”.
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 the [Print Server Operation Mode] group, click [As Print Server].
lick [OK] to close the property sheet.

fter a confirmation dialog box appears, click [OK].

 SmartDeviceMonitor for Admin.

r this step, go to step H on p.107 “Setting Up as a Remote Printer”.
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g Up as a Remote Printer

on to the file server as Admin or an Admin equivalent.

 the SmartDeviceMonitor for Admin.

 the [Group] menu, and click [Search Device], and then select [IPX/SPX].
t of printers appears.

ote
 you cannot identify which printer to configure from the list of printers, print the Configuration
age from the printer and find the desired printer. For more information about printing the Con-
guration Page, see p.166 “Printing a Configuration Page”.

 no printer name appears on the list, match the frame types of the IPX/SPX protocol between
e computer and printer. Use the [Network] dialog box of Windows to change the frame type of
e computer. For more information about changing the frame type of equipment, see p.89 “Con-
uring the NetWare Protocol using the Control Panel”.

t a printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

 to select [Property Sheet], and then click [OK].
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 the [NetWare] tab, and make the following settings.

 the [Logon Mode] area, select [File Server Mode] or [NDS Mode].

Note
If [File Server Mode] is selected, a connecting destination will be chosen based on the string
entered in step C.

If [NDS Mode] is selected, a connecting destination will be chosen based on the string entered
in step D.

 the [Print Server Name(P):] box, enter the name of the print server.

Important
Use the same name as that of the print server name to be set from NWadmin (L-C).

Limitation
Enter up to 47 alphanumeric characters.

 the [File Server Name(F):] box, enter the name of the file server in which a print server is
 be created.

y clicking [Browse(B)...], you can select a file server among those listed in the [Browse(B)...]
ialog box.

Limitation
Enter up to 47 alphanumeric characters.

 the [NDS Tree(T):] box, enter the NDS tree name in which to make the file server.

y clicking [Browse(B)...], you can select the NDS tree name and NDS context name from their
sts.

Limitation
Enter up to 32 alphanumeric characters (“-” and “_” can be used).
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 the [NDS Context(C):] box, enter the context in which the print server is to be created.

Limitation
Enter up to 127 alphanumeric characters.

 the [Print Server Option Mode] area, click [As Remote Printer(R)].
 the [Remote Printer No.(N)] box, enter the number of the printer.

Important
Use the same number as that of the printer to be created in the print server (M-D).

lick [OK] to close the NIB Setup Tool - Network board list] dialog box.

he [NIB] menu, click [Exit] to exit the NIB Setup Tool.

 Windows, run NWadmin.

eference
or more information about NWadmin, see the documentation that comes with the NetWare.

te a print queue as follows:

elect the container object the print queue is located in among those in the directory tree,
nd then click [Create] on the [Object] menu.

 the [Class of new object] box, click “Print Queue”, and then click [OK].
 the [Print Queue name] box, type the name of the print queue.

 the [Print Queue Volume] box, click the [Browse] button.

 the [Available objects] box, click the volume in which the print queue is created, and then
ick [OK].
fter confirming the settings, click [Create].
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te a printer as follows:

elect the container object the printer is located in, and then click [Create] in the [Object]
enu.

 the [Class of new object] box, click “Printer”, and then click [OK]. When you are using
etWare 5, click “Printer (Non NDPS)”.

 the [Printer name] box, type the name of the printer.

lick [Define additional properties] to check a box, and then click [Create].

gn print queues to the created printer as follows:

lick [Assignments], and then click [Add] in the [Assignments] group.

 the [Available objects] box, click the queue created in step I, and then click [OK].
lick [Configuration], and in the [Printer type] box, select [Parallel] using the drop-down
enu, and then click [Communication]. 
lick [Manual load] in the [Communication type] group, and then click [OK].
fter confirming the settings, click [OK].

te a print server as follows:

elect the context specified using the NIB Setup Tool (Step I - AAAA), and on the [Object]
enu, click [Create].
 the [Class of new object] box, click “Print Server”, and then click [OK]. When you are us-
g NetWare 5, click “Print Sever (Non NDPS)”.

 the [Print Server name] box, type the name of the print server.

Important
Use the same name as that specified using the NIB Setup Tool. (Step F - B).

lick [Define additional properties] to check a box, and click [Create].
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gn the printer to the created print server as follows:

lick [Assignments], and then click [Add] in the [Assignments] group.

 the [Available objects] box, click the queue created in the step K, and then click [OK].
 the [Printers] group, click the printer assigned in step BBBB, and then click [Printer Number].

ype the printer number, and then click [OK].

Important
Use the same number as that specified as Remote Printer No. using the NIB Setup Tool.
(Step F - G).

fter confirming the settings, click [OK].

t the print server by typing the following from the console of the NetWare Server.

s running, restart it after exiting it.

o exit
AREE: unload pserver

o start
AREE: load pserver print_server_name
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ing SmartDeviceMonitor for Admin

artDeviceMonitor for Admin, you can not only monitor the status of network printers, but
s you to change the configurations of the network interface board using the TCP/IP protocol
X protocol.

iceMonitor for Admin is equipped with the following functions.

 Information function

cks the printer's network settings and detailed information of devices.

cks the number of pages printed for each computer, using the user codes.

cks the results of print jobs executed from the computer.

bles you to change the printer's network settings.

 Settings function

its the settings to be done from the control panel, and disables changes to be made to some
he items.

bles the selection of paper type loaded in the printer.

 Saver function

itches to the Energy Saver Mode, and wakes up from the Energy Saver Mode.

 Status function

cks the information on printing, paper exhaustion, and such, on the computer.

s function

nitors multiple printers at the same time. When there are many printers, you can create groups
 classify the printers to facilitate management.
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is used for monitoring the machines.

ct the appropriate protocol stack for your operating system.

ng system Protocol stack

ft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX *1 /SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98/Me

Novell Client for Windows 95/98/Me

ft Windows 2000 TCP/IP provided with Windows 2000

IPX *1 /SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client for Windows NT/2000/XP

ft Windows XP TCP/IP provided with Windows XP

IPX *1 /SPX provided with Windows XP

Novell Client for Windows NT/2000/XP

ft Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX *1 /SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

ft Windows NT 4.0 TCP/IP provided with Windows NT 4.0

IPX *1 /SPX provided with Windows NT 4.0

Client Service for NetWare provided with Windows NT

Novell Client for Windows NT/2000/XP
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lling SmartDeviceMonitor for Admin

e all applications that are running.

rt the CD-ROM into the CD-ROM drive.

 Run will start the installer.

ote
uto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”
cated on the CD-ROM root directory.

t a language to change the interface language, and then click [OK].
following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
s (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
ska (Swedish)

t [SmartDeviceMonitor for Client / Admin] installation, and then click [Next].

software license agreement appears in the [License Agreement] dialog box.

r reading through all of the contents, click [I accept the agreement] to agree with the license
ment, and then click [Next >].

w the instructions on the screen.

ote
 you are required to restart the computer after the installation of SmartDeviceMonitor for Admin,
start the computer and continue with necessary configurations. 
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ging the Network Interface Board Configuration

 SmartDeviceMonitor for Admin.

 the [Group] menu, point to [Search Device], and then select [TCP/IP] or [IPX/SPX]. A list of
ters appears.

ote
elect the protocol of the printer you want to change its configuration.

he list, Select a printer you want to change its configuration.

 the [Tools] menu, select [NIB Setup Tool].
NIB Setup Tool starts up.

t [Wizard], [Property Sheet], or [Web browser], and then click [Next].
hen configuring the network interface board for the first time, select [Wizard].
hen changing the configuration of the network interface board or configuring it in detail, select
roperty Sheet].
 you select [Web browser], the Web browser starts up and Web Image Monitor Administrator
ode user ID and password dialog box appears. Settings can be made using Web Image Moni-
r. See p.125 “Using a Web Browser” for details.
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cting [Wizard]

ill in the necessary items, and then click [Next].

cting [Property Sheet]

 configuration list appears on the dialog box.

or more information about each item on the dialog box, see SmartDeviceMonitor for Admin Help
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ing the Menus on the Printer's Control Panel

 SmartDeviceMonitor for Admin.

 the [Group] menu, point to [Search Device], and then select [TCP/IP] or [IPX/SPX].
t of printer appears.

ote
elect the protocol of the printer you want to change its configuration.

t a desired printer.

 the [Tools] menu, point [Device Settings], select [Lock Printer Operation Panel].
Web browser starts up, and the screen that prompts you to type the user name and a password
ars.

 the user name and the password, and then click [OK].
general configuration window appears.

 the [Lock Printer Operation Panel] menu, select [Enable].

ote
he Panel Lock function that can be set here is the same as that on the control panel of this ma-
hine.

 [Apply].

 the Web browser.
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ging the Paper Type

 SmartDeviceMonitor for Admin.

 the [Group] menu, point to [Search Device], and then select [TCP/IP] or [IPX/SPX].
t of printer appears.

ote
elect the protocol of the printer you want to change its configuration.

he list, Select a printer whose paper type you want to change.

 the [Tools] menu, point [Device Settings], select [Select Paper Type].
Web browser starts up, and the screen that prompts you to type the user name and a password
ars.

 the user name and the password, and then click [OK].
paper type configuration window appears.

 the [Paper Type] pull-down menu, select paper type.

 [Apply].

 the Web browser.
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aging User Information

s under each user code can be managed, and functions can be restricted to certain users only.

rence
etails about User Management Tool, see SmartDeviceMonitor for Admin Help.

g up the User Management Tool

 SmartDeviceMonitor for Admin.

he [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX].
t of printers appears.

ote
elect the protocol of the printer whose configuration you want to change.

e list, select the printer whose figures you want to manage.

 the [Tools] menu, select [User Management Tool].
ssword screen appears.

r the password, and then click [OK].

ote
he default password is “password”.

 Code Maintenance Tool starts up.
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ying the Number of Sheets Printed

 the [User Page Count] tab of User Management Tool.

mation about the number of sheets printed appears.

g Information about the Number of Sheets Printed

s of printed sheets per user code can be saved as a csv file.

 the [User Page Count] tab of User Management Tool.

 the [File] menu, and then click [Export User Statics List].

ify the folder and file name to save it to, and then click [Save].



121

Reset

Number

AAAA Click

BBBB Click

CCCC Click

DDDD Selec
The 

EEEE Click
The 

FFFF Click
Chan

Settin

Individu

AAAA Click

BBBB Selec

CCCC Click
The 

DDDD Click

Chan
Operating Instructions Administrator Reference

ting Information about the Number of Sheets Printed

s of printed sheets per user code can be reset (to 0).

 the [User Page Count] tab of User Management Tool.

 the user whose information is to be reset.

 the [Edit] menu, and then click [Reset User Counters].

t the check box of the item to be reset, and then click [OK].
following message appears.

 [Yes].
number is reset.

 the [Edit] menu and click [Apply Settings].
ges to information are applied.

g Restrictions on Functions Use

al functions can be restricted.

 the [Edit] menu of User Management Tool, and then click [Restrict Access To Device].

t the check boxes of the functions to restrict.

 [OK].
following message appears.

 [Yes].
ges to settings are applied.
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g the Functions Available Individual Users

owing explains adding a user and setting the functions available to that user.

 the [Access Control List] tab from User Management Tool.

 the [Edit] menu, and then click [Add New User].

t the user code and user name.

t the check box of the functions available to the new user.

ote
 a function's check box is gray, no restrictions are set. For details about setting these functions for
se, see p.121 “Setting Restrictions on Functions Use”, or SmartDeviceMonitor for Admin Help.

 [OK].

 the [Edit] menu, and then click [Apply Settings].
ges to settings are applied.

eference
ee SmartDeviceMonitor for Admin Help for details about for setting restrictions for use.
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iguring the Energy Save Mode

 SmartDeviceMonitor for Admin.

 the [Group] menu, point to [Search Device], and then select [TCP/IP] or [IPX/SPX].
t of printer appears.

ote
elect the protocol of the printer you want to change its configuration.

t the device you want to make a setting for.

do not need to select anything if you want to make a setting for all the devices in the group.

 [Group] and point to [Energy Save Mode].

ake a setting only for the device you have selected, click [Set Individually].

ake a setting for all the devices in the group, click [Set By Group].

 select any energy saver mode from the menu that appears.
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ng a Password

 SmartDeviceMonitor for Admin.

 the [Group] menu, point to [Search Device], and then select [TCP/IP] or [IPX/SPX].
t of printer appears.

ote
elect the protocol of the printer you want to change its configuration.

he list, select a printer you want to change its configuration.

 the [Tools] menu, select [NIB Setup Tool].
NIB Setup Tool starts up.

ote
o prevent the network interface board configuration from being changed accidentally by some-
ne other than the network administrator, you can set a password in [NIB Setup Tool] that is dif-
rent from the network password. Click [Option] to set a password in [NIB Setup Tool].

t [Property Sheet], and then click [OK].

 the [Password] tab.

 [Change Password], and then enter a password.

 [OK].
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ing a Web Browser

heck machine status and change settings using the web browser. This function is called Web
nitor.

an it do?
n remotely check the status of a machine or specify its settings over the network using a com-
 Web browser.
llowing functions are available with Web Image Monitor:

playing machine status/settings

cking print job status/history

rrupting a job that is currently printing

etting

naging the Address Book

king machine settings

ting mail notification

ting the network protocol

ting security

uring the machine
quires TCP/IP to be installed. After the machine has been configured to use TCP/IP, it will
sible to adjust settings using a Web Image Monitor.

ference
 more information about configuring the machine to use TCP/IP, see p.16 “Configuring the
ter for the Network”.
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 Browser

imitation
 the Web browser in use is older than the recommended version or [Java Script] and [Cookie] are
ot available, display and operation problems may occur.

 you are using a proxy server, change the Web browser settings. Consult your network admin-
trator about the settings.

ometimes after clicking [Back], the previous page may not appear. In this case, click [Refresh]
r [Reload].

his machine information cannot refresh automatically. Click [Reload] or [Refresh] on the Web
rowser, or click [Refresh] on the work area when you want to refresh.

Browser

dows 95/98/Me/2000/XP
Microsoft Internet Explorer 5.5 or later

Netscape Navigator 7.0 or later
dows Server 2003

dows NT 4.0

 OS 8.1 or later Netscape Navigator 7.0 or later

 OS X 10.1 or later
Netscape Navigator 7.0 or later

Safari 1.0 or later



127

Goin

AAAA Acce
addr

The 

N
❒ If

s

❒ W
su
d

Usin
Operating Instructions Administrator Reference

g to the Top Page

ss the machine by entering “http: //(IP address of this machine)/” in the web browser's
ess bar.

Web Image Monitor Top Page appears.

ote
 the machine's host name is registered on the DNS or WINS server, you can enter it. For details,
ee p.307 “Using DHCP”.

hen this machine has the optional network data protection unit and server authentication is is-
ed, a message appears indicating that encrypted communication is in effect. Click [OK] on the

isplayed message.

g the frame function, Web Image Monitor is divided over the following areas:
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er area
can register favorite URLs using [URL]. To
 the Help section, click [Help].

u area
e buttons are for configuring the network
face board and checking machine status.

3. Status
Displays machine status, network interface
board name, and comments.

3
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s of Menu Configuration and Mode

at appear on the menu area differ between user mode and administrator mode.

rk area which appears under the selected menu displays machine status under user mode and
 setting under administrator mode.

ndicates machine status can be displayed.

indicates machine settings can be changed.

indicates the menu is not displayed.

Menu User Mode
Administrator 

Mode

inter Job  $

evice  $

Input Tray ❍ ❍

Output Tray ❍ ❍

Toner ❍ ❍

Function ❍ ❍

System ❍ ❍

Printer Language ❍ ❍

Printer Spool Printing *1 ❍ $

Job History ❍ $

Error Log ❍ $

Locked & Sample Print *2 $ $
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 Book  $

ration Paper  $

System  $

Printer ❍ $

User Code Management  $

Notification *3  $

E-mail *3 ❍ $

Interface ❍ $

Network Protocol Protocol ❍ $

TCP/IP ❍ $

NetWare ❍ $

AppleTalk ❍ $

SMB ❍ $

SNMP  $

Rendezvous ❍ $

System Log ❍ ❍

Webpage ❍ $

Menu User Mode
Administrator 

Mode
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Spool Printing] menu appears only when the optional hard disk drive is installed, and [Spool Print-
s set to [On] using the control panel's [System] Menu.
n the optional hard disk drive is attached.
n [On] is set for [Notify by Email] in the [System] menu of the control panel.
SSL/TLS] menu and [Certificates] menu appears only when the optional network data protection unit
talled.

ration Security Password  $

Access Control  $

IPP Authentication  $

SSL/TLS *4  $

Certificates *4  $

Menu User Mode
Administrator 

Mode
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u Summary

s a summary of each Web Image Monitor

rence
etails about displaying status and chang-
ettings, see p.135 “Using Help on the
 Image Monitor”.

 Printer Job

eset Printer Job] on the Top Page to reset
jobs and jobs on standby.

 Device

eset Device] on the Top Page to reboot
e current job is completed.

s machine status, including remaining
 of sheets in the paper tray and amount of
ng toner.

Job

• Printer
Allows display and deletion of lists, including
those for spool printing jobs and error history,
and Sample Print/Locked Print.

Note
❒ In user mode, Sample Print/Locked Print is

possible, but spool printing jobs and error
history cannot be deleted.

Address Book

User information can be registered, displayed,
changed, and deleted.
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uration

r
he paper size and type for the paper tray.

m
e machine system settings, including ma-
e name, spool printing ON/OFF, and
P server address.

er
ngs can be made for certain items set us-
he control panel, including system setup
nterface setup.

 Code Management
hether to restrict usage by function.

fication
ify what is to be notified by e-mail.
ngs can be made for this machine's mail
ess, notice destination group, notification
lert item, notice timing, etc.

il
e required settings for the notice by e-
 function.
end alert information using the notice by
il function, set the destination e-mail ad-
, SMTP, etc.

• Interface
Make interface-related settings, including
Ethernet and wireless LAN.

• Network
Make settings for each protocol, including
TCP/IP and NetWare enabling/disabling, and
displaying the system log.

• Webpage
Make settings Web Image Monitor Help, link
destinations, and the display language.

• Security
Make security settings, including password
changes for Web Image Monitor administra-
tor mode access, access control, and issuance
server authentication.
Server authentication can be realized by ob-
taining a certificate issued from a certification
authority or issuing your own certificates.
When a certificate is issued, encrypted com-
munication becomes possible. The optional
network data protection unit is necessary to
use the server authentication function.
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ss in Administrator Mode

he Web Image Monitor Top Page, click
inistrator Mode].
password and user name dialog box ap-
.

r your user name and password, and
 click [OK].
se the default account, enter no user
, and “password” for the password.
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g Help on the Web Image Monitor

sing Help for the first time, clicking ei-
lp] in the header area or the icon marked
e work area makes the following screen
From there you can check Help in two
t ways, as shown below: 

king a Help Using the Internet
can check the latest Help updates.

nloading and Checking Help
can download Help to your computer’s

 drive and view it. As the Help URL, you
pecify the path to the local file to view
elp without connecting to the Internet.

licking [Help] in the header area, Help
nts normally appear.

icking “?”, the Help icon in the work area,
 for the items shown in the work area nor-
 appears.

Downloading Help

AAAA In the [OS] list, select the operating system.

BBBB In the [Language] list, select the language.

CCCC Click [Download].

DDDD Download Help by following the messages
on screen.

EEEE Save the downloaded compressed file, and
then decompress it.

Note
❒ To check the downloaded Help, specify

the path where the file is decompressed.
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g the Address (URL) to the 
Button

 link the address (URL) of the [Help] but-
he Help files on the computer or Web

ss Web Image Monitor in Administra-
ode.

eference
.134 “Access in Administrator Mode”.

left area, click [Configuration].

 [Webpage]

e [Help URL] box, enter the path to the
 files.

u copied the Help files to “C:\HELP\EN”,
 “file ://C:/HELP/”. For example, if you
d the files to a Web server and the index
 is “http:// a.b.c.d/HELP/EN/index.html”,
 “http://a.b.c.d/HELP/”.

 [Apply].
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nitoring and Configuring the Printer

ging Names and Comments

hange printer names and make a comment on printers to easily identify the printers listed on
iceMonitor for Client.

ing utilities are used to change printer names and comments.

DeviceMonitor for Admin
s you to change names and comments when the TCP/IP protocol or IPX/SPX protocol is
le. You can install SmartDeviceMonitor for Admin from the CD-ROM that comes with the
. For more information about installing SmartDeviceMonitor for Admin, see p.102 “Install-
artDeviceMonitor for Admin”.

rowser
s you to change names and comments when the TCP/IP protocol is available.

te
h of the names, in a TCP/IP protocol form (printer name) and in a NetBEUI protocol form, is
nged individually. Comments are, however, common to both of them.

 factory default name consists of “RNP” and the last 3 bytes of the MAC address on the net-
k interface board. For example, when the MAC address is 00:00:74:62:7D:D5, the factory de-
lt name is “RNP627DD5”. Comments are not configured.
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DeviceMonitor for Admin

 SmartDeviceMonitor for Admin.

 the [Group] menu, point to [Search Device], and select [TCP/IP] or [IPX/SPX]. A list of print-
ppears.

ote
elect the protocol of the printer you want to change its configuration.

he list, select a printer whose network interface board you want to change its configuration.

 the [Tools] menu, select [NIB Setup Tool].
NIB Setup Tool starts up.

t [Property Sheet], and then click [OK].

/IP

lick the [General] tab, and then type the device name into the [Device Name] box and com-
ent into the [Comment] box.

In the [Device Name] box, type the name of the printer within 15 characters. The factory de-
fault name consists of “RNP” and the last 3 bytes of the MAC address on the network inter-
face board. For example, when the MAC address is 00:00:74:62:7D:D5, the factory default
name is “RNP627DD5”. No name of 9 characters is permitted if the prefix is “RNP”. Also,
when DHCP is selected as an IP address setting, the number of characters is limited to 13
characters.

In the [Comment] box, type any comment on printers within 31 characters.
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EUI

lick the [General] tab, and then type the comment into the [Comment] box.

 the [Comment] box, type any comment on printers within 31 characters.

lick the [NetBEUI] tab.

ype the computer name into the [Computer Name] box.

In the [Computer Name] box, type the name that helps you to identify printers using the Net-
BEUI protocol. The factory default name consists of “RNP” and the last 3 bytes of the MAC
address on the network interface board. For example, when the MAC address is
00:00:74:62:7D:D5, the factory default name is “RNP627DD5”. A maximum of 15 charac-
ters consisting of uppercase English letters, numeric, or symbols (except "*+,/:;<=>?[\]|. and
space) can be used. No name is permitted if the prefix is “RNP”. You must avoid the dupli-
cation of the same name on a network.

 [OK].
NIB Setup Tool exits, and the setting is transmitted to the printer.

 SmartDeviceMonitor for Admin.
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rowser

 the Web browser.

r “http: //(IP address of printer whose you want to change its settings)/” in the address
to access the printer whose settings you want to change.

Web Image Monitor Top Page appears.

 [Administrator Mode].
log box that prompts you to type the user name and a password appears.

 the user name and the password, and then click [OK].
 only the password in this dialog box. The factory default password is “password”.

e left area, click [Configuration], and then click [Network].

nge names and comments.

/IP

lick [TCP/IP].
 a name is used by Ethernet or wireless LAN, enter it in [Host Name] the [Ethernet] column.

 the [Host Name] box, type the name of the printer within 15 characters. The factory default
ame consists of “RNP” and the last 3 bytes of the MAC address on the network interface board.
or example, when the MAC address is 00:00:74:62:7D:D5, the factory default name is

NP627DD5”. No name of 9 characters is permitted if the prefix is “RNP”. Also, when DHCP
 selected as an IP address setting, the number of characters is limited to within 13 characters.
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lick [SMB].
ype the name into the [Computer Name] box and comment into the [Comment] box.

In the [Computer Name] box, type the name that helps you to identify printers using the SMB
protocol. The factory default name consists of “RNP” and the last 3 bytes of the MAC address
on the network interface board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is “RNP627DD5”. A maximum of 15 characters consisting of up-
percase English letters, numeric, or symbols (except "*+,/:;<=>?[\]|. and space) can be used.
No name is permitted if the prefix is “RNP”. You must avoid the duplication of the same
name on a network.

 [Apply].
setting is transmitted to the printer.

 the Web browser.
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laying the Status of Printer

 view the status of printers using SmartDeviceMonitor for Admin, SmartDeviceMonitor for
r Web browser.

DeviceMonitor for Admin

 SmartDeviceMonitor for Admin.

 the [Group] menu, point to [Search Device], and then select [TCP/IP] or [IPX/SPX].
status of printers is indicated with an icon in the list.

ote
or more information about the status icons, see SmartDeviceMonitor for Admin Help.

ing further information, click the desired printer to select from the list, and then click
n] on the [Device] menu.

status of the printer appears on the dialog box.

ote
or more information about each item on the dialog box, see Help.
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DeviceMonitor for Client

 the status of printers using SmartDeviceMonitor for Client, you must, in advance, configure
eviceMonitor for Client so it monitors the printer whose status you want to view.

ring Printers

 SmartDeviceMonitor for Client.

SmartDeviceMonitor for Client icon appears at the right end of the taskbar.

t-click the SmartDeviceMonitor for Client icon, and check if the desired printer is con-
ed on the pop-up menu that appears.

s configured, see p.144 “Displaying the Status of Printers”.

e desired printer is not configured, click [Options] on the pop-up menu.

[SmartDeviceMonitor for Client - Options] dialog box appears.

 the printer to be monitored, and select the [To Be Monitored] check box from the [Moni-
g Information Settings] group.

ote
electing the [Displayed on Task Bar] check box will bring up the status of a printer with an icon on
e SmartDeviceMonitor for Client icon on the task tray.

or more information about the status icons, see Help.

 [OK].
dialog box closes and the configured printer is monitored.
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ing the Status of Printers

 SmartDeviceMonitor for Client.

ing further information on the status, right-click the SmartDeviceMonitor for Client icon,
then click the desired printer.

status of the printer appears on the dialog box.

ote
or more information about each item on the dialog box, see Help.

rowser

 the Web browser.

r “http: //(IP address of the printer whose you want to display its status)/” in the address
to access the printer whose status you want to display.

Web Image Monitor Top Page appears.

e left area, click [Status].

 the menu item you want to check.

printer's status is displayed.

ote
or more information about each item, see Web Image Monitor Help.
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ine Status Notification by E-mail

lerts, such as paper tray empty or paper
cur, machine status notification can be
d using the notify by e-mail function.

 notification e-mail is sent to a previously
il address.

tion timing and content, etc. can also be

Notify by Email] on the [System] menu to
 using control panel (it is set to [On]
 shipped from the factory).

eference
or more information, see p.186 “System
enu”

t web browser, and then access this
hine by inputting “http: //(IP address
is machine)/” in the address bar of the
browser.

top page of the Web Image Monitor ap-
.

CCCC At the top page of Web Image Monitor,
click [Administrator Mode].
The dialog box for entering the password and
user name appears.

DDDD Enter your user name and password, and
then click [OK].
To use the factory default account, enter no
user name and enter “password” for the pass-
word.

EEEE In a left frame, click [Configuration].

FFFF Click [E-mail].

GGGG Make settings for the following:

The dialog box for making e-mail notification
settings appears.

• Key Operator's E-mail Address

• Items in the SMTP column

• Items in the POP before SMTP column
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 [Apply].

left frame, click [Notification].
dialog box for making notification set-
 appears.

e settings for the following:

evice E-mail Address

otification Message

ems in the Groups to Notify column

ems in the Select Groups/Items to Notify
lumn

o make detailed settings for items, click
dit] next to [Detailed Settings of Each

em], make settings in the dialog box that
pears, and then click [OK].

 [Apply].

 web browser.
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king Printer Settings with the Control Panel

 Chart

on describes how to change the default settings of the printer and provides information about
eters included in each menu.

 a while for the display to change after pressing the key. Press and release the key immedi-
ake sure that the display changes, and then proceed to the next step.

Category Function Menu

int Select Action / Error File(s) *1 

int Select Action / Error File(s) *1  

t Tray 1 Ppr.Size

Paper Type

Tray Locking

Tray Priority

rint Config.P/Er.Log

Config. Page

Error Log

Menu List

Color Demo Page

PCL Config.Page

PS Config. Page
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t Print PDF Config.Page

Hex Dump

Operations Test

ance Color Calibrate

Registration

PlainPaper Type

ThickPaper Type

A5/HLT Size

Maint. Reset

HD Format *1  

4C.Graphic Mode

WL.LAN Signal *2 

WL.LAN Defaults *2 

Key Repeat

Menu Protect *3 

Category Function Menu
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Prt. Err Report

Auto Continue

Memory Overflow

Copies

Printer Lang.

Sub Paper Size

Page Size

Def.Print Lang.

Duplex *4 

Energy Saver 1

Energy Saver 2

Unit of Measure

Spool Printing *1  

Letterhead Mode

RAM Disk

Notify by Email

erface I/O Buffer

I/O Timeout

Network Setup

IEEE 802.11b *5 

USB Setting *3 

Category Function Menu



150

PCL Me

⇒  p.208

PS Men

⇒  p.214

PDF Me

⇒  p.218

Languag
Operating Instructions Administrator Reference

nu Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Courier Font

Ext. A4 Width

Append CR to LF

Resolution

u Data Format

Resolution

Color Setting

Color Profile

nu PDF: Change PW

PDF Group PW

Resolution

Color Setting

Color Profile

e⇒  p.225

Category Function Menu



151

*1 The “
menu

*2 The “
ed in

*3 Whil
{{{{Men

*4 The “
*5 The “
Operating Instructions Administrator Reference

Sample Print” menu, the “Locked Print” menu, the “HD Format” menu, and the “Spool Printing”
 appear only when the optional hard disk drive is installed.
WL.LAN Signal” and the “WL.LAN Defaults” menu appears only when “IEEE 802.11b” is select-
 “LAN Type” in the Host Interface menu. 
e the printer is On Line, press the {{{{# Enter}}}} key, and then press the {{{{Escape}}}} key, finally press the
u}}}} key. You can access the “Menu Protect”, “USB Setting” on the panel display.
Duplex” menu appears only when the optional duplex unit is installed.
IEEE 802.11b” menu appears only when the optional 802.11b interface unit is installed.
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ssing the Main Menu

e {{{{Menu}}}} key, and “Menu” appears on the panel display.

nu shows the following 11 items which can be displayed one by one by pressing the {{{{UUUU}}}} or
.

ple Print

ed Print

r Input

Test Print

tenance

m 

 Interface

 Menu

enu

 Menu

uage

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S
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 optional hard disk drive is not installed, the “Sample Print” menu and the “Locked Print” menu
ot be displayed on the control panel.

key: Press to go to the next page.

key: Press to go back to the previous page.

 making the printer settings, be sure to return to the previous menu by pressing the {{{{Escape}}}}

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL005S
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 making the printer settings, press the {{{{On Line}}}} key to return to the “Ready” condition.

revised settings are not canceled even if the power switch is turned off.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL003S
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r Input Menu

e 4 menu items in the “Paper Input” menu.

 1 Ppr.Size

r Type

 Locking

 Priority

rence
ore information about loading paper in the tray, see Maintenance Guide.
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 Input Parameters

Menu Description

pr.Size The paper size for the tray 1.

For more information about paper sizes that can be set in the bypass tray, see “Pa-
per and Other Media Supported by This Printer”, Maintenance Guide.

• Auto

• Custom Size

Note
❒ Default: Auto

ype If you use different kinds of paper, set the paper type for Tray 1, Tray 2. 

For more information about paper sizes that can be set in each tray, seeMainte-
nance Guide.

❖❖❖❖ Tray 1
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Pre-
printed, Thick Paper, Labels, Cardstock, Transparency, Glossy

❖❖❖❖ Tray 2
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Pre-
printed, Labels

Note
❒ Default : Plain Paper

❒ Only the installed trays appear on the panel display.
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cking If you use different kinds of paper, you can lock a tray to prevent printing on 
wrong paper such as letterhead or colored paper. When “Auto Select” is selected 
in the Paper Source selections from the printer driver, the locked tray will not be 
used. You can select each tray set to on or off.

Tray 1, Tray 2

Note
❒ Default : Off

❒ When using paper of an irregular size, if [Tray Locking] is specified 
as [On], the size specified by the operation panel is given priority, 
while if it is specified as [Off], the size specified by the printer driver 
is given priority.

❒ Only the installed trays appear on the panel display.

❒ You can lock multiple trays.

❒ If you want to use the locked tray, you must select the tray from the 
printer driver and the control panel each.

❒ When a locked tray is selected from the printer driver, the printer 
does not search for another tray.

ority You can set which tray should be checked first when “Auto Tray Select” is se-
lected in the Paper Source selections from the printer driver. When printing from 
DOS, the tray selected here is used when no tray is selected for a print job.

Tray 1, Tray 2

Note
❒ Default : Tray 1

❒ Only the installed trays appear on the panel display.

❒ It is recommended that you load paper of the size and direction you 
most frequently use in the tray selected with “Tray Priority”.

Menu Description
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ing the Paper Input Menu

cking

s the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Paper Input”, and then press the {{{{# Enter}}}} key.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Tray Locking”, and then press the {{{{# Enter}}}} key.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 Paper Input

Paper Input:

 Tray Locking
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s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the tray to change the tray locking off, and then press the
ter}}}} key.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Off”, and then press the {{{{# Enter}}}} key.

 for two seconds.

er Input” appears on the panel display.

s the {{{{On Line}}}} key.

dy” appears on the panel display.

Tray Locking:

 Tray 1

Tray 1:

*Off

Ready
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iority

s the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Paper Input”, and then press the {{{{# Enter}}}} key.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Tray Priority”, and then press the {{{{# Enter}}}} key.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 Paper Input

Paper Input:

 Tray Priority
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s the {{{{UUUU}}}} or {{{{TTTT}}}} key to select the tray type you want to use.

s the {{{{# Enter}}}} key. Wait for two seconds.

nu” appears on the panel display.

s the {{{{On Line}}}} key.

ady” appears on the panel display.

Ready

 



162

List/

There ar

• Conf

• Conf

• Erro

• Men

• Colo

• PCL

• PS C

• PDF

• Hex 

• Oper
Operating Instructions Administrator Reference

Test Print Menu

e 10 menu items in the “List/Test Print” menu.

ig.P/Er.Log

ig. Page

r Log

u List

r Demo Page

 Config.Page

onfig. Page

 Config.Page

Dump

ations Test
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est Print Parameters

Menu Description

/Er.Log You can print the configuration page and error log.

Page You can print the current configuration of the printer. See p.166 “Printing a Con-
figuration Page”. 

g You can print an error report.

ist You can print the Menu List which shows the function menus of this printer.

emo Page You can print the Color Demo Page.

nfig.Page You can print the current configuration of the PCL.

ig. Page You can print a list of the installed PS Fonts.

nfig.Page You can print the Adobe® PDF Reference, Memory/HDD status, Printing Con-
figuration, and Resident Fonts.

mp You can print the data sent by the computer using the Hex Dump mode.

ns Test You can confirm paper feeding, discharge and printing operation, including op-
tions. Options—related settings are only displayed for those options actually in-
stalled. When a specified function cannot be performed, a message appears and 
printing is interrupted. When the function operates properly, a border with black 
lines is printed out.
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g the Configuration Page and Error Log

figuration page and error log can be printed out together.

ortant
configuration page and error log print out on A4 or Letter (8 1/2 x 11) size paper, so place same
r Letter (8 1/2 x 11) size paper in the paper tray.

s {{{{Menu}}}} key.

nu” appears on the panel display.

s {{{{TTTT}}}} or {{{{UUUU}}}} key to display the “List/Test Print” menu, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 List/Test Print
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s {{{{TTTT}}}} or {{{{UUUU}}}} key to display the “Config.P/Er.Log” menu, and then press {{{{# Enter}}}} key.

configuration page and error log print out. The test print menu screen returns on completion of
ing.

portant
 you cannot print the configuration page and Error Log, check for an error message appears on
e panel display. For more information about error messages, see “Troubleshooting”, Mainte-
ance Guide.

s {{{{On Line}}}} key.

dy” appears on the panel display.

List/Test Print:

 Config.P/Er.Log

Ready
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g a Configuration Page

owing example explains the procedure for printing out the configuration page. The procedure
ing out other lists is basically the same.

ortant
configuration page prints out on A4 or Letter (8 1/2 x 11) size paper, so place same A4 or Letter
 x 11) size paper in the paper tray.

s the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{TTTT}}}} or {{{{UUUU}}}} key to display the “List/Test Print” menu. and then press {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 List/Test Print
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s the {{{{TTTT}}}} or {{{{UUUU}}}} key to display the “Config. Page” menu. and then press {{{{# Enter}}}} key

configuration page prints out. The test print menu screen returns on completion of printing.

portant
 you cannot print the configuration page, check for an error message appears on the panel dis-
lay. For more information about error messages, see “Troubleshooting”, Maintenance Guide.

s the {{{{On Line}}}} key.

dy” appears on the panel display.

List/Test Print:

 Config. Page

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL003S

Ready
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reting the Configuration Page

 Reference

er ID
s the serial number assigned to the board by its manufacturer.

ware Version
irmware
hows the version number of the printer controller firmware.

ngine
hows the version number of the printer engine firmware.

CS
hows the version number of the network interface board.

s Printed
s the total number of pages printed by the printer to date.

l Memory
s the total amount of memory (SDRAM) installed on the printer.

roller Option
item(s) appears when the controller option(s) is installed.

er Language
s the version number of the printer language.

ons
s the options that you installed.
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put

he settings made under the “Paper Input” menu.

rence
ore information, see p.155 “Paper Input Menu”.

ance

he settings made under the “Maintenance” menu.

rence
ore information, see p.171 “Maintenance Menu”.

he settings made under the “System” menu. 

rence
ore information, see p.186 “System Menu”.

erface

he settings made under the “Host Interface” menu. 

HCP is active on the network, the actual IP Address, Subnet Mask and Gateway Address ap-
arentheses on the configuration page.

rence
ore information, see p.197 “Host Interface Menu”.
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nu

he settings made under the “PCL Menu”. 

rence
ore information, see p.208 “PCL Menu”.

u

he settings made under the “PS Menu”. 

rence
ore information, see p.214 “PS Menu”.

nu

he settings made under the “PDF Menu”. 

rence
ore information, see p.218 “PDF Menu”.

e Information

he interface information.
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tenance Menu

e 12 menu items in the “Maintenance” menu.

r Calibrate

stration

Paper Type

kPaper Type

LT Size

t. Reset

ormat

raphic Mode

LAN Signal

LAN Defaults

Repeat

u Protect
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enance Menu Parameters 

Menu Description

alibrate Corrects the gradation of bright area (highlight parts) and medium areas (middle 
parts) when printing.

❖❖❖❖ Start Calibr. 1
You can print the gradation correction sheet 1.

❖❖❖❖ Start Calibr. 2
You can print the gradation correction sheet 2.

❖❖❖❖ Reset
You can reset the gradation correction value to the initial value

Reference
For more information, see “Correcting the Color Gradation”, Main-
tenance Guide.

tion ❖❖❖❖ Prt. Test Sheet
You can print the registration test sheet.

❖❖❖❖ Adjustment
You can select the start position for printing on page.

• Horiz.: Tray 2

• Horiz.:Dup.Back
-3.5 to +3.5 (by 0.5 mm)

Note
❒ The registration values are not default.

❒ Only the installed trays appear on the panel display.
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PlainPap

ThickPa
Operating Instructions Administrator Reference

er Type You can select the type of plain paper you wish to use as a default.

❖❖❖❖ Tray 1, Tray 2
• 60-74g/16-20lb

• 74-90g/20-24lb

• 90-105g/24-28lb

Note
❒ Default: 74-90g/20-24lb

per Type You can select the type of thick paper you wish to use as a default.

Limitation
❒ Tray 1 can be used for thick paper printing. Thick paper cannot be 

used if it is placed in the optional paper feed unit tray (tray 2).

• 105-163g28-43lb

• 163-210g43-55lb

• Postcard(Japan)

• Thin Envelopes

• Thick Envelopes

Note
❒ Default: 105-163g28-43lb

Menu Description
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A5/HLT

Maint. R

HD Form
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 Size [A5/HLT Size] can be selected when A5 vertical or HLT (51/2 x 81/2) vertical paper 
is placed in tray 1.

Limitation
❒ A5 vertical or HLT (51/2 x 81/2) vertical paper cannot be used if it is 

placed in the optional paper feed unit tray (tray 2).

• Tray 1 HLT

• Tray 1 A5

Note
❒ Default: 

• Metric: Tray 1 A5

• Inch: Tray 1 HLT

eset Maintenance Reset allows the user to reset each internal unit counters such as the 
PCU and fusing unit. These counters can be reset at anytime, but are necessary at 
the time of unit reinstallation.

For more information, see “Replacing Consumables and Maintenance Kit”, 
Maintenance Guide.

at You can format the hard disk drive.

Available when the optional hard disk drive is installed.

Reference
For more information about formatting the hard disk drive, see “At-
taching the Hard Disk Drive Type 2600”, Option Setup Guide.

Menu Description
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hic Mode This setting adjusts how much each color of toner overlaps when printing. If 
characters or lines are blurred, selecting [Text Priority] may make them clearer. 
Select [Photo Priority] for normal use.

Note
❒ Default: Photo Priority

N Signal You can check the signal strength when using the wireless LAN. 

Reference
For more information about displaying the signal strength. See 
p.181 “Displaying the Signal Strength”.

N Defaults You can reset the wireless LAN settings to the default.

eat The default setting [On] enables the user to scroll through menu items and set-
tings by holding the key down continuously, the [Off] setting requires the user to 
press the key for each Cursor/Scroll movement.

Menu Description
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e the printer is On Line, press the {{{{# Enter}}}} key, and then press the {{{{Escape}}}} key. Finally, press the
u}}}} key. You can access the “Menu Protect” menu on the panel display.

rotect *1 This procedure lets you protect menu settings against accidental changes. It 
makes it impossible to change the menu settings you make with the normal pro-
cedure unless you perform the required key operation. In a network environment, 
protecting settings restricts changes to menu settings to network administrators.

• Level 1

• Level 2

• Off

Note
❒ While the printer is On Line, press the {{{{# Enter}}}} key, and then press 

the {{{{Escape}}}} key, finally press the {{{{Menu}}}} key. You can access the 
“Menu Protect” menu on the panel display.

❒ You can protect the “Maintenance”, “System”, “Host Interface” and 
“Language” menu on Level 1.

❒ You can protect the “Paper Input”, “Maintenance”, “System”, “Host 
Interface” and “Language” menu on Level 2.

Menu Description
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ing the Maintenance Menu

ing the menus

k if the On Line indicator is on. If not, press the {{{{On Line}}}} key to enter the “Ready” con-
n.

s the {{{{# Enter}}}} key, then the {{{{Escape}}}} key, and then the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the “Maintenance” menu, and then press the {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Maintenance:

 Color Calibrate
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s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Menu Protect”.

s the {{{{# Enter}}}} key.

following message appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to select the levels desired, and then press the {{{{# Enter}}}} key. Wait
wo seconds.

intenance” appears on the panel display.

Maintenance:

 Menu Protect

Menu Protect:

*Off
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s the {{{{On Line}}}} key.

dy” appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL003S

Ready
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ng Protect

k if the On Line indicator is on. If not, press the {{{{On Line}}}} key to enter the “Ready” con-
n.

s the {{{{# Enter}}}} key, then the {{{{Escape}}}} key, and then the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Maintenance” menu, and then press the {{{{# Enter}}}} key.

following message appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Menu Protect”, and then press the {{{{# Enter}}}} key.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Off”, and then press the {{{{# Enter}}}} key. Wait for two seconds

intenance” appears on the panel display.

s the {{{{On Line}}}} key.

dy” appears on the panel display.

Maintenance:

 Color Calibrate

Ready
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ing the Signal Strength

eed to check the IEEE 802.11b (Wireless LAN) signal, select “WL.LAN Signal” in the “Main-
” menu.

s the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{TTTT}}}} or {{{{UUUU}}}} key to display the “Maintenance” menu, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 Maintenance
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s the {{{{TTTT}}}} or {{{{UUUU}}}} key to display “WL.LAN Signal”, and then press {{{{# Enter}}}} key

of the following messages appears on the panel display.

Maintenance:

 WL.LAN Signal

WL.LAN Signal

Good       100%

WL.LAN Signal

Fair        80%

WL.LAN Signal

Poor         60%

WL.LAN Signal

Unavailable  30%
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ote
 “WL.LAN Signal” is not displayed, “IEEE 802.11b” has not been selected for “LAN Type” in
etwork Setup” of the Host Interface menu. Select “IEEE 802.11b” for “LAN Type”, and then

heck the “WL.LAN Signal” in the Maintenance menu again.

ignal status can be measured in the [Infrastructure] mode of the wireless LAN's “Comm. Mode”.
 the “Comm. Mode” is set to [Ad hoc] or [802.11 Ad hoc], signal status can not be measured. To
easure signal status, select [Infrastructure] as the [Comm. Mode] from [IEEE 802.11b] on the [Host
terface] menu.

very time you press the {{{{# Enter}}}} key, the signal is updated.

he signal is indicated as “Good” if the signal strength is 86-100%, “Fair” if the strength is 61-
5%, “Poor” if the strength is 31-60%, and “Unavailable” if the strength is 0-30%. If the signal is
nstable or unavailable, remove obstacles or move the printer to a place where the signal can
e received.

sing wireless devices or microwave sources near the printer might affect the signal.

s the {{{{Escape}}}} key.

s the {{{{On Line}}}} key.

dy” appears on the panel display.

Ready
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g the IEEE 802.11b (Wireless LAN) Settings

eed to reset the wireless LAN setting, select “WL.LAN Defaults” in the Maintenance menu.

five items that can be reset in “IEEE 802.11b” of the Host Interface menu are “Comm. Mode”,
nnel”, “Trans. Speed”, “ WEP Setting”, and “SSID”.

s the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{TTTT}}}} or {{{{UUUU}}}} key to display the “Maintenance” menu, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 Maintenance
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s the {{{{TTTT}}}} or {{{{UUUU}}}} key to display “WL.LAN Defaults”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

s the {{{{# Enter}}}} key.

wireless LAN setting value is reset.

r about three seconds, “Ready” appears on the panel display.

Maintenance:

 WL.LAN Defaults

WL.LAN Defaults:

Reset->Defaults?

Defaults reset

Press # to exit

Ready
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em Menu

e 16 menu items in the “System” menu.

rr Report

 Continue

ory Overflow

es

er Lang.

Paper Size

 Size

rint Lang.

ex

gy Saver 1

gy Saver 2

 of Measure

l Printing

rhead Mode

 Disk

fy by Email
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m Parameters

Menu Description

Report You can select whether or not to have an error report printed when a printer error 
or memory error occurs.

• Off

• On

Note
❒ Default: Off

ntinue You can set whether Auto Continue is enabled. When it is on, printing continues 
after a system error occurs.

• Off

• Immediate

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

Note
❒ Default: Off

❒ When it is on, and certain types of error occur, the current job might 
be canceled, and the machine automatically resumes the next job.
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Memory

Copies

Printer L
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 Overflow You can select whether the memory overflow error report should be printed.

• Do not Print

• Error Info. 

Note
❒ Default: Do not Print

You can specify how many pages to print.

This setting is disabled if the number of pages to print has been specified with the 
printer driver or a command.

• 1-999

ang. You can specify the printer language.

• Auto Detect

• PCL

• PS

• PDF

• XPDL_0

• XPDL_1

Note
❒ Default: Auto Detect

Menu Description
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er Size You can enable the Sub Paper Size feature. When you select “Auto”, the printer 
substitutes the paper of a certain size which is to be an alternative if the paper cur-
rently specified is not loaded. When you select “Off”, the printer uses the paper 
in the current specified paper input tray regardless of its size.

• Off

• Auto 

Note
❒ Default: Off

e You can specify the default paper size.

8 1/2 x 14, 8 1/2 x 11, 7 1/4 x 10 1/2, 5 1/2 x A4, A5, Custom Size

Note
❒ Default: 

• Metric version: A4

• Inch version: 8 1/2 x 11

❒ The value set for page size is applied when the paper size is not 
specified in the print data.

t Lang. You can specify the default printer language.

• PCL

• PS

• PDF

• XPDL_0

• XPDL_1

Note
❒ Default: PCL

Menu Description
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You can select whether you want to print on both sides of each page.

• Off

• Short Edge Bind

• Long Edge Bind

Note
❒ Default: Off

❒ This menu appears only when the optional duplex unit is installed.

Saver 1 You can set On/Off for the Energy Save Mode level 1. This is Preheat mode.

• On

• Off

Note
❒ Default: Off

❒ When the printer switches to Energy Saver mode, the Power indi-
cator turns off, while the On Line indicator stays on.

Menu Description
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Energy 
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Saver 2 ❖❖❖❖ Switching Setting
You can select whether to switch to Energy Saver mode. Select [On] to Ener-
gy Saver mode, or [Off] if you do not want to switch to Energy Saver mode.

• On

• Off

Note
❒ Default: On

❖❖❖❖ Switching Time
You can select how many minutes the printer waits before switching to Ener-
gy Saver mode. Energy Saver mode reduces electric power consumption.

• 5 minutes

• 15 minutes

• 30 minutes

• 45 minutes

• 60 minutes

Note
❒ Default: 30 minutes

❒ When the printer switches to Energy Saver mode, the Power 
indicator turns off, while the On Line indicator stays on and “En-
ergy Save Mode” appears on the panel display.

Menu Description
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Measure You can select “mm” or “inch” for the custom paper size.

Note
❒ Default: 

• Metric version: mm

• Inch version: inch

rinting You can select whether all of the print data is spooled to the hard disk drive be-
fore printing.

• Off

• On

Note
❒ Default: Off

❒ Spooling stores the print job sent by a computer temporarily in the 
printer, transfers the print job, and then prints it.

❒ This menu appears Only when the optional hard disk drive is in-
stalled.

ad Mode You can select the letterhead printing mode.

• Off

• Auto Detect

• On (Always)

Note
❒ Default: Off

Menu Description
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RAM D
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isk If the optional hard disk drive is not installed, when executing PDF Direct Print 
set a value of 2 MB or higher.

This menu appears only when the optional hard disk drive is not installed.

• 0 MB

• 2 MB

• 4 MB

• 8 MB

• 16 MB

Note
❒ Default: 4 MB

Important
❒ When SDRAM is not increased and RAM Disk set to 16 MB, de-

pending on the print job, printing may not be possible and duplex 
printing canceled. If this happens, increase SDRAM, or set RAM 
Disk to 8 MB or less.

Reference
For more information about the optional SDRAM module, see Op-
tion Setup Guide.

Menu Description
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Notify b
Operating Instructions Administrator Reference

y Email You can have error details sent to a preset e-mail address when an error occurs in 
the printer.

• Off

• On

Important
❒ After changing the setting, turn off the power of the main unit briefly, 

and then back on again.

Note
❒ Default: On

Menu Description
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ing the System Menu

owing example describes how to change the settings for “E. Saver2 Timer”.

s {{{{Menu}}}} key.

nu” appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} key to display “System”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Energy Saver 2”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 System  

System :

Energy Saver 2
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s {{{{UUUU}}}} or {{{{TTTT}}}} key to display “E. Saver2 Timer”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} key to select how many minutes the printer waits before switching to Energy
r mode.

following message appears on the panel display.

s {{{{# Enter}}}} key. Wait for two seconds.

nu” appears on the panel display.

s {{{{On Line}}}} key.

dy” appears on the panel display.

Energy Saver 2:

 E. Saver2 Timer

E. Saver2 Timer

*30 minutes

Ready
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 Interface Menu

e 5 menu items in the “Host Interface” menu.

uffer

imeout

ork Setup

 802.11b

 Setting

ore information about the “Network Setup”, see p.16 “Configuring the Printer for the Network”



198

Host I

I/O Buff

I/O Tim
Operating Instructions Administrator Reference

nterface Parameters 

Menu Description

er You can set the size of the I/O Buffer. Normally it is not necessary to change this 
setting.

128 KB, 256 KB, 512 KB

Note
❒ Default: 128 KB

eout You can set how many seconds the printer should wait before ending a print job. 
If data from another port often appears in the middle of the print job, you should 
increase the timeout value.

• 10 seconds

• 15 seconds

• 20 seconds

• 25 seconds

• 60 seconds

Note
❒ Default: 15 seconds
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 Setup Network-Related Settings

Reference
For more information, see p.16 “Configuring the Printer for the Net-
work”.

❖❖❖❖ DHCP
You can select whether to use DHCP with TCP/IP.

• On

• Off

Note
❒ Default: On

❖❖❖❖ IP Address
You can set the IP address.

Limitation
❒ When DHCP is On, its setting cannot be changed. If you want 

to change the setting, Make the setting for DHCP Off. Consult 
the network administrator for information about how to make 
the setting for the network.

Note
❒ Default: 011.022.033.044

Menu Description
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 Setup ❖❖❖❖ Subnet Mask
You can set the Subnet mask.

Limitation
❒ When DHCP is On, its setting cannot be changed. If you want 

to change the setting, Make the setting for DHCP Off. Consult 
the network administrator for information about how to make 
the setting for the network.

Note
❒ Default: 000.000.000.000

❖❖❖❖ Gateway Address
You can set the gateway address.

Limitation
❒ When DHCP is On, its setting cannot be changed. If you want 

to change the setting, Make the setting for DHCP Off. Consult 
the network administrator for information about how to make 
the setting for the network.

Note
❒ Default: 000.000.000.000

Menu Description



201

Network
Operating Instructions Administrator Reference

 Setup ❖❖❖❖ Frame Type (NW)
You can set the Frame type for NetWare.

• Auto

• Ethernet ll

• Ethernet 802.2

• Ethernet 802.3

• Ethernet SNAP

Note
❒ Default: Auto

❖❖❖❖ Active Protocol
You can set the active protocol.

• TCP/IP

• NetWare

• SMB

• AppleTalk

Note
❒ Default: All Active

Menu Description
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 Setup ❖❖❖❖ Ethernet Speed
You can select the speed of the network that the printer is connected to.

• Auto

• 10Mbps Half D.

• 10Mbps Full D.

• 100Mbps Half D.

• 100Mbps Full D.

Note
❒ Default: Auto

❖❖❖❖ LAN Type
You can select Ethernet or IEEE 802.11b for the LAN Type.
This menu appears only when the optional 802.11 interface unit is installed. 

• Ethernet

• IEEE 802.11b

Note
❒ Default: Ethernet

Menu Description
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IEEE 80
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2.11b You can make settings for using the wireless LAN. This menu appears only when 
the optional 802.11b interface unit is installed.

❖❖❖❖ Comm. Mode
You can set the transmission mode for IEEE 802.11b.

• 802.11 Ad hoc

• Infrastructure

• Ad hoc

Note
❒ Default: 802.11 Ad hoc

❒ Comm.Mode can also be set using a web browser. For details, 
see Web Image Monitor Help, and p.125 “Using a Web Browser”.

❖❖❖❖ Channel
The selectable channels are 1-11 (Inch version) and 1-13 (Metric version).

Note
❒ Default: 11

❖❖❖❖ Trans. Speed
You can set the transmission speed for IEEE 802.11b.

• Auto

• 11 Mbps

• 5.5 Mbps

• 2 Mbps

• 1 Mbps

Note
❒ Default: Auto

Menu Description
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IEEE 80
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2.11b ❖❖❖❖ SSID
You can set for SSID in Infrastructure mode and 802.11 Ad hoc mode.
Select [View] to confirm the set SSID. Select [Enter ID] to set the SSID.

• View

• Enter ID

Limitation
❒ Select “¥” if you want to enter “/” in the SSID. Also, “¥” appears 

when printing the configuration page, read it as “/”.

Note
❒ The characters that can be used are ASCII 0x20-0x7e (32 bytes).

❒ A SSID value is set automatically to the nearest access point if 
the setting has not been made.

❒ If the setting has not been made for 802.11 Ad hoc mode, the 
same value as for Infrastructure mode or an “ASSID” value is 
set automatically.

❒ SSID can also be set using a web browser. For details, see 
Web Image Monitor Help, and p.125 “Using a Web Browser”.

Menu Description
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2.11b ❖❖❖❖ WEP Setting
You can set the code for IEEE 802.11b.

• Active

• Not Active

Note
❒ Default: Not Active

❒ The WEP key is input as a hexadecimal number or an ASCII 
character sequence. 

❒ When using 64 bit WEP, up to 10 characters can be used for 
hexadecimal, or up to five characters for ASCII. When using 
128 bit WEP, up to 26 characters can be used for hexadecimal, 
or up to 13 characters for ASCII.

❒ WEP Key can also be set using a web browser. For details, see 
Web Image Monitor Help, and p.125 “Using a Web Browser”.

tting You can set the transmission speed for USB.

• Full Speed

• Auto

Note
❒ Default: Auto

Menu Description
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ing the Host Interface Menu

owing example describes how to change the setting for “I/O Timeout”.

s the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the “Host Interface” menu. and then press {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 Host Interface
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s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “I/O Timeout”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to select how many minutes the printer waits before ending a print
and then press {{{{# Enter}}}} key.

 for two seconds. “Host Interface” appears on the panel display.

s the {{{{On Line}}}} key.

dy” appears on the panel display.

Host Interface:

 I/O Timeout

I/O Timeout:

*15 seconds

Ready
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 Menu

e 11 menu items in the “PCL Menu”.

ntation

 Lines

 Source

 Number

t Size

 Pitch

bol Set

ier Font

A4 Width

nd CR to LF

lution
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arameters

Menu Description

ion You can set the page orientation.

• Portrait

• Landscape

Note
❒ Default: Portrait

nes You can set the number of lines per page.

5-128

Note
❒ Default: 

• Metric version: 60

• Inch version: 64

urce You can set the location of the default font.

• Resident

• RAM

• HDD

Note
❒ Default: Resident

❒ When you select “RAM”, you can select only fonts downloaded to 
the printer RAM.

❒ When you select “HDD”, you can select only fonts downloaded to 
the optional hard disk drive.
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mber You can set the ID of the default font you want to use.

• 0 to 50 (for Resident)

• 0 to 44 (for RAM)

• 1 to 32767 (for HDD)

Note
❒ Default: 0

ze You can set the point size you want to use for the default font.

4 to 999.75 by 0.25

Note
❒ Default: 12.00 points

❒ This setting is effective only for a variable-space font.

ch You can set the number of characters per inch you want to use for the default font.

0.44 to 99.99 by 0.01

Note
❒ Default: 10.00 pitch

❒ This setting is effective only for a fixed-space font.

 Set You can specify the set of print characters for the default font. The available op-
tions are as follows:

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-TK, 
Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ, Math-
8, PS Math, VN Math, Pifont, Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO 17, ISO 
21, ISO 60, ISO 69, Win 3.0

Note
❒ Default: Roman-8

Menu Description
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Courier 

Ext. A4

Append
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Font You can select a courier font type.

• Regular

• Dark

Note
❒ Default: Regular

 Width You can extend the width of the printable area for an A4 sheet leaving a narrow 
margin on the sides.

• Off

• On

Note
❒ Default: Off

 CR to LF By adding a CR code to each LF code, you can print text data clearly.

• Off

• On

Note
❒ Default: Off

on You can set the print resolution in dots per inch.

• 300 dpi

• 600 dpi

Note
❒ Default: 300 dpi

Menu Description
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ing the PCL Menu

owing example describes how to change the setting for “Orientation”.

s the {{{{Menu}}}} key.

nu” appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “PCL Menu”, and then press the {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 PCL Menu

PCL Menu:

 Orientation
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s the {{{{# Enter}}}} key.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to select the orientation desired, and then press the {{{{# Enter}}}} key.

 for two seconds. “PCL Menu” appears on the panel display.

s the {{{{On Line}}}} key.

dy” appears on the panel display.

Orientation:

*Landscape

Ready
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enu
e 4 menu items in the “PS Menu” .
 Format
lution
r Setting
r Profile

rameters

Menu Description

rmat You can select the data format.

• Binary Data

• TBCP

Limitation
❒ This setting is effective when operating the machine with a parallel, 

USB or EtherTalk connection.
❒ When operating the machine with a parallel or USB connection, if 

binary data is sent from the printer driver, the print job is canceled.
❒ When operating the machine with an Ethernet connection, the print 

job is canceled under the following conditions;
• The printer driver data format is TBCP and the data format se-

lected on the control panel is Binary Data.
• The printer driver data format is binary and the data format se-

lected on the control panel is TBCP.

Note
❒ Default: Binary Data
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on You can select the resolution.

• 600 dpi Fast

• 600 dpi Std.

Note
❒ Default: 600 dpi Fast

tting You can make an RGB setting.

• None

• Fine

• Super Fine

Note
❒ Default: Super Fine

ofile You can set the color profile.

• Auto

• Solid Color

• Presentation

• Photographic

• User Setting

Note
❒ Default: Auto

Menu Description
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ing the PS Menu

owing example describes how to change the setting for “TBCP”:

s the {{{{Menu}}}} key.

nu” appears on the display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “PS Menu”, and then press the {{{{# Enter}}}} key.

following message appears on the display:

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

Menu:

 PS Menu

PS Menu:

 Data Format
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s the {{{{UUUU}}}} or {{{{TTTT}}}} key to select the TBCP desired, and then press the {{{{# Enter}}}} key.

 for two seconds.“PS Menu” appears on the display.

s the {{{{On Line}}}} key.

dy” appears on the display.

Data Format:

*TBCP

Ready
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 Menu

e 5 menu items in the “PDF Menu” .

: Change PW

 Group PW

lution

r Setting

r Profile

arameters

Menu Description

ange PW Set [Password to Open the Text File] for the PDF file executing PDF Direct Print.

• Current PW

• PDF: New  PW

Important
❒ A password can be set using on the Web Image Monitor, but in this 

case the password information is sent through the network. If se-
curity is a priority, set the password using this menu from the Con-
trol Panel.

Note
❒ Default: no password set
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oup PW Set the group password already specified with DeskTopBinder V2 Lite.

Note
❒ When using a group password, this machine requires the optional 

network data protection unit.

• Current PW

Important
❒ A password can be set using on the Web Image Monitor, but in this 

case the password information is sent through the network. If se-
curity is a priority, set the password using this menu from the Con-
trol Panel.

Note
❒ Default: no password set

on You can select the resolution for the PDF file executing PDF Direct Print.

• 600 dpi Fast

• 600 dpi Std.

Note
❒ Default: 600 dpi Fast

tting You can make an RGB setting for the PDF file executing PDF Direct Print.

• None

• Fine

• Super Fine

Note
❒ Default: Super Fine

Menu Description
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ofile You can set the color profile for the PDF file executing PDF Direct Print.

• Auto

• Solid Color

• Presentation

• Photographic

• User Setting

Note
❒ Default: Auto

Menu Description
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ing the PDF Menu

s {{{{Menu}}}} key.

nu” appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S
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s {{{{UUUU}}}} or {{{{TTTT}}}} key to display “PDF Menu”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL004S

PDF Menu:

 PDF: Change PW
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s {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Resolution”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

s {{{{# Enter}}}} key.

s {{{{UUUU}}}} or {{{{TTTT}}}} key to select the resolution desired, and then press {{{{# Enter}}}} key.

screen returns to step C in a few seconds.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL004S

PDF Menu:

 Resolution

Resolution:

*600 dpi
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s {{{{On Line}}}} key.

dy” appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL003S

Ready
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uage Menu

 select the languages you use. Available language are as follows:

, German, French, Italian, Spanish, Dutch, Swedish, Norwegian, Danish, Finnish, Portuguese,
olish and Hungarian.

ult: English

ing the Language Menu

 change the language by the following procedures.

s the {{{{Menu}}}} key.

nu” appears on the panel display.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S
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s the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Language”, and then press {{{{# Enter}}}} key.

following message appears on the panel display.

s the {{{{UUUU}}}} or {{{{TTTT}}}} key until the language you want to select appears on the panel display
then press {{{{# Enter}}}} key.

 for two seconds. “Menu” appears on the panel display.

s the {{{{On Line}}}} key.

dy” appears on the panel display.

Menu:

 Language

Language:

*English

Ready
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ppendix

ng Files Directly from Windows

rint files directly using Windows com-
or example, you can print postscript
ostScript 3. Commands that can be used
ows:

ing explains setup and printing.

Setup

AAAA Setup the printer's network environment.

• Enable the TCP/IP protocol (enabled as
default).

• Set TCP/IP-related items, including IP ad-
dress.

Reference
p.16 “Configuring the Printer for the Net-
work” for the setup method. 

p.307 “Using DHCP”, when setting the IP
address of the printer using DHCP.

BBBB Install the TCP/IP protocol in Windows to
set the network environment.

Note
❒ Make sure network settings are checked

by a network administrator.

OS lpr rcp ftp

95/98/Me ✓

2000/XP, Win-
er 2003

✓ ✓ ✓

NT 4.0 ✓ ✓ ✓
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n printing with Windows 2000/XP,
dows Server 2003 or Windows NT 4.0,
ll “Printing service for UNIX” as the
ork software. When printing with
dows NT 4.0,  install “Microsoft
/IP printing” as the network software.

ote
hen using Windows 95/98/Me, lpr can-

ot be used to print.

his completes the setup for specifying a
rinter using an IP address when printing.
hen using a host name to specify a print-

r, proceed to p.228 “Using a Host Name
stead of an IP Address” and continue the

etup. 

Using a Host Name Instead of an 
IP Address

When the host name is defined, you can specify
a printer by host name instead of IP address. The
host name used differs depending on the network
environment.

When using DNS

Use the host name set to the data file on the DNS
server.

When setting the IP address of a printer using
DHCP

Use the “Printer name” on the Configuration
Page as the host name. See p.166 “Printing a
Configuration Page” for printing the Configura-
tion Page. 
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 cases

 IP address and host name of the network
o the hosts file on the computer used for
 Methods of addition vary according to OS.

ws 95/98/Me

 to the same \WINDOWS\HOSTS.SAM
tory and name it “HOSTS” (no exten-

required).

 the \WINDOWS\HOSTS file you cre-
 using memo pad, etc.

 an IP address and a host name to the
s file in the following format:

.168.15.16  host  # NP

168.15.16 is the IP address, “host” is the
er's host name, and “#” to the end are

ents. Divide each item with a space or
nd use only one line.

 the file.

W\indows 2000/XP, Windows Server 
2003, Windows NT 4.0

AAAA Open the hosts file using memo pad, etc.

The hosts file is in the following folder:

\WINNT\SYSTEM32\DRIV-
ERS\ETC\HOSTS

\WINNT is the directory of the installation
destination for Windows 2000/XP, Windows
Server 2003, Windows NT 4.0.

BBBB Add an IP address and a host name to the
hosts file in the following format:

192.168.15.16  host  # NP

192.168.15.16 is the IP address, “host” is the
printer's host name, and “#” to the end are
comments. Divide each item with a space or
tab, and use only one line.

CCCC Save the file.
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g Method

owing explains printing using the “lpr”,
nd “ftp” commands.

aration
r commands using the commands
pt window. The location of the com-

ds prompt in each operating system is as
s:

indows 95/98
tart]-[Programs]-[MS-DOS Prompt]

indows Me
tart]-[Programs]-[Accessories]-[MS-DOS

rompt]

indows 2000
tart]-[Programs]-[Accessories]-[Command

ronpt]

indows XP, Windows Server 2003
tart]-[All Programs]-[Accessories]-[Com-
and Pronpt]

indows NT 4.0
tart]-[Programs]-[Command Pronpt]

Note
❒ If the “print requests full” message appears,

no more print requests can be accepted. Try
printing again when the number of session
has dropped below the value shown in the fol-
lowing table below.

❒ Enter the file name in a format including the
path from the directory executing the com-
mands.

Reference
The “option” specified in the command is an
intrinsic printer option and its syntax is similar
to printing from UNIX. For details, see UNIX
Supplement.

rcp, rsh 5

ftp 3
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n specifying a printer by IP address
 lpr -Sprinter's IP address
option] [-ol] \pass
e\file name

n using a host name instead of an IP
ess
 lpr -Sprinter's host name
option] [-ol] \pass
e\file name

ote
hen printing a binary file, add the “-ol”

ption (lower case O, and lower case L). 
n using a printer with the host name
t”, to print a PostScript file named “file1”
ed in the C:PRINT directory, the com-
 line is as follows:

 lpr -Shost -Pfiletype=RPS
 C:PRINT\file1

rcp

Register the printer's host name in the hosts file
beforehand. See p.228 “Using a Host Name In-
stead of an IP Address”.

c:> rcp [-b] \pass name\file name
[pass name\file name...] print-
er's host name:[option]

Note
❒ In the file names, “*” and “?” can be used as

wild cards. 

❒ When printing a binary file, add the “-b” option.

When using a printer with the host name “host”,
to print a PostScript file named “file1” or “file2”
located in the C:PRINT directory, the command
line is as follows.

c:> rcp -b C:\PRINT\file1
C:PRINT\file2 host:filetype=RPS
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 put or mput command according to the
 of files to be printed.

n the number of files to be printed is one
> put \pass name\file name
tion]

n the number of files to be printed is
or more
> put \pass name\file name
ass name\file name...] [op-
n]

the mput command, “*” and “?” can be
 as wild cards in the file name.

itation
se symbols are used, the file name will
ad as an option string.

cedure from starting ftp to printing is as

ulate the printer's IP address (or host
e of the hosts file printer) as an argu-
t and use the “ftp” command.

tp printer's IP address

BBBB Enter user names and passwords as need-
ed, and then press the {{{{# Enter }}}} key.

There is no default user name when the de-
fault password is “password”.

User:
Password:

CCCC When printing a binary file, set binary as
the file mode.

ftp> bin

Note
❒ When a binary file is printed in ASCII

mode, print data may change and may not
print out correctly.

DDDD Specify the file to be printed.

The following are examples of printing a
PostScript file named “file1”in the C:PRINT
directory, and printing file1 and file2.

ftp> put C:\PRINT\file1 file-
type=RPS
ftp> mput C:\PRINT\file1
C:PRINT\file2

EEEE Quit ftp.

ftp> bye
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P

MP (Simple Network Management Protocol) agent operating on UDP and IPX, is incorporated
built-in Ethernet board and 802.11b interface unit (option) of this machine.

e SNMP manager, you can get information about the printer.

ory default community names are “public” and “admin”. You can get MIB information using
mmunity names.

community name can be using with the following procedure.

ou can configure SNMP from the command line using telnet. See p.247 “SNMP”.

ou can configure SNMP from SmartDeviceMonitor for Admin using the NIB Setup Tool. See
martDeviceMonitor for Admin Help.

ou can configure SNMP from your Web browser. See Web Image Monitor Help.

itation
kinds of supported MIBs differ depending on the printer.

orted MIBs
IB-II

rinterMIB

ostResourceMIB

icohPrivateMIB
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ote Maintenance by telnet

 view the printer status and configure the network interface board using telnet.

should specify a password so that only the network administrator, or a person having network
inistrator privileges, can use remote maintenance. 

password is the same as that used for Web browser (Web Image Monitor) settings. When the
word is changed on “mshell”, the other passwords change also.

 telnet

owing is a sample procedure in using telnet.

itation
 one person at a time can be logged on to do remote maintenance.

the IP address or the host name of the printer to start telnet.

elnet IP_address

 the password.

ote
he factory default is “password”.

 a command.

eference
or more information about telnet commands, see p.236 “Commands List”.
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 telnet.

> logout

n the configuration is changed, a confirmation message requests whether or not the changes
ld be saved.

 “yes” to save the changes, and then press {{{{# Enter}}}} key.

u do not want to save the changes, type “no”, and then press {{{{# Enter}}}} key. If you want to make
ional changes, type “return” at the command line, and then press {{{{# Enter}}}} key.

ote
 the “Can not write NVRAM information” message appears, the changes are not saved. Repeat
e steps above.

he network interface board is reset automatically when the settings are changed.

hen the network interface board is reset, the active print job which has already been sent to
e printer will finish printing. However, jobs that have not been sent yet will be canceled.
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ands List

 list of commands that can be used via remote maintenance.

 “help” to see a list of commands that can be used.

> help

 “help command_name” to display information about the syntax of that command.

> help command_name

address

“ifconfig” command to configure TCP/IP (IP address, subnet mask, broadcast address, default
 address) for the machine.

rence
> ifconfig
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iguration
> ifconfig interface_name parameter address

 you did not enter the interface name, it will be automatically set to the Ethernet interface.
ou can specify an interface when installing the optional 802.11b interface unit.

ging the Interface
can specify either the ethernet interface or IEEE 802.11b interface when using the optional

11b interface unit.

> ifconfig interface up

owing is an example for configuring an IP address of 192.168.15.16 on ethernet interface.

ifconfig ether 192.168.15.16

owing is an example for configuring a subnet mask of 255.255.255.0 on ethernet interface.

ifconfig ether netmask 255.255.255.0

affects the configuration of the network interface board of the IP address that is used.

TCP/IP setting is the same as that for the ethernet interface and IEEE 802.11b interface.

pe an address using hexadecimal, prefix it by “0x”.

rface name Interface to be configured

r Ethernet Interface *1 

 *2 IEEE 802.11b Interface

meter Meaning

arameter) IP address

ask subnet mask

dcast broadcast address
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ress

et Mask
mber used to mathematically “mask” or hide the IP address on the network by eliminating those
 of the address that are alike for all the machines on the network.

et the above addresses, contact your network administrator.

subnet mask is the same as that for the ethernet interface and IEEE 802.11b interface.
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 Control

 “access” command to view and configure access control. You can also specify two or more
anges.

rence
> access

iguration
> access ✩  range start-address end-address

 represents a target number between 1 and 5. (Up to five access ranges can be registered and
lected.)
ple: To specify accessible IP addresses between 192.168.0.10 and 192.168.0.20:
> access 1 range 192.168.0.10 192.168.0.20

ote
he access range restricts the workstations from which printing is possible by means of an ad-
ress. If you do not need to restrict printing, make the setting “0.0.0.0”.

he entry is invalid if the start address is greater than the end address.

p to five access ranges can be specified. The entry is invalid if the target number is omitted.

ou cannot access Web Image Monitor and telnet from a restricted IP address.

ss Control Initialization 
> access flush

ote
his restores the factory-default settings so that all access ranges become “0.0.0.0”.
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“dhcp” command to configure the DHCP settings.

rence
ore information about DHCP, see p.307 “Using DHCP”.

rence
following command displays the current DHCP settings.

> dhcp

iguration
can configure the DHCP settings.

> dhcp interface_name {on|off}

ote
elect [on] to enable DHCP. Select [off] to disable DHCP.

hen the DNS server address and domain name are acquired from DHCP, be sure to select “on”.
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face Priority Configuration
can assign priorities governing which interface obtains DHCP parameters.

> dhcp priority interface_name

ote
riority assignment is useful when connecting more than one interface to the machine.

 an interface is not selected, it appears according to the currently set priority regardless of mul-
ple interface connections.

vailable when the optional 802.11b interface Unit is installed.

 Server Address Selection
can specify whether to acquire the DNS server address from the DHCP server or to use it as a
setting.

> dhcp dnsaddr [dhcp/static]

ote
pecify “dhcp” when acquiring the DNS server address from the DHCP server, or specify “static”
hen using it as a user setting.

eference
or more information about setting the DNS server address, see p.266 “DNS”.

rface name Interface to be configured

r Ethernet interface

  *1 IEEE 802.11b interface
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ain Name Selection
can specify whether to acquire the domain name from the DHCP server or to use it as a user
g.

> dhcp domainname [dhcp/static]

ote
pecify “dhcp” when acquiring the domain name from the DHCP server, or specify “static” when
sing it as a user setting.

eference
or more information about setting the domain name, see p.268 “Domain name”.



243

Protoco

Use the 

❖❖❖❖ Refe
Proto

msh

*1 In

Prot

tcpip

appl

netw

smb

prot

lpr

ftp

rsh

dipr

 web

 snm

ssl

 ipp

http

rend
Operating Instructions Administrator Reference

l

“set” command to set protocol information display to active or inactive.

rence
col information (active/inactive) appears.

> set protocol

formation about tcpip, appletalk, netware, and smb appears.

ocol

etalk 

are

ocol *1 

int

p

ezvous
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iguration
can set the protocol to active or inactive.

> set protocol {up | down}

ote
 you prohibit remote access using TCP/IP and then log out, you cannot use remote access. If
is was a mistake, you can use the control panel to allow access by TCP/IP.

hen you prevent access via TCP/IP, you are also prevented from using lpr, ftp, rsh, diprint,
eb, snmp, ssl, ipp, http, and rendezvous.

ocol

etalk 

are

int

p

ezvous

“up” means active and “down” means inactive.
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status

owing commands can be used to get information about the current status of the printer.

command

 information about any print job is displayed when the ID number is added after the prnlog command

rence
ore information about the meaning of the data returned with these commands, see p.284 “Un-

tanding the Displayed Information”.

nd Information that is displayed

Status of printer.

Information about the print jobs.

Information about the paper tray, output tray, and 
printer language.

ID] Lists the last 16 print jobs.
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 interface board configuration settings information

“show” command to display the network interface board configuration settings.

show [-p]

“-p” to the show command to have information displayed on screen at one time.

rence
ore information about the meaning of the data returned with this command, see p.286 “Con-

ing the Network Interface Board”.

 log information

“syslog” command to display information stored in the printer's system log. 

syslog

rence
ore information about the displayed information, see p.293 “System Log Information”.



247

SNMP

Use the 

Note
❒ You 

❒ The 
ent if
Devi
nam

❒ Defa

❖❖❖❖ Disp
Show

msh
msh

N
❒ If

❒ O

Num

Com

IP ad

Acc
Operating Instructions Administrator Reference

“snmp” command to display and edit SNMP configuration settings such as the community name.

can configure from ten SNMP access settings numbered 1–10.

printer cannot be accessed from SmartDeviceMonitor for Admin or SmartDeviceMonitor for Cli-
 “public” is not registered in numbers 1-10. When changing the community name, use Smart-
ceMonitor for Admin and the installed “SNMP Setup Tool” to change a computer's community
e to correspond with printer settings.

ult access settings 1 and 2 are as follows:

lay
s the SNMP information and available protocols.

> snmp ?
> snmp [-p] [registered_number]

ote
 the -p option is added, you can view the settings one by one.

mitting the number displays all access settings.

ber 1 2

munity name public admin

dress 0.0.0.0 0.0.0.0

ess type read-only

trap off

read-write

trap off
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munity name configuration
can set the community name of the network interface board.

> snmp number name community_name

ote
he community name must be within 15 characters.

ss type configuration
can select the access type from those listed below.
> snmp number type access_type

ocol configuration
should use the following command to set the protocols to active or inactive. If you set a protocol
active, all access settings set to use that protocol are disabled.

> snmp {ip | ipx} {on | off}

pecify “ip” for TCP/IP, or specify “ipx” for IPX/SPX.

on” means active and “off” means inactive
hange the protocol of access settings, use the following command. However, if you disabled a
col with the above command, making it active here will have no effect.

> snmp number active {ip | ipx} {on | off}

ess type Type of access which is permitted

All access is denied.

Read only

e Read and write

User is notified of trap messages.
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ss configuration
can configure an address of a host depending on the protocols used. 
network interface board accepts requests only from hosts having addresses with access types of
-only” or “read-write”. Type “0” to have network interface board accept requests from any host

out requiring a specific type of access.
pecifying a TCP/IP address
sh> snmp number ip/addr address
pecifying an IPX/SPX address
sh> snmp number ipx address

ote
o specify the TCP/IP protocol, type ip followed by a space, and then the IP address.

o specify the IPX/SPX protocol, type ipx followed by a space and then the IPX address followed
y a decimal and then the MAC address of the network interface board.
following is an example of how to configure registration number 3 with the IP address
168.15.16.
> snmp 3 ip 192.168.15.16
following is an example of how to configure registration number 3 with the IPX address
A448, and the MAC address 00:00:74:62:5C:65.
> snmp 3 ipx 7390A448:000074625C65
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“ipp” command to configure the IPP settings.

ing setting
following command displays the current IPP settings.

> ipp
ple output:

eout=900(sec)
h basic

he “timeout” setting specifies how many seconds the computer keeps trying to access the net-
ork printer to send print jobs when no connection could be made.

he “auth” setting indicates the user authorization mode.

imeout configuration 
ifies how many seconds to wait before canceling a print job if it has been interrupted for some
n. The range of time can be changed between 30 to 65535 seconds.

> ipp timeout {30 - 65535}

ser authorization configuration
the IPP user authorization to restrict users to print with IPP. The factory default is “off” .

> ipp auth {basic|digest|off}

he setting of user authorization are “basic” and “digest”.

se “off” to remove a user's authorization.

ote
 you select “basic” or “digest”, see next section “Configuring IPP user authorization” for more
formation about how to configure the user name.
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iguring IPP user authorization
the following command:

> ipp user
following message appears.

> Input user number (1 to 10):
 the number, user name and password.

> IPP user name:user1
> IPP password:*******
r configuring the settings, the following message appears.

r configuration changed.
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rinting Port

ct printing port allows printing directly from a computer, connected to the network, to the printer.

“diprint” command to change the direct printing port settings.

 settings
following command displays the current direct printing port settings.

> diprint
ple output:

t 9100
eout=300(sec)
irect off

he “Port” specifies the port number of the direct printing port.

he “bidirect” setting indicates whether the direct printing port is bidirectional.

ng timeout
can specify the timeout interval to use when receiving data from the network.

> diprint timeout [30~65535]

ote
he factory default is 300 seconds.

ectional configuration for the direct printing port
this setting to configure whether the direct printing port is bidirectional.
factory default is “off”.

> diprint bidirect {on|off}
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“smb” command to configure or delete the computer name or workgroup name for NetBEUI.

ngs of NetBEUI related items
 >smb parameter

ocol settings
le/disable NetBEUI and TCP/IP. Select “up” to enable, and “down” to disable.

> smb protocol [netbeui {up | down} | tcpip {up | down}]

meter Settings

p Your computer name consisting of up to 15 characters

p Workgroup name consisting of up to 15 characters

ment Comment consisting of up to 31 characters

 {on | off} To notify print job completion, specify “on”. Otherwise, specify “off”

 comp Clears complete name

 group Clears Workgroup name

 comment Clears comment
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“route” command to control the routing table.

mand allows you to configure and display routing information. You can change the network
ration from a remote computer using this command.

maximum number of routing tables are 16.

dress

he gateway address when communicating with devices on a different network beyond the router.

same gateway address is shared by all interfaces.

ter Topics of setting

d [host|net] destination *1  
 *1 

Adds a host/network route to “destination”, and a gateway address to “gateway” 
in the table. Host becomes the default setting.

ete [host|net] destination  *1 Deletes a host/network route from the table. Host becomes the default setting.

t [destination]  *1 Displays only route information corresponding to a specified destination. When 
the destination is unspecified, all routing information is displayed.

ive {host | net} destination *1  You can turn the specified destination on or off. Host becomes the default setting.

d default gateway *1 You can set the default gateway address.

sh Deletes all routing information.
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 command to configure SLP settings.

 search the NetWare server using SLP in the PureIP environment of NetWare 5/5.1, Netware
sing the slp command, you can configure the value of TTL which can be used by SLP multi-
ket.

default value of TTL is “1”. A search is executed only within a local segment. If the router does
upport multi-cast, the settings are not available even if the TTL value is increased.

acceptable TTL value is 1 - 255.

> slp ttl {1 -255}

IEEE 802.11b

e setting for IEEE 802.11b, use the “wiconfig” command.

itation
can make settings when installing the optional 802.11b interface unit.

 settings
following command displays the current IEEE 802.11b settings.

> wiconfig
IEEE 802.11b information is displayed.

> wiconfig cardinfo

ote
 the IEEE 802.11b is not working correctly, the IEEE 802.11b information is not displayed.
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iguration
> wiconfig parameter

meter Value to be configured

e [ap|adhoc|802.11adhoc] You can set infrastructure mode (ap) , 802.11 ad hoc 
mode (802.11adhoc) or ad hoc mode (adhoc).

The default is ad hoc mode.

ID value You can set for SSID in infrastructure mode.

The characters that can be used are ASCII 0x20-0x7e 
(32 bytes).

A SSID value is set automatically to the nearest access 
point if the setting has not been made.

If the setting has not been made for ad hoc mode, the 
same value as for infrastructure mode or an “ASSID” 
value is set automatically if the setting has not been 
made.

nel frequency channel no. You can set the channel.

You can specify from following channel.

• Metric Version :1-13

• Inch Version :1-11

Set the same channel for all the machines you are using.

[on|off] You can enable or disable the WEP function. To enable 
the WEP function, specify [on]; to disable it, specify 
[off].

To start the WEP function, enter the correct WEP key.
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[key value] val [1|2|3|4] You can specify the WEP key when entering in hexa-
decimal.

With a 64-bit WEP, you can use 10 digit hexadecimal. 
With a 128-bit WEP, you can use 26 digit hexadecimal.

Up to four WEP keys can be registered. Specify the 
number to be registered with “val”.

When a WEP is specified with the key, the WEP speci-
fied with the keyphrase is overwritten.

To use this function, set the same key number and WEP 
key for all ports that transmit to each other.

You can omit the numbers with “val”. The key number 
is set to 1 when making these omissions.

hrase [phrase] val [1|2|3|4] You can specify the WEP key when entering in ASCII.

With a 64-bit WEP, you can use 10 digit hexadecimal. 
With a 128-bit WEP, you can use 26 digit hexadecimal.

Up to four WEP can be registered. Specify the number 
to be registered with “val”.

When a WEP is specified with the keyphrase, the WEP 
specified with the key is overwritten.

To use this function, set the same key number and WEP 
key for all ports that transmit to each other.

You can omit the numbers with “val”. The key number 
is set to 1 when making these omissions.

al [1|2|3|4] You can specify which of the four WEP keys is used for 
packet encoding. “1” is set if a number is not specified.

meter Value to be configured
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 [open|shared] You can set the authorized mode when using WEP. The 
specified value and the authorized mode are as follows:

open: Open system authorized (default)

shared: Shared key authorized

[auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting speed.

The transmitting speed you specify here is the speed at 
which data is sent. You can receive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

meter Value to be configured
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ol

“spoolsw” command to configure Job Spool settings.

itation
can only specify diprint, LPR, IPP, and SMB protocol.

rence
Job Spool setting appears.

> spoolsw

Spool setting
> spoolsw spool {on | off}

ote
elect [on] to enable Job Spool or [off] to disable it.

ocol configuration
hange protocol settings, use the following command. You can specify the setting for diprint,
, IPP, and SMB protocol.

iprint

sh> spoolsw diprint {on | off}

r

sh> spoolsw lpr {on | off}

p

sh> spoolsw ipp {on | off}

MB

sh> spoolsw smb {on | off}
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g the Host Name

“hostname” command to change the printer name.

iguration
> hostname [interface_name ] printer_name

 you did not enter the interface name, it will be automatically set to the Ethernet interface.
 you install the optional 802.11b interface unit, you can set the command.

ote
nter the printer name using up to 15 characters.

ou cannot use a printer name starting with RNP or rnp.

he Ethernet interface and IEEE 802.11b interface will have the same printer name.

rface name Interface to be configured

r Ethernet interface *1 

  *2 IEEE 802.11b interface
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“wins” command to configure the WINS server settings

rence
ore information about WINS server settings, see p.311 “Configuring a WINS Server”.

cified values of the interfaces used in each of the following settings are shown below.

u install the optional 802.11b interface unit, you can set the command.

ing setting
following command displays the WINS server IP address.

> wins
ple out put:

s: primary server 0.0.0.0  secondary server 0.0.0.0
P current config:
mary server 192.168.10.1 secondary server 192.168.10.2
tname RNP620B47 ScopeID

ote
 DHCP is used to start from the network, the current WINS server address is displayed. This
ddress, however, is not displayed if DHCP is not used.

 the IP address obtained from DHCP differs from the WINS IP address, the DHCP address is
e valid address.

e name Interface to be configured

Ethernet interface

 IEEE 802.11b interface
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iguration
the set command to make WINS active or inactive.

> wins interface_name {on | off}

n” means active and “off” means inactive.

ess configuration
this command to configure a WINS server IP address.

> wins ifname {primary|secondary} IP address

se the “primary” to configure a primary WINS server IP address.

se the “secondary” to configure a secondary WINS server IP address.

ou cannot use “255.255.255.255” as the IP address.

 (NetBIOS over TCP/IP) Scope ID Selection
can specify the NBT scope ID.

> wins interface_name scope scope ID

he scope ID is specified using up to 31 alphanumeric characters.
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t

“autonet” command to configure AutoNet settings.

rence
ore information about AutoNet, see p.310 “Using AutoNet”.

lay
following command displays the current AutoNet settings.

> autonet

iguration
can configure the AutoNet settings.

> autonet [on|off]

n” means active and “off” means inactive.

face Priority Configuration
can assign priorities governing which interface obtains AutoNet parameters.

> autonet priority interface_name

ote
riority assignment is useful when connecting more than one interface to the machine.

 an interface is not selected, the interface appears according to the currently set priority, regard-
ss of multiple interface connections.

vailable when the optional 802.11b interface unit is installed.

rface name Interface to be configured

r Ethernet interface

  *1 IEEE 802.11b interface
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ter clock can be synchronized with a NTP server clock using the Simple Network Time Protocol
. To change the SNTP settings, use the “sntp” command.

itation
P supports the NTP servers running xnptd V3 and V4.

rence
> sntp

 Server Address Configuration
can specify the IP address of the NTP server.
> sntp server IP_address

val Configuration
can specify the interval at which the printer synchronizes with the operator-specified NTP server.
> sntp interval polling_time

ote
he factory default setting is 3,600 seconds.

ou can set the interval from 16 to 16,384 seconds.

 you set 0, the printer synchronizes with the NTP server only when you turn the printer on. After
at, the printer does not synchronize with the NTP server.

-zone Configuration
can specify the time difference between the printer clock and the NTP server clock.
> sntp timezone +/-hour_time
ple: To set the time-zone difference to +8 hours:
> sntp timezone +08:00

ote
he time is in 24-hour notation.
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g the Password

“passwd” command to change the remote maintenance password.

ortant
ure not to forget or lose the password.

default factory password is “password”.

 “passwd”.

> passwd

 the current password.

 password:

 the new password.

 password:

ote
he password must consist of 3 to 8 alphanumeric characters and symbols. Upper and lower
se characters are considered unique. For example, R is different from r.

he password is the same as that used for Web browser (Web Image Monitor) settings. When
e password is changed on “mshell”, the other passwords change also. If you change a pass-
ord from telnet, change other passwords also.

 the new password once again.

ype new password:
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“dns” command to configure or display DNS (Domain Name System) settings.

 setting
following command displays current DNS settings:

> dns

 server configuration
following command enables/disables use of the DNS server address:

> dns number server server address
following is a sample configuration using an IP address of 192.168.15.16 on DNS 1 server:

> dns 1 server 192.168.15.16

ou can register up to three DNS server numbers.

ou cannot use “255.255.255.255” as the DNS server address.

mic DNS Function Setting
can set the dynamic DNS function to active or inactive.

> dns ifname ddns {on|off}

n” means active and “off” means inactive.

vailable when the optional 802.11b interface unit is installed.

rface name Interface to be configured

r Ethernet interface

  *1 IEEE 802.11b interface
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ifying the record overlap operation
can specify the operation performed when records overlap.

> dns overlap {update|add}

pdate
o delete the old record and register a new record.
d

o add a new record while allowing the old record to remain.

ote
hen CNAME overlaps, it is always changed, irrespective of the setting.

ME Registration
can specify whether to register CNAME.

> dns cname [on|off]

n” means active and “off” means inactive.

ote
he CNAME registered is the default name beginning from RNP. CNAME cannot be changed.

cords Registration
can specify the method of registering an A record when the dynamic DNS function is active
HCP is used.

> dns arecord [dhcp|own]

hcp
o register an A record while using the DHCP server as the DNS client instead of the printer.
wn
o register an A record using the printer as the DNS client.

ote
he DNS server address and domain name already designated on p.240 “DHCP” are used for
e registration.
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rd Updating Interval Setting
can specify the interval at which records are updated when using the dynamic DNS function.
> dns interval time
he updating interval is specified in units of one hour. It can be specified over a range of 1 to
55 hours.
he default is 24.

 name

“domainname” command to display or configure domain name settings.
 configure the Ethernet interface or IEEE 802.11b interface.

 setting
following command displays the current domain name:
> domainname

face domain configuration
following command displays or sets the Ethernet interface domain name or IEEE 802.11b in-
ce.
etting the domain name
sh> domainname interface_name domain name

A domain name can consist of up to 63 alphanumeric characters.
The Ethernet interface and IEEE 802.11b interface will have the same domain name.

eleting the domain name
sh> domainname interface_name clear

vailable when the optional 802.11b interface unit is installed.

rface Interface that can be set

r Ethernet interface

 *1 IEEE 802.11b interface
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 “netware” command to configure the NetWare settings such as the print server name or file
ame.

netware parameter

ter Settings

Enter the NetWare print server name using up to 47 characters.

Enter the NetWare file server name using up to 47 characters.

02.3/802.2/snap/ 
2/ auto]

Select the encap type.

Specify the remote printer number.

Set the timeout.

erver Select the print server mode.

rinter Select the remote printer mode.

Specify the NDS context name.

rval Specify the SAP intervals.

Each interval can be set to between 0 and 3600 seconds in one-second incre-
ments.

rver Specify “login with a selected file server” as the login mode.

e Specify “login with a selected NDS tree” as the login mode.

S tree name Select the NDS tree to log on to.
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“web” command to display and configure the parameters on the Web Image Monitor.

 Settings
> web

 Configuration
link address reached by pressing [URL] on the Web Image Monitor can be set.

> web url http://The URL or IP address you want to register/

 Name Configuration
can enter the name for [URL] that appears on the Web browser.

> web name Name you want to display

 URL Configuration
link address reached by pressing [Help] or “?” on the Web Image Monitor can be set.

> web help http://Help URL or IP address/help/
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vous

dezvous” commands are used for rendezvous-related displays and settings.

 settings
 displays a list of rendezvous settings.

> rendezvous

ezvous Service Name Setting
can specify the rendezvous service name.

> rendezvous cname “service name”

he service name is specified using up to 63 alphanumeric characters.

he current service name appears if a service name is not specified.

ezvous Installation Location Information Setting
can enter information related to the location where the printer is installed.

> rendezvous location “location”

formation related to installation location can be entered using up to 32 alphanumeric characters.

he current installation location information appears if installation location information is not
tered.
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ng Order of Priority for Each Protocol
can specify the order of priority for “diprint”, “1pr”, and “ipp”. Smaller numbers indicate higher
ity.

iprint

sh> rendezvous diprint [0–99]

r

sh> rendezvous lpr [0–99]

p

sh> rendezvous ipp [0–99]

L setting
can specify the IP TTL (the number of routers a packet can pass through).

> rendezvous ipttl {1-255}

ote
he factory default setting is 255.

tting the computer name and location information
can reset the computer name and location information.

> rendezvous clear {cname | location}

ame
eset the computer name. The default for the computer name will be displayed when the com-
uter is restarted.

cation
eset the location information. The location information will be deleted. 
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th™

e setting for Bluetooth™, use the “btconfig” command.

 settings
Bluetooth™ settings are displayed.

> btconfig

e settings
can set Bluetooth™ operation mode to either [private] or [public].

> btconfig [private | public]

ote
he default is [public].

inology

sed in the explanations are explained.

ortant
rotocol is disabled or inactive, functions provided by that protocol cannot be used.

/IP
unctions that use “ftp”, “lpr”, “rsh”/”rcp”, “diprint”, http, ipp, web, wins, snmp *1 , smb *2 , and
ezvous. *1  *2 

NMP using TCP/IP
MB using TCP/IP

ote
ou cannot switch protocol functions, but you can disable smtp and dns by switching off or dis-
bling TCP/IP.
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rinter function using SmartDeviceMonitor for Client

rinter function using Microsoft Windows Network

rinter function using NetBEUI protocol

eTalk
rinter function using Appletalk with Macintosh

ote
his function can be selected when a module supporting PostScript 3 is attached.

are
rinter function using NetWare server (remote printer/printer server)

ote
 protocols are disabled or inactive under PureIP environment, only the print server can be used.

 this protocol is switched off or disabled, the SNMP session using IPX/SPX is also disabled.

rinter function using Standard TCP/IP

rinter function using command line

rinter function using command line

unction to obtain device information by command line

/RCP
rinter function using command line

unction to obtain device information by command line
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INT
rinter function using SmartDeviceMonitor for Client

eb Image Monitor function

P
idirectional configuration for the printer driver

unction to obtain device information by SmartDeviceMonitor for Admin/Client

rinter function using SmartDeviceMonitor for Client

eb Image Monitor function

unction to obtain device information by SmartDeviceMonitor for Admin/Client

S
following functions assume encrypted communication:

eb Image Monitor function

unction to obtain device information by SmartDeviceMonitor for Admin/Client

less LAN
less network interface based on the IEEE 802.11b standard

 (WINS)
unction to register a NetBIOS name (computer name)

unction to resolve a NetBIOS name (computer name)
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tooth™
ing function using Bluetooth™ interface

P/Autonet
tion for automatically assigning IP addresses

P
tion for sending and receiving e-mail to and from an SMTP server

unction to register a host name (dynamic DNS)

unction to resolve a host name

ezvous
er function that can be used with Mac OS 10.2.3 or later when using TCP/IP
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ing Printer Information over the Network

of each item when displaying printer status and information.

r current status

es the status of the printer. Status can be checked using the following method:

X: uses the “lpq” command and “rsh”, “rcp”, and “ftp” parameters. For details, see UNIX Sup-
ent.

ll: uses the “status” command. For details, see p.245 “Printer status”.

Messages Description

g... Adjusting color.

vice Center There is a malfunction.

g Job... An error has occurred in the engine part or controller part.

ring... The job is being cancelled.

pen: Duplex Unit Rear The optional duplex unit cover is open.

pen: Front The front cover is open.

pen: Rear The rear cover is open.

pen: Upper The upper cover is open.

Black Toner The toner cartridge is empty.

Cyan Toner The toner cartridge is empty.

Magenta Toner The toner cartridge is empty.

Yellow Toner The toner cartridge is empty.
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Saver Mode The printer is in Energy Saver Mode.

thernet Board An error has occurred in the Ethernet interface.

DD Board An error has occurred in the optional hard disk drive.

ptional Font An error has occurred in the optional font.

ptional RAM An error has occurred in the optional Memory Unit.

arallel I/F Board An error has occurred in the parallel interface.

SB I/F An error has occurred in the USB interface.

ireless Card The IEEE 802.11 b or Bluetooth™ card shows irregularity.

ireless Card or Board The IEEE802.11 b or Bluetooth™ card or board shows irregularity.

ndard Tray The standard tray is full.

oner Bottle Full/Not Set The waste toner bottle is full.

mp Mode The printer is in Hex Dump Mode.

ack Toner The toner cartridge is not set correctly, or toner is almost running out.

an Toner The toner cartridge is not set correctly, or toner is almost running out.

agenta Toner The toner cartridge is not set correctly, or toner is almost running out.

llow Toner The toner cartridge is not set correctly, or toner is almost running out.

neous Error An unspecifiable error has occurred.

h: Paper Size The tray's paper type setting differs from that of the actual size in the 
tray.

h: Paper Size and Type The tray's paper type setting differs from that of the actual size and type 
in the tray.

Messages Description
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h: Paper Type The paper type setting of the tray differs from that of the actual type in 
the tray.

ull: Waste Toner Bottle The waste toner bottle will soon be full.

r: Selected Tray There is no paper in the selected tray.

r: Tray 1 There is no paper in tray 1.

r: Tray 2 There is no paper in tray 2.

ected: Black Toner The black toner is not correctly set.

ected: Charge Roller The charger Roller is not correctly set.

ected: Cleaning Blade The cleaning blade is not correctly set.

ected: Cyan Toner The cyan toner is not correctly set.

ected: Fusing Unit The fusing unit is not correctly set.

ected: Input Tray The input tray is not correctly set.

ected: Magenta Toner The magenta toner is not correctly set.

ected: PCU The PCU is not correctly set.

ected: Transfer Unit The transfer unit is not correctly set.

ected: Tray 1 The tray 1 is not correctly set.

ected: Tray 2 The tray 2 is not correctly set.

ected: WasteToner Bottle The waste toner bottle is not correctly set.

ected: Yellow Toner The yellow toner is not correctly set.

The printer is offline and cannot print data.

isfeed: Duplex Unit There is misfeed in the duplex unit.

Messages Description



280

Paper M

Paper M

Paper M

Printing

Ready

Replace

Replace

Warmin

Waste T
Operating Instructions Administrator Reference

isfeed: Input Tray There is misfeed in the input tray.

isfeed: Internal Path There is a misfeed inside the machine.

isfeed: Output Tray There is misfeed in the output tray.

... Busy printing.

Printing is available.

 Fusing Unit It is time to replace the fusing unit.

 PCU It is time to replace the photo conductor unit.

g Up... The printer is warming up.

oner Bottle Full/Not Set The waste toner bottle is full, or not set properly.

Messages Description
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r configuration

 check the printer configuration using telnet.

t
the “info” command.

sterisk) appears with the current setting.

rding *1 - *5, see the following table.

Item Description

ay

ID number of the paper tray

Name of the paper tray*1

ze Paper size loaded in the paper tray*2

Current status of the paper tray*3

ray

ID number of the output tray

Name of the output tray*4

Current status of the output tray*5

anguage

ID number of the printer language used by the printer

Name of the printer language used in the printer

Version of the printer language
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❖❖❖❖ *2 In

❖❖❖❖ *3 In

Tray X

A4 (210

A5 (148

8 1/2 × 1

8 1/2 × 1

5 1/2 × 8

7 1/4 × 1

Custom

NCS

**

Normal

NoTray

PaperEn
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put Tray: Name

put Tray: PaperSize

put Tray: Status

Name Description

Name of installed paper tray (X is the number of tray).

Paper Size Description

 × 297 mm) A4 (210 × 297) K

 × 210 mm) A5 (148 × 210) K

4 LG (8 1/2 × 14) K

1 LT (8 1/2 × 11) K

 1/2 5 1/2 × 8 1/2 K

0 1/2 7 1/4 × 10 1/2 K

(XXXxYYY mm) Custom Size

There is no tray.

The paper size is not selected.

Status Description



There is no paper tray

d There is no paper in the paper tray
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utput Tray: Name

utput Tray: Status

Name Description

 Tray Output Tray

Status Description

----

Other errors
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rstanding the Displayed Information 

tion describes how to read the status information returned by the network interface board.

ob Information

us of the print job can be viewed using the following commands.

t : Use the “status” command. See p.245 “Printer status” .

me Meaning

Print job status.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Print request user name.

Print request number.

The name of the document.

ze The size of the data (spooled).

The default is “0 bytes”.
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og Information

 record of the most recent 16 jobs that have been printed.

 can be displayed with the following commands.

t : Use the “prnlog” command. See p.245 “Printer status” .

ars the UserID and JobName information when entering the info command with the ID.

Meaning

Print request ID.

Print request user name.

The number of pages that is printed.

The result of the print request.

The time when the print request was received

 *1 User ID that is to be configured in the printer driver.

e *1 The name of the document for printing.
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uring the Network Interface Board

ork interface board settings can be displayed by using the commands below.

t : Use the “show” command. See p.246 “Network interface board configuration settings infor-
on” .

me Meaning

n 

e 

col Up/Down Up means active, Down means inactive.

pleTalk 

P/IP 

tWare 

B

t interface Internal version number

riority

 version Internal version number

name Printer name.

nt Comment.

n Location of the printer in the SNMP and Rendezvous information 

 Person who maintains the printer and contact information in the 
SNMP information 

itch 
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alk 

e AppleTalk protocol in selection.

Network number.

ct Macintosh printer name.

 The type of printer.

 Name of the zone that the printer belongs to.

 

e Up means active, Down means inactive. 

 

 

 

net 

rint 

b 

p

c 

mp

tonet

dezvous

me Meaning
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pType Frame type.

P Dynamic Host Configuration Protocol (on/off)

ess IP address.

ask Subnet mask.

dcast Broadcast address.

 Domain DNS domain type

way Default gateway address.

s Range[✩ ] *1 Access Control Range.

 server NTP server address

 Zone NTP server time difference

 server polling time Synchronizes interval

OG server

e page URL URL of homepage.

e page link name URL name of homepage.

 page URL URL of help page.

P protocol Protocol used with SNMP.

me Meaning
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e 

pType Frame type.

INTER number Remote printer number.

 server name Print server name.

erver name Name of the connect file server.

ext name Context of print server.

h 

ode Active mode.

S/Bindery (this value is fixed)

cket negotiation 

gin Mode Login mode.

 job timeout Time of the job timeout.

col Protocol used.

interval time

 Tree Name NDS tree name.

h 

ode (this value is fixed)

rect print (this value is fixed)

tification Notification of print job completion.

group name Name of the workgroup.

me Meaning
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puter name Name of the computer.

ment Comment.

 name[1] Share name (name of the printer type).

col

2.11b *2 

e Name Printer name.

P DHCP (on/off)

ss IP address.

ask Subnet mask.

cast Broadcast address.

Domain DNS domain type

SSID being used.

nel range Channels available for use.

nel Channel being used.

unication mode IEEE 802.11b interface transmitting mode.

tication

ate IEEE 802.11b interface speed.

 encryption Whether WEP is enabled or disabled.

ption key WEP key.

me Meaning
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th *3 

th mode Bluetooth™ connection mode

X *4 ]: IP address of the DNS server

d DNS Server Selected DNS server

 Name

Domain name on an Ethernet connection

Domain name on a wireless LAN connection

ous

puter Name Printer name.

ezvous Name (ether) Printer name displayed with Rendezvous on an Ethernet connection

ezvous Name (wlan) Printer name displayed with Rendezvous on a wireless LAN connection

tion Location of the printer

ity (diprint) diprint priority number

ity (lpr) lpr priority number

ty (ipp) ipp priority number

L IP TTL value

Dynamic DNS function on an Ethernet connection (on/off)

Dynamic DNS function on a wireless LAN connection (on/off)

me Meaning
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presents a target number between 1 and 3.
can display the item names when installing the optional 802.11b interface unit.
can display the item names when installing the optional Bluetooth™ interface unit.
presents a target number between 1 and 3.

ry WINS IP address of the primary WINS server on an Ethernet connection

dary WINS IP address of the secondary WINS server on an Ethernet connection

ode Mode of the remote maintenance tool.

me Meaning
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age List

 list of messages written in the printer's system log. The system log can be viewed using the
ommand.

m Log Information

 use the following methods to view the system log.

t : Use the “syslog” command. See p.236 “Commands List” .

e Description and Solutions

o NetWare server <file server name> denied. Ei-
e is no account for this print server on the Net-
rver or the password was incorrect. 

(In print server mode) Cannot log in to the file server. 
Make sure that the print server is registered on the file 
server. If a password is specified for the print server, de-
lete it.

s: bad trap addr:<IpAddress>, community:<com-
ame>

The IP address (0.0.0.0.) is unavailable when the commu-
nity access type is TRAP. Specify the host IP address for 
the TRAP destination.

: community<community name> already defined. The same community name already exists. Use another 
community name.

s_ipx: bad trap addr: <IPXaddress>, communi-
munity name>

The IPX address (00:00:00:00:00:00) is unavailable 
when the community access type is TRAP. Specify the 
host IPX address for the TRAP destination.

s_ipx: community <community name> already The same community name already exists. Use another 
community name.

MOUS FTP LOGIN FROM <IP address>, 
rd>

An anonymous login has been made with a password 
<password> from the host <IP address>.
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rt. (AppleTalk) An anpd (AppleTalk Network Package Daemon) has 
started.

ileServer =<file server name> Attached to the file server as a nearest server.

o print queue <print queue name> (In print server mode) Attached to the print queue name.

create service connection (In remote printer mode) Cannot establish a connection 
with the file server. The number of file server users may ex-
ceed the maximum number that the file server can handle.

find rprinter (<print server name>/
 number>)

The printer having the number displayed on the print 
server does not exist. Make sure that the number of the 
printer is registered in the print server.

IP address from DHCP Server. The IP address changes when DHCP LEASE is renewed. 
To always assign the same IP address, set a static IP ad-
dress to the DHCP server.

cess exec error! (process name) Failed to start the network service. Turn the printer off 
and then on. If this does not work, contact your service or 
sales representatives.

ed DHCP Server(<DHCP server address>). The IP address was successfully received from the DHCP 
server.

ion from <IP address> Logged on from the host <IP address>.

ot attach to FileServer<error number> (In remote printer mode) Cannot attach to the file server. 
For some reason, the file server refuses the connection. 
Check the file server configuration.

ot attach to PServer<print server> (In remote printer mode) Cannot attach to the print server. 
For some reason, the print server refuses the connection. 
Check the print server configuration.

Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 Mbps).

e Description and Solutions
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IP address <current IP address> The IP address <current IP address> was received from 
the DHCP server.

IPX address<IPX address> The current IPX address.

ease time expired. DHCP lease time has expired. The printer tries to discov-
er the DHCP server again. The IP address used up to now 
becomes invalid.

erver not found. The DHCP server cannot be found. Make sure the DHCP 
server is running on the network.

start. A dhcpcd (DHCP client service) has started.

te IP=<IP address>(from <MAC address>). The same IP address is used. An IP address must be 
unique. Check the address of the device indicated in 
<MAC address>.

hed SPX Connection with PServer,

et=<socket number>, connID=

tion ID>)

(In remote printer mode) A connection with the print 
server has been established.

lpd service has ended and the system is exiting the process.

rver (In print server mode) Exits the print server because the 
necessary print server settings have not been made.

pe =<frame type name> The <frame type name> is configured to be used on Net-
Ware.

rt. An httpd has started.

rt. An inetd has started.

el-job: permission denied. The printer could not authenticate the name of the user at-
tempting to cancel a job.

e Description and Solutions
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ble. Printing with ipp is disabled.

le. Printing with ipp is enabled.

canceled. jobid=%d. The spooled job has been canceled due to an error or by 
user request.

me=<lease time>(sec), RenewTime=<renew 
c).

The resource lease time that was received from the DHCP 
server is <lease time> in seconds. The renewal time is 
also <renew time> in seconds.

 fileserver <file server name> 
>,<NDS|BINDERY|NDS|BINDERY>) 

(In print server mode) Logged in to the file server with 
NDS or BINDERY mode.

tart. Data transmission service for multiprotocols has started.

tart. (NetBEUI) The service for NetBEUI protocol stack setting has started.

gistration Broadcast(<NetBIOS name>) Use a local broadcast to map <NetBIOS name> with the 
IP address.

rt. A nbtd (NetBIOS over TCP/IP Daemon) has started. 
(Available only in DHCP mode)

I Computer Name =<computer name> The NetBEUI Computer Name is defined as <computer 
name>.

rt. (NetBEUI) A nmsd (Name Server Daemon) has started.

tart. (NetWare) (In remote printer mode) NetWare service has started.

start. (NetWare) The service for NetWare protocol stack setting has started.

g file <file name> (In print server mode) The specified log file has been 
opened.

rt. (AppleTalk) AppleTalk print service has started.

e Description and Solutions
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ase file open failed. Replacing the Network Interface Board is required. Con-
tact your sales or service representatives.

eue <print queue name> cannot be serviced by 
, <print server name>

(In print server mode) The print queue name cannot be 
serviced. Make sure that print queue volume exists on the 
specified file server.

ver <print server name> has no printer. (In print server mode) The printer object is not assigned to 
the print server <print server name>. Using NWadmin, as-
sign the printer object, and then restart the printer device. 

sion full Cannot accept the print session.

printer name> has no queue (In print server mode) The print queue is not assigned to 
the printer. Using NWadmin, assign the print queue to the 
printer, and then restart it.

start. (NetWare) (In print server mode) NetWare service has started.

d computer name (<Computer name>) is dupli-
me 

The same computer name is detected on the network. The 
start job determines the computer name by adding the 
computer name to the suffix (0,1....). Configure a new 
computer name that is unique.

d file server (<file server name>) not found Cannot find the required file server.

. LPD has started.

le, saptype=<SAP type>, sapname=<SAP The SAP function has started. The SAP (SAP type and 
SAP name) packet is issued to advertise the service on the 
SAP table on the NetWare server.

community name>already defined. A requested community name is not defined.

ipx<community name> not defined. A requested community name is not defined.

ext to <NDS context name> A <NDS context name> has been set. 

e Description and Solutions
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n signal received. network service rebooting... Rebooting the network service.

rt. (NetBEUI) An smbd (SMB (Server Message Block) service) has 
started.

: failed to get smtp server ip-address. Failed to get the SMTP server IP address. This could be 
because:

• The DNS server could not be found.

• There is no connection to the network.

• The specified DNS server could not be connected to.

• Incorrect DNS server is specified.

• No specified SMTP server IP address in the DNS 
server.

: failed to connect smtp server. timeout. Failed to connect the SMTP server due to timeout. This 
could be because:

• The SMTP server name is incorrect.

• There is no connection to the network.

• The network configuration is incorrect, so there is no 
response from the SMTP server.

: refused connect by smtp server. The connection to the SMTP server is denied. This could 
be because:

• Another server other than the SMTP server has been 
specified.

• The SMTP server port number is incorrect.

e Description and Solutions
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: no smtp server. connection close. No response from the SMTP protocol. Cannot connect to 
the SMTP server. This could be because:

• Another server other than the SMTP server has been 
specified.

• The SMTP server port number is incorrect.

: failed to connect smtp server. Failed to connect the SMTP server. This could be because:

• There is no connection to the network.

• The network configuration is incorrect, so there is no 
response from the SMTP server.

• The SMTP server name is incorrect.

• The specified SMTP server is incorrect.

• There is no specified SMTP server IP address in the 
DNS server.

• Another server other than the SMTP server has been 
specified.

• The SMTP server port number is incorrect.

: username or password wasn’t correct. Failed to connect the SMTP server. This could be because:

• The specified SMTP user name is incorrect.

• The specified SMTP password is incorrect.

Check the SMTP user name and password.

er ip is ready. Communication over TCP/IP with SNMP is available.

er ipx is ready. Communication over IPX with SNMP is available.

tart. SNMP service has started.

Direct print service has started.

The Rendezvous function is enabled.

e Description and Solutions
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ted. The Rendezvous function is disabled.

t server received error <error number> during at-
 log in to the network.Access to the network was 
erify that the print server name and password are 

Cannot log in to the file server. The print server is not reg-
istered or the password is specified. Register the print 
server without specifying a password.

ame refresh :Server No Response There has been no response to the update request from the 
server. Confirm that the WINS server address is correct 
and the WINS server is working properly.

ame registration/refresh error code(errornumber) Set NetBIOS names those do not overlap with each other.

Confirm that the WINS server address is correct and the 
WINS server is working properly.

ame registration:Server No Response There has been no response to the registration request 
from the server. Confirm that the WINS server address is 
correct and the WINS server is working properly.

erver address0.0.0.0 The WINS server address has not been specified. Specify 
the WINS server address to match the printer name with 
WINS.

erver=<WINS server address> NetBIOS 
NetBIOS name>

The printer name has been successfully registered in 
<WINS server address>.

rong scopeID The scope ID is wrong.

Specify the correct scope ID.

e Description and Solutions
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n Using Windows Terminal Service/MetaFrame

ting Environment

owing combinations of operating system
aFrame are supported:

ows NT Server 4.0 Terminal Server
on
etaFrame 1.8 SP3/FR1 SP3/SP4

etaFrame XP 1.0 SP1/SP2/FR1

ows 2000 Server /Advanced Server 
etaFrame 1.8 SP3/FR1 SP3/SP4

etaFrame XP 1.0 SP1/SP2/FR1/FR2

rted Printer Drivers

n Windows Terminal Service is operating
CL5c

ostScript 3

RPCS printer driver is not supported.

e RPCS printer driver functions do not
 if Windows Terminal Service is installed,
 if it is not operating.

Limitation

The following restrictions apply in the Windows
Terminal Service environment.

These restrictions are due to the way Windows
Terminal Service or MetaFrame works.

❖❖❖❖ When printing (Windows Terminal Service)
When printing a file containing a large
number of bitmap images or fonts, some im-
ages or font settings may be lost. We strongly
recommend testing this function under your
network environment before applying it to ac-
tual jobs.
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n using [Auto-creating client printers]
aFrame)
-creating client printers] can select a log-
rinter created by copying the client's lo-

rinter data to the MetaFrame server. We
gly recommend testing this function un-
our network environment before apply-

t to actual jobs.

he settings for optional equipment will
ot be stored in the server after the equip-
ent is disconnected. The settings for op-
onal items will return to default values
ch time the client computer logs on to
e server. 

hen printing a large number of bitmap
ages or using the server in a WAN envi-
nment over dial-up lines such as ISDN,

epending on the data rate, printing may
e disabled or errors may occur.

hen using MetaFrame XP 1.0 or later
ersions, we recommend configuring [Cli-
t Printer bandwidth] available from [Cit-

x Management Console], according to the
vironment.

• If a printing error occurs on the server and
the print job or [Auto-creating client print-
ers] cannot be deleted, we recommend do-
ing the following:

• MetaFrame 1.8 SP3, MetaFrame XP
1.0 SP1/FR1
Configure the [Delete unfinished print
jobs] settings in the registry. For more
information, see the Readme file pro-
vided with MetaFrame.

• MetaFrame XP 1.0 FR2
Configure the [Delete pending print
jobs at logout] settings in [Printer Prop-
erties Management] of the Citrix Man-
agement Console.

❖❖❖❖ When using [Printer driver replication]
(MetaFrame)
[Printer driver replication] is designed to dis-
tribute printer drivers across all servers in a
server farm. We strongly recommend testing
this function under your network environment
before applying it to actual jobs.

• If the printer drivers are not properly cop-
ied, we recommend installing them direct-
ly onto each server.
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ions when using Bluetooth™ Interface Unit

chine's optional Bluetooth™ interface
ration mode, is set to [public] as default.

tting is changed to [private], only regis-
mputers can use this machine via Blue-
interface unit.

re settings to the operation mode using
age Monitor or telnet.

rence
p.125 “Using a Web Browser” for Web
e Monitor. See Web Image Monitor Help
etails about setting items.

p.273 “Bluetooth™” for details about
ng operation mode settings using telnet. 
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autions

ay attention to the following when using the network interface board. When configuration is
ry, follow the appropriate procedures below.

cting a Dial Up Router to a Network

e NetWare file server and the printer are on the opposite side of a router, packets are continu-
nt back and forth, possibly causing communication charges to increase. Because the packet
sion is a specification of NetWare, you need to change the configuration of the router. If the
 you are using does not allow you to configure the router, configure the printer.

ring the router

e packets so that they do not pass over the dial-up router.

MAC address of the printer doing the filtering is printed on the printer configuration page. For
 information about printing a configuration page, see p.166 “Printing a Configuration Page”.

ore information about configuring the printer if the router cannot be configured, see the instruc-
 below.
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ring the printer with NetWare

w the setup method in this manual, configure the file server.

he Frame type for a NetWare environment.

eference
or more information about selecting a Frame type, see p.89 “Configuring the NetWare Protoco
sing the Control Panel”.

ring the printer without NetWare

le not printing, the network interface board sends packets on the network. Set the Net-
e to inactive.

eference
or more information about selecting a protocol, see p.89 “Configuring the NetWare Protocol us-
g the Control Panel”.

cript Printing from Windows

rinting PostScript from Windows, see the PostScript 3 Supplement.
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re Printing

ed

uld not configure the form feed on NetWare. The form feed is controlled by the printer driver
ows. If the NetWare form feed is configured, the printer might not print properly. If you want
e the form feed setting, always configure it on Windows.

 Windows 95/98/Me, clear the [Form feed] check box under the [Printer Settings] tab in the
er Properties dialog box.

 Windows 2000/XP, Windows Server 2003, Windows NT 4.0, clear the [Form feed] check box
r the [NetWare Settings] tab in the Printer Properties dialog box.

 Page

uld not configure a banner page on NetWare. If you want to change the banner page setting,
onfigure it on Windows. 

 Windows 95/98/Me, clear the [Enable banner] check box under the [Printer Settings] tab in the
er Properties dialog box.

 Windows 2000/XP, Windows Server 2003, Windows NT 4.0, clear the [Enable banner] check
under the [NetWare Settings] tab in the Printer Properties dialog box.
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 after resetting the printer

setting the remote printer, it will be cut off from the print server for about 30-40 seconds before
ing again. Due to the NetWare specification, print jobs may be accepted, but they will not be
during this interval.

sing the printer as a remote printer, wait about 2 minutes after resetting the printer before at-
g to print. 

 DHCP

chine can be used in DHCP environment. In a WINS server environment, the printer name can
eously be registered with a WINS server.

n static IP addresses are set for each interface
 address: When set at the same value, the Ethernet interface is used.

ubnet mask: When a value overlaps, the Ethernet interface is used.

ateway address: The value set is used. For the gateway address, set the gateway address located
 the subnetwork set by the interface. Is a value is outside the subnet range set by the interface,
 operates as “0.0.0.0”. 
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n each setting is acquired from the DHCP server
 address, subnet mask: set for each value leased by the DHCP server operating on a connected
terface. When overlapping IP addresses or identical IP addresses in the subnetwork are set at
is time, only the highest priority active value is set for the interface.

Note
The default priority interface is Ethernet.

utoNet: An automatic private address (169.254. xxx.xxx) is set for high priority interfaces.

ateway address, DNS server address, domain name: Settings are made for the DHCP-acquired
alues that have the highest interface priority.
 the gateway address is outside the subnetwork range set by the interface, it operates as
.0.0.0”.

Note
The default priority interface is Ethernet.

n the settings of the static IP addresses and the DHCP acquired value overlap
 address, subnet mask: When the static IP address and DHCP-acquired value (IP address) are
e same, or the static subnet mask value and DHCP-acquired subnet mask value overlap, the
terface (strikethrough : setting) set by the static IP (strikethrough : use the) address is available

sing its value set. The interface set by DHCP is reset to the default.

ateway address: Uses the manually set value. 

hen a gateway address is set outside the interface subnetwork range, it operates as “0.0.0.0”.

Note
When the static IP address is not set, or is set as “0.0.0.0”, the interface setting the DHCP
acquisition value is activated.
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orted DHCP server operating systems are: Windows 2000 Server, Windows NT 4.0 Server
ice Pack 4 or later, NetWare, and UNIX standard. 

IP address acquired from DHCP can be checked on the configuration page. See p.166 “Printing
nfiguration Page” printing the configuration page.

n using WINS server, set the WINS server as shown on p.311 “Configuring a WINS Server”. 

r WINS server, host names can be used for remote network printer ports.

 do not use the WINS server, reserve the printer's IP address in the DHCP server so the same
dress is assigned every time.

n there are multiple DHCP servers, make the same reservation for all. This machine operates
e information from the DHCP server that answered first.

P relay-agent is not supported. If you use DHCP relay-agent on an ISDN line network, it wil
 expensive line charges. This is because your computer connects to the ISDN line whenever a
et is transferred from the printer.
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utoNet

inter IP address is not assigned by a DHCP server automatically, a temporary IP address starting
.254 which is not used on the network can be selected automatically by the printer.

st change the setting to “on” to use AutoNet. 

rence
p.263 “AutoNet”.

DHCP-assigned IP address for priority over that selected by AutoNet. As this machine reboots
is time, it is temporarily not able to print.

can confirm the current IP address on the configuration page. For more information about the
guration page, see p.166 “Printing a Configuration Page”.

n AutoNet is running, the printer name is not registered on the WINS server.

ommunication can take place except between units started up using AutoNet. However, com-
ication can take place Macintosh machines running Mac OS X 10.2.3 or later versions.
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uring a WINS Server

ter can be configured to register its NetBIOS name with a WINS server when power is turned
 enables the NetBIOS name of the printer to be specified from SmartDeviceMonitor for Admin
der a DHCP environment.

tion describes how to configure the WINS server.

WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or later, and Windows
 Servers WINS Manager.

ore information about the WINS Server settings, see Windows Help.

re is no reply from the WINS Server, the NetBIOS name will be registered by broadcast.

NetBIOS name consists of up to 13 alphanumeric characters.
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 Web browser

t the Web browser.

r “http: //(IP address of printer whose settings you want to change)/” in the address bar
cess the printer whose settings you want to change.

Web Image Monitor Top Page appears.

 [Administrator Mode].
dialog box for entering the password and user name appears.

r your user name and password, and then click [OK].
se the factory default account, enter no user name and type “password” for the password.

e left area, click [Configuration], and then click [Network]. 

 [TCP/IP].

k [WINS] in the [Ethernet] column is [Active], and then enter the WINS server's IP address
oth [Primary WINS Server] and [Secondary WINS Server]. 

 [Apply].

 the Web browser.

lnet

1 “WINS”
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 the Dynamic DNS Function 

c DNS is a function which dynamically updates (registers and deletes) records (A record and
ord) managed by the DNS server. When a DNS server is part of the network environment to
is machine is connected and this machine is a DNS client, records can be dynamically updated
is function.

rocessing updates

g procedure differs depending on whether the machine's IP address is static or acquired by DHCP.

n the dynamic DNS function is not used, if the IP address of this machine is changed, records
aged by DNS server must be updated manually.

pdate the record with this machine, the DNS server has to have either of the following:

o security settings made.

 security settings are made, an IP-specified client (this machine), that permits updating.

e case of a static IP setting
 IP address or host name is changed, this machine updates the A and PTR record. 
 A record is registered, CNAME is registered also. CNAMEs that can be registered are as follows.

thernet and IEEE 802.11b
NPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)
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HCP settings
 substituting for this machine, the DHCP server updates the record, and one of the following
rs: 

hen this machine acquires the IP address from the DHCP server, the DHCP server updates the
 and PTR record.

hen this machine acquires the IP address from the DHCP server, this machine updates the A
cord, and the DHCP server updates the PTR record.
 A record is registered, CNAME is registered also. CNAMEs that can be registered are as follows:

thernet and IEEE 802.11b
NPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

itation
mic update using message authentication (TSIG, SIG(0)) is not supported.

rvers targeted for operation

tatic IP setting
icrosoft DNS server with standard Windows 2000 Server features

IND 8.2.3 or later

HCP setup, when this machine updates the A record
icrosoft DNS server with standard Windows 2000 Server features

IND 8.2.3 or later

e case of the DHCP setup, when the DHCP server updates records
icrosoft DNS server with standard Windows 2000 Server features

IND 8.2.3 or later

NS server with standard NetWare 5 (or a later version) features
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ervers targeted for operation

stitute for this machine, DHCP servers capable of updating the A record are as follows:

osoft DHCP server with standard Windows 2000 Server (Service Pack 3 or later versions) features

DHCP 3.0 or later

P server with standard NetWare 5 features

method of the dynamic DNS function 

ttings with telnet using the “dns” command. For details, see p.266 “DNS”.
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l Printing

ool Printing, the whole data of a print job is saved in the hard disk drive before printing. To use
tion, set it from the menu. See p.186 “System Menu”.

ortant
ot turn off the printer or the computer when a print job is being spooled and the Data In indicator
nking. If you do, the print job will remain in the hard disk drive and be printed when the printer
ned on.

itation
l Printing does not appear unless the optional hard disk drive is installed.

 that has been received in the protocol other than “diprint”, “lpr”, “IPP”, or “SMB” cannot be
led.

 “diprint”, spool printing cannot take place using bi-directional communication.

ximum number of 150 jobs can be spooled.

capacity of the domain reserved for spool printing is about 1 GB.

n Spool Printing is on, the size of a single print job cannot exceed 500 MB.

n sending spooled print jobs from more than one computer at the same time, up to one diprint
10 LPR jobs, one IPP job, and one SMB job can be spooled. Jobs exceeding the maximum
ber cannot be spooled. Wait until the number of spooled print jobs falls below the maximum be-
adding jobs.

n “On” is selected, the first print will take time.

 spool printing, the computer is freed from print processing earlier, even when processing a
 amount of data.

l jobs stored in the machine can be viewed or deleted using a Web browser. 



317

Settin

Spool P

• Usin
In [S
For d

• Usin
Type
For m
Operating Instructions Administrator Reference

g Spool Printing

rinting can be set using telnet or a Web browser.

g a Web browser
ystem] on the [Configuration] menu, set [Spool Printing] to [Enable].
etails, See Web Image Monitor Help.

g telnet
 in “spoolsw spool on” to set Spool Printing.
ore information, See p.259 “Job Spool”.
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m or delete the spooled job from a Web browser

oled job can be viewed or deleted from a Web browser.

t the Web browser.

r “http: //(IP address of printer whose settings you want to change)/” in the address bar
cess the printer whose settings you want to change.

Web Image Monitor Top Page appears.

 [Administrator Mode].
dialog box for entering the password and user name appears.

r your user name and password, and then click [OK].
se the factory default account, enter no user name and type “password” for the password.

 [Job] on the menu displayed in the left frame.

bmenu will then appear.

 [Spool Printing] on the [Printer] menu.

t of spooled jobs appears. 

elete a job, select the check box of the job you want to delete, and then click [Delete].
checked job is deleted.

 the Web browser.

eference
or more information, see Web Image Monitor Help.
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n Using IPP with SmartDeviceMonitor for Client

sing IPP with SmartDeviceMonitor for
ote the following:

network printer can only receive one
 job from SmartDeviceMonitor for Client
time. While the network printer is print-
another user cannot access it until the job
ished. In this case, SmartDeviceMonitor
lient tries to access the network printer

 the retry interval expires.

artDeviceMonitor for Client cannot ac-
the network printer and times out, it will
sending the print job. In this case, you
ld cancel the paused status from the print
e window. SmartDeviceMonitor for Cli-
ill resume access to the network printer.

 can delete the print job from the print
e window, but canceling a print job print-
 the network printer might cause the next
ent from another user to be incorrectly
ed.

• If a print job sent from SmartDeviceMonitor
for Client is interrupted and the network print-
er cancels the job because something went
wrong, send the print job again.

• Print jobs sent from another computer do not
appear in the print queue window, regardless
of protocol.

• If various users send print jobs using Smart-
DeviceMonitor for Client to network printers,
the printing order might not be the same as
that in which the jobs were sent.

• An IP address cannot be used for the IPP port
name because the IP address is used for the
SmartDeviceMonitor for Client port name.
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ory Capacity and Paper Size

t resolution from each printer driver is as follows:
PCS: [600 x 600 dpi] on [Resolution]
CL 5c: [600 dpi] on [Resolution]
ostScript 3: [600 dpi] on [Resolution] and [Fast] on [Gradation]

eference
For more information about how to set the printer driver, see printer driver's Help.

t resolution from each printer driver is as follows:
PCS: [1200 x 600 dpi] on [Resolution]
ostScript 3: [600 dpi] on [Resolution] and [Standard] on [Gradation]

eference
For more information about how to set the printer driver, see printer driver's Help.

ortant
plex printing, do not use A5 paper size.

Quality Paper Size
Non-Duplex Printing Duplex Printing

Can be printed Guaranteed Can be printed Guaranteed

0 dpi *1 

A4

128 MB (Standard)

128 MB (Standard)

A5  

Letter 128 MB (Standard)

00 dpi *2 
A4

128 MB (Standard)

128 MB

(Standard)

192 MB

(Standard + 64 MB)

A5  

Letter
128 MB

(Standard)

192 MB

(Standard + 64 MB)
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Spec

Mainf

❖❖❖❖ Conf
Desk

❖❖❖❖ Print
Sem
Phot

❖❖❖❖ First
Mon
Mon

❖❖❖❖ Print
Mon
Colo

❖❖❖❖ Reso
600 ×

❖❖❖❖ Pape
See “

❖❖❖❖ Pape
See “
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ifications

rame

iguration:
top

 Process:
iconductor laser beam scanning method
o conductor 1 drum method

 Print Speed:
ochrome: 14 sec or less (A4K) 
ochrome: 20 sec or less (A4K) 

ing Speed:
ochrome: Maximum 31 pages per minute (A4K),
r: Maximum 8 pages per minute (A4K)

lution:
 600 dpi

r size:
Paper and Other Media, Maintenance Guide.

r Weight:
Paper and Other Media”, Maintenance Guide.
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ia Type:
Paper and Other Media”, Maintenance Guide.

r Output Capacity:
dard 250 sheets (80 g/m2 (20 lb.bond))

r Input Capacity:

aper weight: 80 g/m2 (20 lb. bond)

er Source:
 240 V, 6A or less, 50 Hz

er Consumption:

-up Time:
 than 45 seconds (22°C, 71.6 F) *1 

hen no error.

nsions:

dard Paper Tray 250 sheet tray *1 

onal Paper Feed Units 530 sheet paper tray *1 

ting 1,300 W or less (No power is used during power off.)

gy Saver 15 W or less

Width Depth Height

ter only 
 not extended)

480 mm (18.9 inches) 420 mm (16.5 inches) 385 mm (15.2 inches)
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❖❖❖❖ Weig
Appr

❖❖❖❖ Nois
Soun

Soun

*1 T
*2 M

❖❖❖❖ Mem
Stan
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Stan
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• U
*1

Opti
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Stan

Duri

Stan
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ht:
oximately 31.5 kg (69.4 lb) (toner cartridge and power cord included)

e Emission *1 :
d Power Level

d Pressure level *2 

he preceding measurements made in accordance with ISO7779 are actual values.
easured at the position of a bystander.

ory:
dard 128 MB, up to 384 MB (with the optional Memory Unit)

face:
dard:

arallel (Bidirectional IEEE1284)

thernet (10/100Base-TX)

SB2.0 *1 

It requires a USB computer port and cable that support USB 2.0.
onal:

EE 802.11b (Wireless LAN)

luetooth™

Mainframe only

d-by 54 dB (A) 

ng Printing 66 dB (A)

Mainframe only

d by 46 dB (A)

ng Printing 60 dB (A)
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❖❖❖❖ Print
PCL

❖❖❖❖ Font
PCL
Agfa
Font
Post
136 f
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er Language:
 5c, RPCS, Adobe PostScript Level 3, PDF

s:
 5c
 Font 35 Manager Intellifonts, 10 TrueType fonts, and 1 Bitmap font Agfa
 Manager available, 31 fonts
Script 3
onts
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ns

 FEED UNIT Type 1000

r size:
, Letter (81/2×11)K

nsions (W ×××× D ×××× H):
 466.5 × 185 mm (18.1 × 18.4 × 7.3 inches)

r weight:
105 g/m2, (16 - 28 lb. bond)

ht:
 than 6.0 kg (13.2 lb)
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AD460

❖❖❖❖ Dime
345 ×
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❖❖❖❖ Pape
A4K

❖❖❖❖ Pape
60 - 

❖❖❖❖ Weig
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Hard Di

❖❖❖❖ Stor
20 G

❖❖❖❖ Spec
• S
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nsions (W ×××× D ×××× H):
 185 × 406 mm (13.6 × 7.3 × 16.0 inches)

ote
his option is built into the machine.

r size:
, Letter (81/2×11)K

r weight:
105 g/m2 (16 - 28 lb. bond)

ht:
 than 5.2 kg (11.5 lb. bond)

sk Drive Type 2600

age Capacity (Formatted):
B

ifications:
pool print data to collate

pool Sample Print/Locked Print data

tore PostScript fonts

tore log data

ote
ou can install PostScript fonts with this optional hard disk drive. With Mac OS, types of fonts sup-
orted are PostScript Type 1 and PostScript Type 2. To download them, use Printer Utility for Mac.
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Memory

❖❖❖❖ Mod
SO-D

❖❖❖❖ Mem
SDR

❖❖❖❖ Num
144 p

IEEE 80

❖❖❖❖ Tran
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❖❖❖❖ Prot
TCP

N
❒ S

❖❖❖❖ Data
Auto
1 Mb
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 Unit Type C (64/128/256 MB)

ule Type:
IMM (Small Outline Dual-in-line Memory Module)

ory Type:
AM (Synchronous Dynamic RAM)

ber of Pins:
ins

2.11b Interface Unit Type D

smission Spec.:
d on IEEE 802.11b (Wireless LAN)

ocol:
/IP, NetBEUI, IPX/SPX, AppleTalk

ote
martDeviceMonitor and Web Image Monitor are supported.

 Transfer Speed:
 select from below speed
ps, 2 Mbps, 5.5 Mbps, 11 Mbps
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uency Range:
ch version:

412-2462 MHz (1-11 channels)

etric version:
412-2472 MHz (1-13 channels)

smittable Distance:
ps 400 m *1 

ps 270 m *1 

bps 200 m *1 

bps 140 m *1 

hese figures are a guideline for outdoor use. In general, the transmittable distance indoors is 10-100
, depending on the environment.

smission Mode:
c mode and infrastructure mode
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Bluetoo

❖❖❖❖ Supp
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• B

❖❖❖❖ Freq
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th Interface Unit Type 2238

orted Profiles:
PP (Serial Port Profile)

CRP (Hardcopy Cable Replacement Profile)

IP (Basic Imaging Profile)

uency Range:
z ISM band

 Transmission Speed:
bps

ote
he transmission speed is adjusted according to factors such as the distance and obstacles be-
een the devices, radio signal condition and Bluetooth™ adaptor.

mum Range:
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mation about Installed Software

he software installed on this product, including the controller (hereinafter "software") and the ex-
ion 1.95.2 application software (hereinafter "expat 1.95.2"), is subject to the following conditions:

duct manufacturer provides warranty and support to the software of the product including expat
nd the product manufacturer allows the initial developer of expat 1.95.2 to be free from these
ons.

ht (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

rk Cooper

ion is hereby granted, free of charge, to any person obtaining a copy of this software and asso-
ocumentation files (the "Software"), to deal in the Software without restriction, including with-
tation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
oftware, and to permit persons to whom the Software is furnished to do so, subject to the fol-
onditions:

ve copyright notice and this permission notice shall be included in all copies or substantial por-
the Software.

FTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
LIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABIL-
TNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT
 THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAG-
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHER-
RISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
ER DEALINGS IN THE SOFTWARE.

mation on expat 1.95.2 is available at:
p://expat.sourceforge.net/
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 LIBRARY

software installed on this product is based in part on the work of the Independent JPEG Group.

D

ht Notice of NetBSD
sers to use this product:
duct contains NetBSD operating system:
most part, the software constituting the NetBSD operating system is not in the public domain;
rs retain their copyright.
owing text shows the copyright notice used for many of the NetBSD source code. For exact
ht notice applicable for each of the files/binaries, the source code tree must be consulted.
urce code can be found at http://www.netbsd.org/.
ht © 1999, 2000 The NetBSD Foundation, Inc.
ts reserved.
bution and use in source and binary forms, with or without modification, are permitted provided
following conditions are met:
stributions of source code must retain the above copyright notice, this list of conditions and the
wing disclaimer.
stributions in binary form must reproduce the above copyright notice, this list of conditions and
ollowing disclaimer in the documentation and/or other materials provided with the distribution.
dvertising materials mentioning features or use of this software must display the following ac-
ledgment:

 product includes software developed by the NetBSD Foundation, Inc. and its contributors.
er the name of The NetBSD Foundation nor the names of its contributors may be used to en-
 or promote products derived from this software without specific prior written permission.
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OFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBU-
AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIM-
O, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
ULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR
IBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EX-
RY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PRO-
ENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;

SINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILI-
ETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
ERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF

ED OF THE POSSIBILITY OF SUCH DAMAGE.

 Name List

uct names mentioned herein are trademarks of their respective owners.

owing notices are required to satisfy the license terms of the software that we have mentioned
ocument:

product includes software developed by the University of California, Berkeley and its contributors

 product includes software developed by Jonathan R. Stone for the NetBSD Project.

 product includes software developed by the NetBSD Foundation, Inc. and its contributors.

 product includes software developed by Manuel Bouyer.

 product includes software developed by Charles Hannum.

 product includes software developed by Charles M. Hannum.

 product includes software developed by Christopher G. Demetriou.

 product includes software developed by TooLs GmbH.

 product includes software developed by Terrence R. Lambert.

 product includes software developed by Adam Glass and Charles Hannum.
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 product includes software developed by Theo de Raadt.

 product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD
ct.

 product includes software developed by the University of California, Lawrence Berkeley Lab-
ry and its contributors.

 product includes software developed by Christos Zoulas.

 product includes software developed by Christopher G. Demetriou for the NetBSD Project.

 product includes software developed by Paul Kranenburg.

 product includes software developed by Adam Glass.

 product includes software developed by Jonathan Stone.

 product includes software developed by Jonathan Stone for the NetBSD Project.

 product includes software developed by Winning Strategies, Inc.

 product includes software developed by Frank van der Linden for the NetBSD Project.

 product includes software developed for the NetBSD Project by Frank van der Linden

 product includes software developed for the NetBSD Project by Jason R. Thorpe.

software was developed by the University of California, Berkeley.

 product includes software developed by Chris Provenzano, the University of California, Ber-
, and contributors.
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X

hic Mode,   171

 Size,   171
ontrol,   239

n Administrator Mode
b Image Monitor,   134
  326
CR to LF,   208
ntinue,   186
,   310
net,   263

onal transmission,   44, 64, 86
h™
net,   273
h Interface Unit Type 2238,   329

C

Cautions when using Bluetooth™ Interface Unit,   303
Changing Names and Comments,   137

SmartDeviceMonitor for Admin,   138
Web Browser,   140

Changing the Network Interface Board Configuration
SmartDeviceMonitor for Admin,   115

Changing the Paper Type
SmartDeviceMonitor for Admin,   118

Color Calibrate,   171
Color Demo Page,   162
Color Profile,   214, 218
Color Setting,   214, 218
Community name,   248
Config. Page,   162
Config.P/Er.Log,   162
Configuration

NetWare,   89
NetWare 3.x,   94
NetWare 4.x, 5/5.1, 6/6.5,   101
Web Image Monitor,   125
Windows 2000,   23
Windows NT 4.0,   67
Windows Server 2003,   47
Windows XP,   47

Configuring,   137
Configuring a WINS Server,   311

Web browser,   312
Web Image Monitor,   312
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Domain
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uring NetBEUI for Printing
indows 2000,   26
indows NT 4.0,   70

uring the Energy Save Mode
artDeviceMonitor for Admin,   123

uring the Printer for the Network,   16
uring the Protocols
indows 2000,   24
indows NT 4.0,   68
indows Server 2003,   48
indows XP,   48

,   186
 Font,   208

rmat,   214
nt Lang.,   186
   240, 307
 router,   304
ing the Status of Printer,   142
artDeviceMonitor for Admin,   142
artDeviceMonitor for Client,   143

eb browser,   144
 266
 name,   268

,   186

E

Energy Saver 1,   186
Energy Saver 2,   186
Error Log,   162
Escape key,   153
Ext. A4 Width,   208

F

Font Number,   208
Font Pitch,   208
Fonts,   324
Font Source,   208
Form Lines,   208

G

Getting Printer Information over the Network,   277
Going to the Top Page

Web Image Monitor,   127

H

Hard Disk Drive Type 2600,   326
HD Format,   171
Hex Dump,   162
Host Interface,   152, 197, 198
Host Name,   260
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02.11b,   197, 255
02.11b Interface Unit Type D,   327
ation
etwork Interface Board configuration,   286
etwork interface board configuration,   246
int job,   284
int log,   285
stem log,   246, 293

ng
artDeviceMonitor for Admin,   114
artDeviceMonitor for Client,   27, 50, 72

ng Software
indows 2000,   27
indows NT 4.0,   72
indows Server 2003,   50
indows XP,   50
fer,   197
eout,   197

ess,   236
50, 319
 Printing
indows 2000,   24
indows NT 4.0,   68
indows Server 2003,   48
indows XP,   48

J

Job Spool,   259

K

Key Repeat,   171

L

LAN adapter number (Lana Number),   71
Language,   152, 225
Letterhead Mode,   186
List/Test Print,   152, 162
List/Test Print Parameters,   163
Locked Print,   152
Locking the Menus on the Printer's Control Panel

SmartDeviceMonitor for Admin,   117
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e Status Notification by E-mail
tify by e-mail function,   145

nance,   152, 171, 172
Reset,   171
 Printer Settings with the Control Panel,   147

ing User Information
artDeviceMonitor for Admin,   119

y,   323
y Capacity and Paper Size,   320
y Overflow,   186
y Unit Type C (64/128/256 MB),   327
accessing,   152
Changing,   225
hart,   147
ey,   152
ist,   162
rotect,   171
ummary
eb Image Monitor,   132
e,   293
233
ring,   137

N

NetWare,   89
NetWare 3.x,   94
NetWare 4.x, 5/5.1, 6/6.5,   101
NetWare Printing,   306
Network Setup,   197
Notify by Email,   186
Notify by e-mail function,   145

O

On Line key,   154
Operations Test,   162
Options,   325
Orientation,   208

P

Page Size,   186
PAPER FEED UNIT Type 1000,   325
Paper Input,   152, 155, 156
Paper Type,   155
Password,   265
PCL Config.Page,   162
PCL Menu,   152, 208
PDF

Change PW,   218
PDF Config.Page,   162
PDF Group PW,   218
PDF Menu,   152, 218
PlainPaper Type,   171
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ize,   208
ipt Printing from Windows,   305
ions,   304
tion before Use,   16
Lang.,   186
status,   245
 a Configuration Page,   166
 Files Directly from Windows,   227
 Method
inting files directly from Windows,   230
 the Configuration Page and Error Log,   164

 Report,   186
fig. Page,   162
u,   152, 214
,   105

isk,   186
ation,   171
 printer, setup
etWare4.x, 5/5.1, 6/6.5,   107
vous,   271
tion,   208, 214, 218

S

Sample Print,   152
SDRAM,   323
Setting a Password

SmartDeviceMonitor for Admin,   124
Setting Up as a Print Server

NetWare3.x,   95
NetWare4.x, 5/5.1, 6/6.5,   102

Setting Up as a Remote Printer
NetWare3.x,   97
NetWare4.x, 5/5.1, 6/6.5,   107

Setting Up Options
Windows 2000,   43
Windows NT 4.0,   85
Windows Server 2003,   63
Windows XP,   63

Setup
printing files directly from Windows,   227

Share Setting
Windows 2000,   46
Windows NT 4.0,   88
Windows Server 2003,   66
Windows XP,   66

SmartDeviceMonitor for Admin
installing,   114

SmartDeviceMonitor for Client,   319
installing,   27, 50, 72

SMB,   253
SNMP,   233, 247
SNTP,   264
Specifications,   321
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rinting,   186
 mask,   238
per Size,   186
l Set,   208
,   152, 186

 for Printing
indows 2000,   24
indows NT 4.0,   68
indows Server 2003,   48
indows XP,   48

INS,   261
 234
utonet,   263
aper Type,   171
Ppr.Size,   155
cking,   155
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f Menu Configuration and Mode
eb Image Monitor,   129

U

Unit of Measure,   186
USB Setting,   197
Using a Host Name Instead of an IP Address

printing files directly from Windows,   228
Using Help on the Web Image Monitor,   135
Using SmartDeviceMonitor for Admin,   112
Using the Dynamic DNS Function,   313

W

Web Image Monitor,   125
Windows 2000,   23

Share Setting,   46
Windows NT 4.0,   67

Share Setting,   88
Windows Server 2003,   47

Share Setting,   66
Windows XP,   47

Share Setting,   66
WINS

telnet,   261
WL.LAN Defaults,   171
WL.LAN Signal,   171
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